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Let’s assume our article on interior photography on 
page 100 has got you all fired up and you’ve taken a series 
of finely composed images, but the colors on the monitor
don’t look like the ones you saw in the viewfinder while you
were shooting. Help is at hand! Our workshop on page 18
gives you all the inside knowledge and expert tips you need
to produce authentic colors from exposure to print, so when
you’re out and about searching for exciting subjects you 
can be sure that your next multimedia slideshow will look
fantastic. And to guarantee you know which tools deliver 
the best results, we have also tested all the latest slideshow
software for you (page 130).

There are hundreds of articles and dozens of books out there
on the subject of making selections using Photoshop, but we
are convinced that this issue’s bumper article by our resident
Adobe expert Maike Jarsetz will leave none of your questions
unanswered, from straight edge selections to isolating the
finest fur (page 44).

Have two years passed already? When c’t Digital Photography
started way back in 2010, we had no idea where our journey
would lead, although we have always believed that there is 
a market for our high-quality approach – and the many
enthusiastic comments and letters we receive continue to
prove us right.

The c’t Digital Photography team would like to say a big
‘Thank You’ to all of our long-time fans and all the new
readers who are helping to make us bigger and better with
every issue.

Have fun with number 8! 

Juergen Rink
Editor



Portfolio
Thomas Wrede’s model worlds tread the fine line 
between real and surreal. 

10 Thomas Wrede Portfolio

Color Management
If you want the deep green of a meadow to look just
as luscious in print or on a monitor as it did through
the viewfinder, color management is what you need.
This article explains how to set up your workflow to
give you perfect colors all the way down the line. 

18 What is Color Management?
21 In-camera Color
26 Monitor Calibration
32 Operating System Settings
39 Color-managed Printing

Precision Selections
Using Photoshop to make perfect selections requires 
practice and a comprehensive tutorial like this one. We
introduce you to the basics and use step-by-step 
examples to explain the tools and techniques you need 
to select even the most complex objects.

44 The Principles of Selection
46 Basic Tools
48 Common Techniques
54 Montage 
58 Step-by-step Guides

Time-lapse Photography
Time-lapse techniques bring life to sequences of still images.
This article explains how to transform stationary subjects into
entertaining and often surprising movie clips.

70 Basics, Subjects and Camera Settings
76 Video Creation Software
79 Error Correction and Fine-tuning

Fog and Smoke Effects
This article tells you all you need to know about how to create and
photograph spectacular fog and smoke effects, from carefully
constructed table-top scenes to full-on stage shows.

82 Equipment 
84 Technique
88 Sample Scenarios

Interior Photography
Interior photos present a unique set of challenges. A space, its
contents and the light illuminating it have to interact in perfect
harmony. Architectural photographer Adrian Schulz explains
what to look out for on a shoot and gives you important tips on
how to get your scene looking just right.

100 Introduction
102 Choosing a Subject
108 Seeing and Photographing Space
112 All About Light
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Photo Book Reviews
96 From Polaroid To Impossible
97 China, Portrait of a Country

What’s New in Lightroom 4
Adobe’s latest Lightroom offering introduces
map and book creation modules, as well as
many improvements to the workflow. We fill
you in on the details and explain some of the
new version’s highlights.

118 Lightroom 4 Overview

Free, Self-hosted Web Galleries
The problem with Flickr, Picasaweb and others is
your reliance on third parties. Gallery is a free,
open source alternative that gives you all the
tools you need to host your own custom photo
sharing and selling Website.

122 Open Source Gallery

HD Slideshow Software
The HD television in your living room is the perfect tool for
viewing high-resolution slideshows. We take a look at the
available software and check out its suitability for creating
HD photo shows with audio and video special effects.

130 Slideshow Software Test
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DVD Download
An image of the free DVD provided with
the magazine is available for download at 
www.ct-digiphoto.com/dvd082012.



Reviews How They Should Be

Just wanted to say that I love your magazine
and think the way you approach the camera
reviews is the way it should be done.
Technical, with no bias for one brand or
another. Well done indeed. That being said, I
was wondering if you are planning a review of
the Sigma SD1. I am currently a Sigma shooter
and an avid member of the Sigma forum on
DPreview.com (toasterflyer). Since this camera
was announced it has stirred up a lot of
anticipation in the forum and among regular
Sigma shooters.

But now that the camera has been released
at an unexpectedly high price we are all
wondering why the high price and whether
this camera is worth that much money in view
of the current competition. I believe the way
you do your camera reviews will really shed
some light on this. For a camera that offers so
much IQ yet not much in the way of modern
features or components, I would really like to
know what your reviewers think of this
overpriced beast of a camera.

Richard Haas

PDF Versions of Earlier Issues

c’t Digital Photography is the best
photography magazine I know and I find it
very informative. Is it possible to get PDF (or
PostScript) versions of old issues? Perhaps also
including the previous version on each issue’s
DVD? I like using a local search tool to find
information. Thanks for the great magazine.

Richard

All previous and current issues are available
via our free iPad app (itunes.apple.com/app/
ct-digital-photography/id439662182?mt=8),
which includes search functionality. You can
read the iPad version of the magazine either
by purchasing individual copies or by purcha-
sing a subscription to the print version, which
includes free iPad access to all available digi-
tal issues.

c’t Digital Photography is also available 
at zinio for single issue or subscription pur-
chase, but please note that our DVD content
is not currently available with the zinio editi-
on of the magazine.

GigaPan Stitch Suddenly More
Expensive?
How to Shoot Gigapixel Images, 
c’t Digital Photography 7 (2012)

I was blown away by the article on doing
Gigapixel photos. So much so that I am going
to dive into making some and see if I have the
skills to make some nice ones.

I am also writing because in the article you
said that the GigaPan Stitch software costs
US$9.99 and I was thrilled to find out that 
the software for making large panos was 
so inexpensive. However, when I went to 
http://gigapan.com/cms/shop/software to
purchase it, the prices were US$149 and
US$79.

Was the article price a misprint or am I
looking at the wrong site for the download
and purchase?

I really am enjoying your magazine and
have gotten several great ideas for improving
my own photography skills.

Andy Killgore

We took a closer look at GigaPan and disco-
vered that the company changed its pricing
and software options in March of this year.
The stitching software now appears to be
available either bundled with hardware 
or as a standalone for US$79. The new Efx ver-
sion costs US$149. Due to the price change,
our author no longer recommends buying the
program, and there is better software availa-
ble for the money – for example, PTGui Pro
(www.ptgui.com/order.html).

… and what people 
are saying about us 
on the Web:

Emphasis on the
Photographer, the Process
and the Workflow. 

Within the covers of c’t Digital Photography
lies an intelligent, well thought out magazine
that treats the reader with respect and not just
as fodder for the industry advertisers. If you
think about your own photography in a 
more sophisticated way than simply as a race
to afford the latest and most expensive
equipment then this magazine is probably for
you. The articles are in-depth and original and
the magazine is not equipment-centric. The
emphasis is very much on the photographer,
the process and the workflow. 

http://minimalistphotography101.com/
ct-digital-photography-a-genuinely-useful-
photography-magazine/

Minimalist Photography 101

Off the Beaten Path 

Like its German-language sister magazine c’t,
which I’ve been reading for quite a number of
years now, c’t Digital Photography is really
excellent and I can only compliment the
publishing team for a job well done.

c’t goes off the beaten path to deal with
lots of OS X and Linux info in an in-depth way.
Happy to see that c’t Digital Photography deals
likewise with focus stacking, HDR, noise
reduction etc., and manages to get away from
a Photoshop-only approach to include open
source options as well as commercial offerings
from around the globe. I truly appreciated the
article on Luminance HDR in issue 7, it was
brilliant.

www.facebook.com/profile.php?id=1000015
42586539

Mike Bing
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Reader Forum

Readers’ Letters

We are always happy to receive your
comments and suggestions in a letter,
an e-mail to editor@ct-digiphoto.com
or at www.facebook.com/ct-digiphoto.
We reserve the right to abbreviate your
input for publication. Our comments
are printed in italics.

Tell us what
you think:





This is a full-featured DSLR remote control
program designed to work with a wide

range of Canon and Nikon cameras. The only
current limitation is that Nikon users cannot
use the Bulb (B) shutter setting, while Canon
users have access to all the program’s features
and functions. Smart Shooter offers a
complete range of tethered shooting and
remote capture features, including live view
monitor output (with individual frame
capture), automatic image download and
display, autofocus support, and scripted
shooting functionality with individual
exposure and focus settings – perfect for
shooting macro focus stacking sequences.
You can view, pan and zoom JPEG and RAW
results in real time at 1:1 on your computer’s
monitor. 

To simplify working with scripts and to
enable you to unleash the full potential of this
powerful tool, the program’s author, Francis
Hart, offers script API documentation and
sample scripts at www.hartcw.com. The
website also includes a detailed overview of

all supported cameras and lists any limitations
that apply to specific models. 

There is no limit to the number of cameras
the software can control. This means you can,
for example, capture a 360-degree panorama
using multiple cameras and a single mouse
click. Combining exposure and focus bracketing
sequences enables you to shoot 360-degree
HDR Macro scenes with enhanced depth of
field.

The current 1.0 version of the software is
included on this issue’s DVD and is fully
functional once you have registered it for free
at http://hartcw.com/promo/ct-digiphoto. The
developer is currently working on a successor
version that should be available in the next
quarter. c’t Digital Photography readers who
purchase the new version before October 31st
2012 using the voucher code SS2CTDP will
receive a 30% discount.

The software included on this issue’s free
DVD is equivalent to the full version available at
www.hartcw.com for US$50 (GB£32) and works
on Windows PCs and Intel Macs . (tho)

Eˇxtracting successful selections is a serious
challenge for many photographers. In this

workshop, Tim Grey introduces the various
selection tools and explains how to use them
effectively. Amongst other things, he tells us
when the Lasso tool is preferable to the Magic
Wand and how efficient the Quick Selection 
tool really is when separating a subject from its
background. The second part of the workshop
is dedicated to selecting complex objects that
test the limits of the program’s simpler tools,
and shows you how to use masks and 
channels to make and save selections. Tim also
demonstrates how to use the Pen tool to make
precise selections in objects with complex
shapes. 

The other main theme of this set of
workshops is the use of curves. The Photoshop
Curves tool can be used to make targeted
adjustments, select a white point and to adapt
contrast within an image. This 40-minute video
details how to use the tool efficiently and
effectively, explaining the use of anchor points
and freehand brushes as well as how to save

Smart Shooter

Full Version Software: This exclusive c’t full version software
enables you to completely control your Nikon or Canon
DSLR remotely using your computer. The application is
script-compatible, and allows you to program complex
shooting sequences and view the results in seconds on your
computer’s monitor.

video2brain Tutorials 

Photoshop Workshops: Tim Grey
discusses selection tools and
techniques, and explains how to use
curves to optimize your images. The
videos also include Tim’s personal top
ten new features in Photoshop CS6.

8 c’t Digital Photography 8 (2012)

DVD Highlights
Highlights of this issue’s free DVD include an exclusive set of Photoshop video tutorials, sample
images and video clips from the articles and tests in the magazine and a free full version of the Smart
Shooter camera remote control software. Our free software selection also includes ShiftN, which is
designed to help you combat converging verticals, as explained in our article on interior photography. 

DVD | Highlights
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DVD | Contents

your settings as a preset for future use. The
workshop also explains how to use masks to
limit effects and apply them selectively.

Photoshop CS6 introduces a range of new
and optimized tools and functions. In our final
video, Tim Grey tells us about his personal top
ten new features and gives us an overview of
the new version’s capabilities. With it’s darker
user interface and menus, CS6 looks a lot more
like its RAW converter cousin Lightroom than its
predecessors, and the new features are
definitely oriented toward photographers. The
revised Crop tool now includes atuomatic
perspective correction functionality, and there
are a number of new Content Aware tools that
help you to invisibly correct a wide range of
image errors and enable you to move objects
within an image without leaving any gaps in the
background.

These videos, with a total running time of
more than two and a half hours, are part of the
Photoshop Selections Workshop and Photoshop
Curves Workshop videos available at
www.video2brain.com for US$29.99 each. (tho)

Image Processing Tools

GIMP

GIMP Portable 2.6.12

GraphicConverter 7.6.2

GREYC’s Magic Image Converter (G’MIC)

Image Analyzer 1.34

ImageJ 1.45

Inkscape

Inkscape Portable 0.48.2

JDraw 1.1.5

Mosaizer Pro 9.2.140

Paint.NET 3.5.10

Picasa 3.9.0

PSPI

ShiftN 3.6

StylePix 1.9.2

StylePix Portable 1.9.2

Photo Tools

AmoK Exif Sorter 2.5.6

EXIFeditor 2.2.2994.38866

Exifer 2.1.5

ExifTool 8.89

Gallery 3.0.3

GeoSetter 3.4.16

GeoSetter Portable 3.4.16

IrfanView 4.33

IrfanView PlugIns 4.33

IrfanView Portable 4.33

jAlbum 10.6

MacPorts 2.0.4

Rawker 2.3.4

Smart Shooter 1.1.14

ThumbsUp 4.5

XAMPP

Xee 2.2

Sample Images

Color Management Test Images

Precision Selection Sample Images

Videos

Time-lapse Photography Sample Clips

Photoshop Workshop

Video Tools

Deshaker 3.0

PhotoLapse 3.0

VirtualDub 1.9.11

VirtualDub Portable 1.9.11



Such an idyllic summer scene (page 12) – beautiful blue sky,
summery  clouds reflected in the water between the sandbanks, a

house on stilts at the water’s edge and a caravan alongside. The
ultimate idyll; the place we all long for. Despite the extreme
perspective, with a foreground rich in detail and a horizon far away in
the distance, the entire photo is extremely sharp and has a hyper-real
feel to it, especially if you get a chance to see the original, which
measures 2.5 square meters. The incredible depth of field in these huge
photos is created using a special lens mounted on a large-format (4x5”)
analog camera. The negatives are scanned before being processed
digitally, and the finished photos are mounted behind Plexiglass on
Dibond aluminum panels.

Looking more carefully, we eventually twig that the grains of sand
are far too big, and that there is no path to the house. Some things in
the scene just don’t add up, and the idyll turns out to be a carefully

constructed illusion. The buildings, vehicles and trees in Wrede’s photos
are models that are often only the size of a shoebox, and many of them
are standard pieces from Faller Models. The initial concepts take shape
as doodles on paper, and Wrede then builds the model and looks for
the right landscape in which to set it. He often finds what he is looking
for near his home in northern Germany or on one of the North Frisian
islands.

These ‘real landscapes’ do not represent any actual location, yet they
seem familiar. The diner on the edge of a canyon in the middle of
nowhere could have come from any American road movie, the
apartment buildings next to the hills really do look like the last place
anybody would want to live and the house perched on the
mountainside is just the kind of splendid isolation we all dream of. The
photos play on the way we are used to seeing things and are, in a way,
a kind of visual quotation.
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Portfolio | Thomas Wrede
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Portfolio

Thomas Wrede
For his ‘Real Landscapes’ series, Thomas Wrede
places small models in a natural setting and
photographs them as if they were real. Viewers
can either simply appreciate the aesthetics of 
the images or try to put their finger on what it is 
that doesn’t look quite right. Wrede’s works are
exhibited in galleries and museums all over 
the world.
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Playing around with miniaturization and the aesthetics of modeling
is a big trend in the world of movies and photography. The films used
to introduce each country at the 2011 Eurovision Song Contest are just
one example of the widespread use of fake miniature effects. But while
many people like to experiment with making reality look like a model,
Wrede works the other way around, making models look like part of
the real world. The large format of his works makes them quite different
from those of his colleagues, too. Images of models usually look best
when reproduced as small as possible, but the size of these photos
reveals every flaw and inaccuracy. These images are not perfect fakes –
instead, they cleverly toy with our perceptions of reality.

Thomas Wrede discovered his affinity for photography while
studying for a fine arts degree. At some point along the way, the
photographs he was taking in preparation for his paintings took on a
life of their own. The ‘Real Landscapes’ project began in 2005 and is

sure to run for a few more years yet. Wrede has made a living from 
his photographic art for the last decade, though he says every 
year presents a fresh challenge. He usually issues two series of each
image: one in large format with five prints and a 95x120cm run of
seven prints. Buyers may be individuals, banks or insurance companies
and, most recently, he sold one of his works to the German Ministry of
Food, Agriculture and Consumer Protection. (jr)

Links

www.thomas-wrede.de
www.galerie-wagner-partner.com/artists/thomas-wrede/works
www.faller.de/App/WebObjects/XSeMIPS.woa/cms/page/
pid.14.16/lg.en/ecm.p/Home.html
www.beck-eggeling.de/en/new_quarters/artist/thomas_wrede

Canyon
(2007, 170x240 cm)
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Lakeside Landscape 
(2007, 140x180 cm)

Portfolio | Thomas Wrede
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Portfolio | Thomas Wrede



15

Skyscrapers
(2008, 95x180 cm)

House in the Mountains 
(2007, 120x240 cm)
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Dari King Drive-In 
(2007, 170x220 cm)

Portfolio | Thomas Wrede





Ralph Altmann

Keep it Real
Effective Color Management from 
Exposure to Print



The digital world is built on three colors. All
you have to do to capture a digital photo

is take a certain amount of red, blue or green
– from zero for none up to 255 for ‘all there
is’ – stir thoroughly and marvel at the unique
colors the process produces. The 256 tonal
values per color channel that 8-bit color depth
provides give us 16.7 million different colors
to play with and, if we work with 10-, 12- or 14-
bit colors, this number increases still further
into unimaginably complex realms that
produce differences in color tones that are
indistinguishable to the human eye.

Such enormous numbers of colors are great
if we want to produce smooth color transitions,
but even the most comprehensive palette isn’t
guaranteed to contain all visible colors. 

The quality of any mixture can only ever be
as good as that of its ingredients, so a color
that is composed of ‘impure’ red, green and
blue components can never be as pure and
strong as the brightest red, green and blue
tones that our eyes can see. Impure primary
colors always produce an incomplete
spectrum of secondary colors. No monitor,
printer or photo lab is capable of reproducing
pure, bright colors as they exist in nature.

But this is only a subsidiary problem. The
real problem – and the reason why color
management systems are necessary in the
first place – is that just about every imaging
device in existence has a slightly different idea
of what ‘red’, ‘green’ or ‘blue’ actually means.
If two digital painters use exactly the same
recipe but slightly different ingredients, the
resulting colors will not be the same. Take a
look at the TVs on display at your local
electronics store and check out the
differences in color they produce even though
they are all displaying the same test picture.

What we have to do is define our recipe
more precisely to make each color explicitly
reproducible. It is not sufficient to simply say
how much red, green, or blue we require – we
also have to define how much of which
primary color we need. This is the task
assigned to color profiles.

19c’t Digital Photography 8 (2012)

If you want the deep green of a meadow to look just as luscious in
print or on a monitor as it did when you focused on it through
your camera’s viewfinder, color management is what you need.
This article explains why terms like ‘green’ or ‘red’ are insufficient
descriptions of color and how to set up your digital photo
workflow to keep your colors true from the moment you release
the shutter to the second you hold a perfect print in your hand.
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Color Management | Basics

Color Profiles

A monitor profile contains information that
defines the strongest red, green and blue
tones that the monitor can reproduce within a
reference color space that contains precise
definitions of all theoretically visible colors.
Printer profiles work on the same principle,
but are slightly more complex because they
usually mix four (cyan, magenta, yellow and
black) or more component colors with the
white of the paper to produce the printed
colors. Ideally, monitors would also use four
component colors to produce an image, but
‘real’ cyan cannot be adequately mixed from
just red, green and blue, which is why it is
missing from all monitors.

Not only output devices, such as printers
and monitors, but also all capture devices (i.e.,
cameras, scanners and photographic film)
capture the colors contained in incident light
in their own particular and often idiosyncratic
way. However, in the case of capture devices,
the color production process is performed the
other way around. The jumble of colors in the
subject is captured using a sensor that uses a
matrix of colored filters to mix the appropriate
amounts of our old friends red, green and
blue into an interpretation of what it sees. The
software algorithms used to perform these
calculations and the pattern of the colored
filters vary from manufacturer to

manufacturer, from camera to camera and
even from sensor to sensor.

Color Management

What color management does is translate
between all these different color recipes. If a
camera outputs the RGB values 170/55/67 for
a particular color, the color management
process calculates the ‘true’ color values for a
device-independent color space based on the
camera’s own profile. It then calculates which
values are necessary to reproduce the same
color on a monitor or other device. In practice,
the first stage of the color management
process actually takes place in the camera and
maps the color values captured by the sensor
into either the sRGB or the AdobeRGB color
space.

If all camera, monitor and printer
manufacturers were to agree on a single
standard working color space for their
products, we wouldn’t have to deal with color
management at all – the whole process would
simply take place invisibly in the background.
Many imaging experts dream of such
medium-independent color management,
although this cannot be achievee at a high
enough level on the basis of the sRGB and
AdobeRGB color spaces. You are probably
already asking yourself why we don’t just use
the reference color space already mentioned

for all devices. This would indeed represent
something approaching an ideal solution, but
would require the entire digital image capture
process – from camera hard- and software
through image processing software to all
aspects of the output process – to be adapted
to work on a 16-bit basis. A reference color
space that contains all truly visible colors
would have to be extremely large to cope
with the irregular form of the color space of
the human eye. A large part of such a color
space would go unused but still requires
memory bits to exist. In this context, the
differences between the 256 different tonal
values present in the 8-bit system would
become too obvious. If you want to build a
house using a predefined number of stairs,
there is a limit to how tall the house can be
before each step becomes too high to climb
comfortably.

The dilemma of wanting to use the largest
possible color space while keeping the
transitions between tonal values as smooth
as possible has so far prevented the
invention of a universally satisfactory
solution to the problem of color
management. Color management in its
current form is a complex, imperfect and
often confusing system. It is inconsistent and
is at best something of a crutch - although
the situation today is significantly better than
it was 20 years ago.

The freeware ColorInspector
3D displays the colors
contained in an image in four
different color models.
However, color profile support
and a tool for comparing the
results with standard
reference color spaces are only
available in other, commercial
programs such as Colorthink
(www.chromix.com).
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Color Management | In the Camera

If your camera isn’t capable of capturing
colors accurately, the rest of the color
management process turns into a guessing
game. Unfortunately, camera manufacturers
have differing ideas of what ‘accurate’
means, and often vary their definitions
according to consumer taste. Asian
photographers have a distinct preference for
strong colors that are considered over-the-
top in Europe and the US. If you are using a
camera that can only output JPEG images,
you will have to choose the camera preset
that produces what you consider to be the
most natural looking colors. If you are
shooting in a RAW format, an exposure
preset will only really influence the look of
the image preview on the camera’s monitor.
These are often designed to look like the
results produced by specific analog film
stocks. You can then use a RAW converter to
change the look or the white balance of your
image to your heart’s content without
actually altering the original image data. In
contrast, every change you make to a JPEG
image alters the original pixels, and the 8-bit
nature of those pixels doesn’t give you much
room for maneuver before editing visibly
reduces the quality of the resulting image.

White Balance

White balance is just as important as the color
characteristics of the image sensor, which
captures the light reflected by the subject’s
surface. The actual color of this reflected light
depends not only on the color of the subject
itself, but also on the color of the light source
illuminating it. It is only possible to make
genuinely precise statements about the color
of an object if you know the exact color (or
better still, the spectral distribution) of the
light source. 

If you don’t apply the correct white
balance setting, a sheet of white paper will
appear yellow if photographed under a
conventional light bulb and will have a blue
tinge if photographed in daylight. Auto white
balance mechanisms assume that the
brightest parts of the frame are lit by the
dominant light source and only a few
high-end cameras have light sensors that
detect the color of the ambient light
independently from the colors reflected by
the subject. Most subjects contain bright
details that directly reflect the illuminating
light without altering its color and, because
the human eye works on a similar principle,

the results usually correspond adequately to
our visual expectations.

However, this method doesn’t work at
dusk or in artificially colored light and often
produces images with an indeterminate
lighting mood. Auto white balance is also
inappropriate for use while shooting image
sequences because it detects slight
differences in lighting from frame to frame
and alters the camera’s settings accordingly
even though the subject remains the same.
You can alter and match white balance
settings after shooting if you shoot in a RAW
format, but not if you use JPEG. If you have to
use JPEG, it is better to set the camera to set
white balance manually before you begin
shooting.

For the sake of precision, you should
always take a reference shot of a gray card at
the start of a shoot and every time the light
changes. Color targets (see below) contain
gray reference patches, although a dedicated,
frame-filling gray card is better still. Many
photographers simply use any old sheet of
paper that happens to be on hand, but paper
is not uniformly white and the bleaches it
contains often react inconsistently to the UV
component of incident light.

Authentic In-camera Colors

Back then, the only way to produce
consistent colors was using proprietary
solutions that only a few specialists could
understand. Nowadays, anyone with an
affinity for IT can construct a perfect sRGB-
based imaging workflow that produces better
colors than any expert could have managed
all those years ago. The following pages are
dedicated to investigating the more
challenging aspects of the color management
process, although we won’t completely lose
sight of the sRGB workflow along the way. The
aim of the exercise is to achieve a perfect
reproduction of the colors you saw through
the viewfinder on your monitor or in print.

We will begin by considering white
balance and camera calibration, followed by
monitor calibration techniques. We also need
to make a number of system settings to
ensure that all the devices and programs in
the workflow understand one another, and
this is the subject of the third major section
of the article. The final section deals with
processing for output and details our
experiences with print services that claim to
provide full color management support.

The grid in this illustration represents the eciRGB color space and the colored shape within it
the sRGB color space. This comparison was provided by www.iccview.de, where you can also
upload your own color profiles. The eciRGB color space is the same size as the NTSC color
space used to calibrate and compare wide gamut monitors. 



ICC Camera Profiles

Color temperatures that vary from shot to
shot make camera profiling and setting white
balance quite tricky. Strictly speaking, ICC
profiles are valid for only a single color,
theoretically making it necessary to use a
different profile for every shoot. For this
reason, ICC camera profiles are generally only
used in professional situations such as  studio

environments in which the color of the lights
is known and is unlikely to change
significantly. There are, however, simpler
solutions available for everyday photographic
situations, and the following sections describe
two of these. Both work with Lightroom and
Adobe Camera Raw. Although both programs
are capable of processing various image
formats, we strongly recommend that you use
RAW format for camera calibration purposes.

If you want to use DNG profiles, RAW is
obligatory anyway.

Calibration using
SpyderCheckr
Every fine adjustment to camera settings
requires a subject with predefined colors
called a ‘target’. The following guide uses the
SpyderCheckr package from DataColor. In this
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Step 1: In Lightroom, adjust white
balance to match patch E2 using the
eyedropper tool, then adjust patch E1 to
about 90% using the Exposure slider and
patch E6 to about 4% using the Blacks
slider. 

Moving the mouse over one of the
colored patches displays that color’s
values in the histogram display, and you
can then use the + and - keys to adjust
the values.

In Adobe Camera Raw (ACR) you can
achieve the same thing by selecting two
reference points with the eyedropper and
adjusting their RGB values manually to
230 and 10.

Correcting Colors using SpyderCheckr

Step 2: Load your target image in Spyder -
Checkr using the ‘Open with’ command. If
you prepare your target image using ACR,
you will have to save it in TIFF format and
load it manually. You can now perform any
necessary fine-tuning on the target’s colors.



case, the target contains 48 color patches
attached to a foldable aluminum frame that
protects the colors from wear and fading. The
target includes a special ‘FadeCheckr’ patch
that changes color with cumulative exposure
to light and warns you when you need to
purchase a new color card. 

The target has to be photographed under
realistic conditions in even light without
extraneous reflections. The manufacturer
advises that as little blue sky as possible
should illuminate the target if the reference
shot is made in daylight, so try to shoot under
some kind of shade if you are using the
SpyderCheckr out of doors. Open your RAW
image of the target in ACR or Lightroom, crop
it if necessary, and adjust the tonal values and
white balance as you would when processing
any other image. If the camera and its internal
processes are accurate, the RAW image of the
target should now contain exactly the same
colors as the original. If not, you can adjust the
colors using the program’s sliders, although
adjusting one slider often affects the colors in
more than one patch.

A simpler alternative is to use the Spyder -
Checkr software, which does the same job
virtually automatically. Once you have loaded
your photo of the target, all you have to do is
fine-tune the colors. You can then click the Save
Calibration button to save the results as a new
User Preset (in Lightroom) or a Setting (in ACR).
Following a restart, the new preset will be
available in the Develop module in Lightroom.

In ACR, you can either select a preset directly in
the Presets tab, or select Load Settings or Apply
Preset in the Preset tab’s menu.

DataColor calls this procedure “Camera
Calibration”, although what it actually does is
create a user preset that automatically adjusts
Lightroom’s HSL slider settings. These presets
can be applied to photos shot with any
camera, so be sure to include the appropriate
camera name in the preset title. The advantage
of this process is that you can change a preset’s
parameters and save it under a new name at
any time, while the major disadvantage is that
a preset is only really suitable for use with
photos that were shot under exactly the same
lighting conditions. If you have created two
new presets for different lighting situations,
the SpyderCheckr software can interpolate
three intermediate presets with values that lie
between the ones you have captured. This can
make things quite complicated, but
thankfully  Lightroom does allow you to
arrange presets in folders and sub-
folders.

The sensitivity of variations in color
temperature has its uses, and you can
deliberately use the SpycderCheckr’s
blue- and red-tinged white patches to

adjust white balance to give portraits a
warmer or cooler look. DataColor compares
this methodology with the weak colored
filters that analog photographers used to use
to adjust skin tones. Admittedly, this kind of
technique has less to do with color
management than it doses with creative
photography, but can nevertheless be used to
create consistently reproducible results. 

In Lightroom, calibration presets can be
applied to multiple images or selected as a
Develop Setting during image import. If you
use the Develop > Set Develop Settings
command, you can apply presets
automatically according to camera model, or
even serial number if you are using more than
one camera of the same model. Note that this
approach saves not just the HSL slider
settings, but rather all of the current Develop
module settings.
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Device calibration targets are
available in various sizes

Step 3: The newly created
Lightroom User Preset affects
only the HSL slider settings
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Calibration using DNG Profiles

The Lightroom Develop module contains the
same Camera Calibration settings as the
eponymous tab in the ACR interface, where
you can select one of the standard Adobe
camera profiles included with the software.
The profiles themselves are stored under
ProgramData\Adobe\CameraRaw\CameraProf
iles\Adobe Standard, and contain the settings
that the color interpolation performed by the
Adobe demosaicing algorithm is based on. A
number of additional profiles for various
mid-range and high-end cameras are available
from the Adobe website. These are based on
the color characteristics of the various looks
that are programmed into the camera
manufacturer’s own shooting presets – for

example, a ‘Portrait’ profile will reduce red
saturation, while ‘Landscape’ and ‘Vivid’
profiles tend to have the opposite effect. 

Creating your own camera profiles is much
more interesting than using manufacturers’
presets, and Adobe has come up trumps with
its free DNG Profile Editor, which enables you
to create and adjust profiles using images of
any target you choose. A faster, automatic way
to create camera profiles is to use the X-Rite
ColorChecker package, with targets available
in Mini and Classic sizes for US$75-99. As an
alternative to the Adobe Profile Editor, X-Rite
also markets its own ColorChecker Camera
Calibrator software (also known in some
markets as the ColorChecker Passport), which is
available for free from the X-Rite website. The
Windows version of the software includes a

Lightroom export plug-in that can be
downloaded separately for use with Mac
systems.

The DNG Profile Editor can be started
directly without prior installation. Although
DNG stands for Adobe’s own Digital Negative
file format, you don’t have to adapt your
workflow to DNG to use profiles created using
the tool – you only have to export your target
image in DNG format so that it can be loaded
into the editor. Then simply switch to the Chart
tab, place four markers in the like-colored
patches in the target and click the Create Color
Table button. The program then switches to
the Color Tables tab, where all 24 target colors
are displayed in ‘before and after’ versions
alongside their positions on a color wheel.
Each target color can be adjusted using the

The Adobe DNG Profile Editor automatically creates a manually adjustable color correction table (shown
on the far right) from an image of a ColorChecker target. You can also create a dual illuminant profile
using two photos of the ColorChecker taken under different lighting conditions.

ColorChecker
Passport supports
step-by-step profile
creation and also
works as a Lightroom
export plug-in



HSL sliders, although this is seldom necessary.
Finished profiles can be exported to the
appropriate folder via the File menu and are
available in the Calibration panels of ACR and
Lightroom after the next restart. You can save
any changes you make to a profile as a
‘Recipe’ that you can load and continue to
fine-tune later. An existing profile can also be
adjusted by loading it into the Color Tables
tab as a ‘Base Profile’ while selecting the colors
that you want to adjust from a separately
loaded image.  Base Profiles play no part in the
automatic creation of profiles using
ColorChecker targets.

Adobe DNG profiles actually consist of two
component profiles adapted to match color
temperatures of 2850 and 6500 K (Kelvin). The
program simply interpolates values for other
color temperatures, enabling DNG profiles to
cover all conventional lighting situations.
Profile Editor can also be used to create new
dual illuminant profiles. All you have to do is
shoot a target photo under each of the two

light sources, save them in DNG format and
automatically create two color tables for 2850
and 6500 K values in the Charts tab. You can
then save the new profile in the usual way.

The program’s Color Matrices tab includes
three sets of Primary Color sliders as well as
temperature and tint White Balance sliders
and enables you to create profiles for extreme
lighting situations, such as for digital cameras
adapted for shooting infrared photos. There is
also a Tone Curve editor in its own tab.

The X-Rite ColorChecker Passport software
is not as versatile but is much easier to use. It
can be used to create dual illuminant profiles
and its built-in Lightroom plug-in saves you
the effort of converting your target shots to
DNG format. The package also includes
monitor calibration functionality, but doesn’t
allow manual profile adjustments. Finished
profiles are much less complex than their
Adobe counterparts, and contain just a
simple color matrix and one look-up table
(LUT) of about 100 values. In contrast, an

Adobe DNG profile contains four separate
color matrices and more than 2,200 reference
points. In spite of its obvious advantages, this
complexity doesn’t guarantee high-quality
profiles, especially if you consider how
accurate today’s cameras are (i.e., their high
tolerances and often negligible color
discrepancies). 

DNG profiles are only valid for the camera
they were created with and are only visible in
the Adobe Calibration panel if a photo is
selected that was shot using that particular
camera – a great help  when it comes to
retaining an overview of your profiles. The DNG
Profile Manager is another great management
tool that you can download for free when you
register the purchase of a ColorChecker target.
To apply a profile during import into Lightroom,
simply include it in the standard Develop
settings, as described for the SpyderCheckr
above. Profiles that contain only calibration
settings are best suited for application to
multiple images.
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Most mid-range and high-end cameras
offer the choice of shooting in the sRGB or
the larger AdobeRGB color spaces. If you
shoot in a RAW format, the color space you
choose is less relevant, as the final profile
for an image is only created during RAW
development. The profile you select in the
camera serves only as a suggestion and to
provide colors for the monitor display. If
you are shooting in JPEG format, the
profile you choose is set in stone, and any
adjustments  you make after shooting will
reduce the size of the resulting gamut.

The great advantage of using sRGB is its
ease of use, which makes it a very close
approximation to genuine, user-friendly
medium-independent color management.
Image files that don’t have a profile of their
own are usually interpreted as having been
shot in the sRGB space, and most non-
calibrated monitors and printers produce
acceptable colors. Wide gamut monitors
are still fairly rare, but have to be calibrated
to produce usable colors. sRGB images can
also be edited to ICC-compatible standards
using older (often cheaper) image
processing software. Inclusion in a fairly
simple, closed color management
workflow and the embedding of sRGB
profiles in all output files (in order to avoid
confusion) are often more important than

squeezing the very last drop of saturation
out of an image. Even if they are capable of
more, most machines used by professional
printing services (the final link in the
imaging chain) are limited to processing
sRGB files by default.

The major advantages of AdobeRGB are
the slightly larger gamut and its
acceptance as something of a standard for
press and agency work. However, the
gamut is still too small for most inkjet and
photo lab printers (and probably soon for
high-end monitors too). 

The modified gamma curve used by sRGB
to reproduce deep shadows is better than
the standard curve used by AdobeRGB,
while eciRGB_v2 uses the (supposedly)
even better L* curve. However, eciRGB is
not yet available as a setting in any current
camera firmware. If you want to get the
most from your camera and it supports
RAW shooting, then use it – you can
convert your images to any color space
(including AdobeRGB) later. sRGB is
perfectly adequate if you  shoot mainly for
Web publication or printing at a sub-fine
art level. 

sRGB or AdobeRGB?

Today’s digital cameras no longer embed
a standard profile in image files, but
instead simply write the name of the
appropriate profile along with the
filename to an Exif tag. An underscore at
the beginning of a filename indicates
AdobeRGB, while filenames without
underscores are stored as sRGB files.
This system works well until a file gets
renamed. Image processing software
should adjust the contents of the Exif
tag every time a profile change takes
place, but the only way to be really sure
that an image is saved correctly is to
embed the profile.



Cathode ray monitors are a perfect example
of additive color synthesis. Three beams of
electrons bombard red, green and blue
phosphorescent dots. The mixture of these
produces the colors that are visible on the
screen, while their brightness depends on the
strength of the electron beam, which itself
depends on the strength of the voltage
applied to the cathode. This is the technical
origin of the famous gamma – i.e., the inverse
non-linear distortion of brightness curves in
still or video images. Zero voltage means zero
brightness (i.e., black), while full power for all
three channels combines to produce white
light. The color characteristics of this type of
monitor depend entirely on the nature of the
phosphorescent colors used in their
manufacture, but even the highest quality
phosphors cannot reproduce all visible colors.
Bright cyan requires the presence of a
‘negative’ red value, which this technology
doesn’t support. In principle, the same is true
of LCD monitors and projectors, although the
spectrum of the backlight color also plays a
role in determining the overall color
characteristics of these types of device. LCD
monitors work on the basis of a hybrid
technology. The red, green and blue filters
located in front of the more or less transparent
liquid crystals first have to filter out the color
of the backlight using subtractive color
synthesis techniques before they use additive
color synthesis to mix the waves the filters
allow through to create the colors displayed
on the screen.

Monitor Calibration

The process of setting up a monitor to
produce optimum colors is called calibration,
and initial calibration takes place at the
factory. The process ensures that the
brightness of the monitor image follows the
control voltages applied to it according to the
values contained in a specific curve, and also
makes sure that gray tones remain neutral at
all brightness settings. It also ensures that
displayed whites have a consistent color
temperature. The appropriate values required
to make these kinds of corrections are stored
in ‘look-up tables’ (LUTs) that are an integral
part of the device’s circuitry.

Similar tables are used to compensate for
differences in brightness in a monitor’s
backlight. The LCD cells that are located in
front of brighter parts of the backlight are
darkened permanently and, when a particular
RGB value is sent to a pixel, the monitor’s
circuitry checks the red, green and blue color
look-up tables (LUTs) for possible correction
values and then checks in an additional large
table for pixel-related corrections. LUTs are
the digital equivalent of the dials and resistors
that used to be used to regulate analog
monitor signals.

The LUTs built into modern high-end
monitors can be manipulated using computer
software – a process known as hardware
calibration. However, ‘software calibration’
performed by manipulating a computer’s
graphics card is more common.

LUTs are written to appropriate memory
banks in the graphics card, but are limited by
the fact that these usually only support 8-bit
color depth. For example, the brightest
possible white tone in an 8-bit digital image
has RGB values of 255, 255, 255. In order to
prevent this color being displayed with a
strong blue color cast, a monitor’s blue
channel has to be regulated to a value of
around 220 to produce a realistic overall color
temperature of between 5000 and 6500 K. The
limitations of 8-bit color depth tend to make
the graduations between different levels of
brightness coarser and therefore more easily
visible. If we extrapolate 8-bit color values to a
10-bit scale before correcting them, the
resulting graduations will be finer, even if they
are scaled down again for display on an 8-bit
panel. Today’s high-quality, graphics-grade
LCD panels are controlled using 10-bit
firmware and a simple trick called Frame Rate
Controlling (FRC). The individual LCD cells in
such a panel are only actually capable of
displaying 256 different grayscale values, but
are switched on and off extremely quickly
according to a predetermined pattern to
simulate finer tonal differences.

LCD panels with true 10-bit control
systems are rare and expensive, but graphics
cards with 10-bit LUTs and 10-bit signal
transmission technology (such as ATI FirePro
and nVidia Quadro) are nowadays standard
fare in professional graphics circles. In order
to ensure that 10-bit control signals actually
reach the monitor, the graphics card has to be
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Authentic Monitor Colors

The NEC SpectraView
range proves that
monitors can produce
stable colors over
long periods of time
without resorting to
regular calibration.
The MultiProfiler
software enables the
user to make precise
color space, color
temperature and tone
curve settings
without the use of
additional calibration
hardware.
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Viewing Angle Independence: A large
color space is no use if the colors on the
monitor screen change with the angle of
view. Only the best IPS and PVA panels are
used in high-end monitors.

Large Color Space: The reproducible color
space depends largely on the backlight
technology used. RGB LEDs are capable of
reproducing the most colors but are also
the most expensive. A cheaper way to
produce acceptable colors is to use LEDs
just at the edges of the screen. White LEDs
produce impure, pseudo-white light and
are inferior to traditional cold cathode
(CCFL)  technology. Most mid-range and
high-end wide gamut monitors use CCFL
backlight technology.

Panel Bit Depth: The greater the bit depth
of a monitor, the smoother the transitions
between colors will be. 8-bit color depth
(with 256 grayscale values per channel) is
the current industry standard, and most
‘10-bit’ monitors use 8-bit panels and FRC
technology to simulate greater resolution.
Native 10-bit panels, such as the Eizo
CG303W or the NEC PA245W, are rare and
expensive. The advantages of 10-bit panels
only come to the fore if your system is
capable of producing 10-bit signals, which
requires the use of a 10-bit graphics card

and DisplayPort. This technology is not yet
available for Macs.

Internal Signal Processing: Performed
using look-up tables (LUTs) that contain
monitor settings and correction values.
The greater the LUT bit depth, the more
precise the corrections they can make
without the loss of intermediate colors.
Most mid-range monitors use three ‘one-
dimensional’ LUTs (one for each color
channel) with 10- to 16-bit color depth. 3D
LUTs are channel-independent and
provide  more accurate color reproduction
with consistently neutral gray tones.

Hardware Calibration: The correction
values produced by the monitor

calibration process are stored in the
monitor’s high-bit-depth LUTs rather than
in the 8- or 10-bit  LUTs in the graphics
card. Graphics cards are designed to
control systems that have already been
calibrated and don’t perform corrections
themselves.

Black Point and Maximum Brightness:
These two values represent a monitor’s
(statistical) maximum range of contrast. Most
graphic artists set their monitors to 50
percent brightness or less, making a low

black point value essential for providing
sufficient contrast. About 0.2cd/m2 (candelas
per square meter) is a good reference black
point value, while maximum brightness
should be between 250 and 350 cd/m2.

Uniform Illumination: Monitors that use
edge backlight technology are particularly
prone to uneven illumination – a problem
that can be counteracted using specially
formulated, pixel-based correction tables.
This involves measuring screen brightness
section by section during calibration,
resulting in correction values that
attenuate  the current in the LCDs in areas
that are too bright. In reality, this means
that images are displayed darker in these
areas.

Comparison Website: A comprehensive
database with detailed background
information on a wide range of LCD panels
and monitors can be found at
www.tftcentral.co.uk. It is simplest to search
for your desired panel size and quality under
tftcentral.co.uk/articles/panel_parts.htm 
(for example, 10-bit IPS with 100 percent
AdobeRGB gamut) and copy the appropriate
panel description to the ‘Panel’ search box at
tftcentral.co.uk/panelsearch.htm. This
produces a list of monitors that contain your
chosen panel type. 

What to Look Out For when Purchasing a Monitor

The Fujitsu P27T IPS wide gamut monitor (left) produced great results in a recent c’t test and is good value at
around US$900. The 23-inch standard gamut NEC MultiSync PA231W (right) costs about the same. The larger
monitors in the NEC MultiSync range are all wide gamut models.



connected to the DisplayPort, and your
computer’s operating system and the display
software have to support 10-bit monitor
output. So far, this only applies to Windows 7
(not Mac) and Photoshop CS4 (and later). DVI
cables are only capable of transmitting 8-bit
instructions.

And what is all this effort good for? This
issue’s free DVD includes a test image that you
can use to check how well your monitor
resolves fine tone gradations. It is important
that the full color depth of your images is
displayed on your monitor, and hardware
calibration achieves visible improvements.

The difference between 8-bit and 10-bit
processing was not immediately obvious 
on our Eizo ColorEdge CG275W test 
monitor (hardware calibrated using 16-bit 
LUTs) – probably because this particular
model produces smooth color transitions
anyway. Our Fujitsu P27T-6 IPS test monitor
(software calibrated with internal 12-bit
processing) clearly benefited from 10-bit
signal transfer. Both models have 8-bit IPS
panels with 10-bit FRC. Really clear differences
and noticeably smoother color gradations are
still rare in everyday use.

Monitor Profiling

Monitor calibration using a graphics card’s
LUTs is not strictly part of the color
management workflow, but a badly calibrated
monitor can affect color consistency to an
extent that even the best profile cannot offset.
This is why most programs first attempt
calibration before analyzing a monitor’s color
behavior for the creation of an ICC profile.
Users can enhance the potential success of
the calibration process by making appropriate
brightness, color temperature and contrast
settings on the monitor itself (provided, of
course, that it has controls or an OSD for doing
so). All settings that you make on the monitor
itself are a kind of ‘hardware calibration’ that
doesn’t involve altering the LUTs in the
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This illustration
shows the two
Windows 7 test
images used for
visual monitor
calibration (above)
and downloadable
test images from
www.simplefilter.de
for making gamma,
white point and black
point settings
(below)

All parameters that can be adjusted via a monitor’s on-screen display (above) are written directly to the
device’s hardware and thus qualify as a form of hardware calibration. Take care when making changes to the
settings in a graphics card’s control panel (above right). These alter the card’s LUTs and can make it
impossible to calibrate a monitor correctly using third-party devices.



graphics card. Any anomalies that cannot be
remedied in the hardware or via the LUTs are
then recorded as deviations from the
reference value in the monitor profile. The
profile will also contain the monitor’s RGB
primaries (in the XYZ color space), an ideal
white point, a gamma correction curve and
often a large color correction table. The
particular values for the graphics card’s
calibration LUT are also part of the profile and
are loaded either at system startup or when
the profile itself is activated. To do this, most
calibration programs are equipped with an
autoloader that is located in the Startup folder
on Windows systems.

Believe Your Eyes

Although your own eyes are by no means
perfect, they are the yardstick for your success
and are fine for performing an initial visual
calibration. Your targets are created by your
display software anyway, and many image
processing programs are equipped with
‘visual calibration’ functionality, as are
Windows 7 and OS X. 

These tools all work on the same principle,
and use test images to help the user set white
and black points that preserve detail in bright
and dark image areas while displaying neutral
grays (with no color casts) and a gamma value
that suits the current workflow. The black and
white point and gray value adjustments are
usually made on the monitor (i.e., hardware
calibration) and only the gamma correction
values are stored as part of the ICC profile,
which is used to load them into the graphics
card’s LUT.

But that’s it as far as visual calibration is
concerned. Gamma correction is limited to a
narrow range of brightness values, and the
ability of the human eye to accommodate
makes it virtually impossible to set color
temperature and color space values or judge
luminance accurately.

Whatever you do, don’t be tempted to
‘calibrate’ your monitor using the ‘DQ test
cards’ used by many print services. The idea
is that you adjust your monitor to match the
colors in the test print, but what this actually
ends up doing is calibrating your monitor to
match the color profile of one particular

commercial printer. This pseudo-perpetual
soft proof is fine if you only want to work
with that one particular service, but is
guaranteed to produce false colors as soon
as you view images that were profiled
elsewhere.

Don’t Guess, Measure!

A dedicated colorimeter is quite cheap to buy
and is more precise than visual calibration. We
recommended you use one if you are serious
about your image processing. We tested the
Datacolor Spyder3 and basICColor Discus
models. Both devices are sold as colorimeters,
although basICColor claims that its product is
as precise as (or even more precise than) some
spectrophotometers. This difference is
evident in the price difference between the
Spyder3 (about US$160) and the Discus
(US$1300). Software is included in the
Spyder3 package, whereas it has to be
purchased separately for the Discus. The
basICColor Display calibration software (about
US$120) is more sophisticated than the
Datacolor offering and can be used with other
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You don’t need a separate colorimeter to calibrate the Eizo ColorEdge CG275W. This model has a
built-in calibration sensor that folds out when needed. This US$3,300, 27-inch monitor can be
hardware calibrated without the use of a computer by way of a 16-bit 3D LUT. The proprietary
Eizo ColorNavigator software can also be used with third-party colorimeters.



colorimeters, including the Spyder3, whereas
the Datacolor software only works with the
Spyder hardware. Both programs enable you
to calibrate multiple monitors on a single
system.

basICColor’s licensing system prevents the
use of its products on multiple computers,

and you have to purchase a separate license
for US$75 for each additional machine. The
Datacolor license allows you to install its
software on computers at a single location
and on up to five notebooks. It also allows you
to transport a prepared notebook to your
monitor’s location and to connect the two for

calibration purposes. Any profiles you create
using the software can be distributed but not
sold as part of any professional services you
may offer.

The Calibration Workflow

Allow LCD monitors to warm up before
calibration and familiarize yourself with your
monitor’s controls and settings before starting
the process. The following description applies
to the Spyder3 Elite software used with the
Spyder3 colorimeter on a Fujitsu P27T-6 IPS
monitor. Calibration software that is matched
with the monitor you are using (which is often
the case when the soft- and hardware come
from the same manufacturer) can alter some
monitor settings automatically, which saves a
lot of effort playing with the fiddly monitor
buttons.

If your monitor has a ‘custom’ setting, this
is the best one to use – otherwise simply use
the brightness and color temperature settings
that you like best. The brightness of an LCD
monitor is controlled by the brightness of the
backlight and alters the black point (i.e., the
amount of light that an unlit LCD cell allows
to pass through). The color temperature of
CCFL backlights and ones that use white LEDs
cannot be altered. Only the brightness of RGB
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Brightness: This setting depends on the
brightness of your surroundings. If you
position your monitor in a darker part of
your room and face it away from any
windows, 120 cd/m2 (or even less) should
be sufficient. Some monitors have ambient
light sensors that automatically adjust
brightness to match the situation – a
feature that is anything but helpful when
setting a color managed workflow. The
color sensitivity of our eyes also depends
on the brightness of the image being
viewed.

Color Temperature: 6500 K (D65) is often
recommended for photographic purposes,
while 5000 K (D50) is an widely used value
for pre-press work. D65 looks better in
artificial light, whereas D50 looks better in
daylight. If your monitor doesn’t happen to
be located right next to a standardized

light box, the color temperature you set is
not that important and your eyes will
quickly compensate for any anomalies.
5800 K is a good compromise that works in
a variety of ambient lighting situations.

Gamma: Select the gamma value for the
working color space of the majority of your
images. sRGB, AdobeRGB and ProPhoto
RGB all have the same gamma value of 2.2.
The luminance value in the L*a*b* color
space – written L* and pronounced
‘L-star’ – has a similar effect to a gamma

value of 2.2, but better visual linearity.
Some monitors and calibration programs
offer L* as an option, and this is a good
choice if you are working in the eciRGB v2
color space. Note that eciRGB v1 uses a
gamma curve with a value of 1.8.

Color Space: Only if your software is fully
color management-compatible and can

correctly interpret your image data will you
be able to use a wide gamut monitor to its
fullest extent. Unfortunately, many Web
browsers and office applications don’t
support color management, although
Safari and Firefox (3.5 and later) are now
compatible. Internet Explorer lacks
monitor profile translation functionality
and, as a result, interprets AdobeRGB
images as sRGB, producing dull colors.
Conversely, it produces over-bright colors
when displaying sRGB images on a wide
gamut monitor. In the latter case, you can
improve the situation by switching the
monitor to sRGB. Most conventional
monitors are preset to sRGB, while wide
gamut monitors often have additional
AdobeRGB and NTSC options. It is always a
good idea to use a monitor’s own presets if
you are planning to calibrate it using one
of the predefined color spaces.

Recommended Monitor Settings

The basICColor Discus (left ) and the Datacolor Spyder3 colorimeters shown with their
respective software interfaces. Calibration programs require independent installation
to work correctly – installing two such programs simultaneously on a single computer
produces unpredictable results and can even cause your system to crash.



LEDs can be altered without having to alter
the brightness of each pixel individually.
Leave the contrast setting unaltered at 50%
and set the gamma value to 2.2. These are
proven reference values that you can always
use as a jump-off point for calibration, even if
your program uses the L* gradation curve
instead of a conventional gamma value.

While gamma/L* corrections serve to keep
color transitions balanced, the gray balance
setting ensures that gray tones are
reproduced without color casts at all
brightness levels. The RGB tone curves are
adjusted separately, and we recommend that
you use the iterative gray balance method if
you often work with black-and-white images.
This takes longer but produces more
reference points and is more precise than the
standard gray balance setting.

The first steps in the calibration process
assess the primary colors and the white and
black points. The Spyder software then
requests that you enter an approximate
brightness value. Any remaining inaccuracies
are equalized later by the profile. The rest of
the process is automatic and delivers
before/after images so that you can compare
the results of the process with the look of the
uncalibrated monitor. The program also
produces two-dimensional color space
comparison diagrams, which you can use to
compare your results either with three
standard profiles or with other monitor
profiles that you have created yourself.

From the profile overview, you can
navigate to the Advanced Analysis screen,
which includes an option for checking screen
uniformity. Any discrepancies in the eight
quadrants used to compare the rest of the
screen with its center are displayed
graphically. Unfortunately, this is a purely
informational tool and offers no functionality
for ‘correcting’ any deviations it reveals. 

The Datacolor software produces matrix
profiles and writes all correction values to the
graphics card (i.e., software calibration). The
basICColor Display software is also capable of
hardware calibration. It can be used with the
Spyder hardware too and can produce LUT
profiles with as many as 700 reference points.
These are more precise than the ones
produced by Datacolor and our test profiles
contained a slightly larger color space. Both
programs can produce ICC version 4 profiles.
There are presets for various situations, such
as outdoor (with a higher overall color
temperature for notebook users on the road),
indoor, Web design and pre-press. In general,
the basICColor software was more clearly set
out and easier to use. Datacolor includes
plenty of options, but they are more difficult
to find.
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The software enables you to check your results using (rather small) sample images or
using 2D color space diagrams (shown here compared with the sRGB space). The 3D
view on the right (created using ICCView) shows that the monitor’s own color space is
larger even than the AdobeRGB space in some places.

Spyder3 Elite’s advanced options include a built-in tool for analyzing screen uniformity

The Spyder3 Elite software requires you to identify your monitor’s controls and enter
target values before starting the calibration process. The software also has an expert
mode in which you can define your target values more precisely and create your own
tone curves.



Color management only works properly if it is
part of a complete system. Apple was quick to
recognize this and introduced its own
ColorSync system in 1993. Microsoft’s
Integrated Color Management (ICM) offers
system-wide color management functionality,
but it is the application manufacturers who
have to ensure that the guidelines are
implemented. Many approach the subject
rather half-heartedly and some simply don’t
bother, making it necessary to adjust a
number of settings yourself. 

Microsoft itself is inconsistent too – even
the latest version of Microsoft Office doesn’t
support color management and the
implementation in Internet Explorer is still
only half finished. 

With the introduction of XP, Windows
finally included a well-thought-out profile
management system similar to ColorSync,
although Microsoft managed to compound
the confusion by introducing the Windows
Color System (developed together with
Canon) with Vista. Theoretically at least, WCS
is superior to the traditional Windows
ICC-compatible color management system,
but it has yet to be adopted by any major
hardware manufacturers. As long Windows
XP, 7 and 8 support ICC profiles, there is no

need to pay WCS any attention, especially if
your hardware supports ICC profiles too.

Most current image processing software is
color management-compatible but, for more
than 11 years now, Photoshop has remained
top of the heap with regard to flexibility. The
current Adobe CM system was introduced
with version 6.5 which, theoretically, still has
better color management chops than much
of the brand new competition.

Setting up Color Management
in Windows
The most important part of any color
management system is the color
management module (CMM), which is part 
of the computer’s operating system. This
module also allocates appropriate profiles to
devices attached to the machine. A fresh
Windows 7 installation includes a generic
(WCS-based) sRGB monitor profile and a few
other standard device profiles. All other
profiles are installed later on with applications
and device drivers, or automatically during
monitor calibration. 

All devices (and their profiles) that
Windows recognizes are listed in the Color
Management tool in the Control Panel. You

can adjust their settings manually, provided
that you have checked the Use my settings for
this device option.

Many image processing programs pay
little or no attention to the color
management settings you make in the
operating system. Photoshop automatically
uses the Windows monitor profile, but you
have to set it manually if you are using GIMP
or Photoline. Other image processing
programs rely on the user making the correct
operating system settings. For example,
Paint Shop Pro’s color management only
works if Windows has at least one monitor
profile installed, and printer profiles, too,
have to be installed in Windows before they
can be selected in the Corel interface. Profiles
have to be installed in the standard Windows
folder (System32\spool\drivers\color) so that
third-party programs can find them.
Installing new profiles is a simple matter of
right-clicking the appropriate file and
selecting the Install Profile option at the top
of the context menu.  Windows then
automatically copies the profile to the
correct folder and lists it in the Color
Management interface. Most image
processing programs use the same standard
path to look for ICC profiles.
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The most important profile
conversions that take place
during image processing:

The image data from the
camera (far left) is processed
either in its original color
space or in the application’s
working color space. It is
then converted to the
monitor’s color space for
display, the printer’s color
space for printing or into a
standard space (such as
eciRGB) for further
processing by third-party
services. The printer profile
can also be used to create a
soft proof for viewing on the
monitor.

Operating System Colors



If you install a new printer using the
manufacturer’s CD, the software often installs
a generic printer profile and assigns it to the
printer. However, downloaded or home-made
profiles have to be assigned manually to the
appropriate device. However, most
applications and device drivers don’t actually
pay heed to this information, making it
necessary to select the appropriate profile
manually in the application interface or device
driver control panel. Be careful not to
integrate a profile into the workflow twice. If a
printer profile is already assigned to a color-
management-compatible application, you
have to make sure that color management is
deactivated in the printer driver itself. In
principle, it is possible to perform this process
in reverse, but this is less reliable because not
all applications are capable of communicating
a file’s color space to the printer driver. 

Assigning a profile to a device in the
Windows color management interface can also
cause additional confusion. for example, in
Corel Photo-Paint versions X4 and earlier, such
a profile is listed in the Corel color management
dialog once as a description of the profile and a

second time under the name of the device.
Profile names can also be a problem, and
process-internal naming schemes are by no
means guaranteed to be the same as a profile’s
ICC filename. Windows color management lists
both names, but many programs (including
Photoshop) only recognize a profile’s internal
name. Eizo’s Color Navigator gives each newly
generated profile the same default name
(‘Photography’), which means that Photoshop
only ever lists one Eizo-based profile name.

In conclusion: leave Windows’ own color
management as wide a berth as possible and
use your application’s built-in color
management functionality as much as you
can.

The Color Management
Workflow
Monitor calibration and correct operating
system setup are the basic prerequisites for
any color managed workflow. Provided that
your display software offers appropriate
support, this will guarantee faithful on-
screen colors. 

Strictly speaking, even these preparatory
steps aren’t always necessary, as the simplest
of all workflows involves passing your image
files on to a print service exactly as the camera
captures them in either the sRGB or
AdobeRGB color space. All print services are
capable of interpreting sRGB files, and 
sRGB is also widely recommended for Web
publication purposes. 

sRGB extends beyond some printer color
spaces in some places and is smaller in others.
Where it is larger, bright on-screen colors
simply cannot be reproduced in print, while a
smaller color space doesn’t use the printer’s
potential color range to its full extent. It can
happen that a strong print color really is
present in the subject but remains invisible on
the monitor because it is not included in the
sRGB gamut. A ‘faithful’ color is a relative
concept, and there is nothing to be said
against adjusting blue and cyan saturation in
an image until it matches our memories or our
personal taste. Color management is not
designed to keep colors true to nature, but
rather to help ensure that we end up printing
or publishing the colors we want, whether
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these deviate from those in the original
subject or not.

This process requires the use of a color
space that is at least as large as the one used
by your chosen output device. sRGB is simply
too small for making high-quality prints on
high-end photo paper and is much too small
for use with inkjet photo printers. AdobeRGB
has a larger gamut, but still doesn’t include
many printable colors. The best currently
available color space for print output is
eciRGB_v2, and print services that claim color
management compatibility should be able to
work with it. But remember: it is only worth
using color spaces that are larger than eciRGB
if you use a 16-bit image processing workflow.

The illustration below depicts a number of
workflows with various different types of
input files, output devices and quality levels.
These all assume that the original camera files
are either sRGB JPGs or RAW. Because it only
offers marginal improvements over sRGB, we
haven’t included AdobeRGB here. In principle,
you can substitute AdobeRGB for every
instance of sRGB in the illustrated workflows,
but you will then have to insert an additional
conversion step for every print service that
doesn’t offer AdobeRGB processing.

If you shoot in RAW and use a high-quality
RAW converter, you will be able to squeeze
every last drop of quality out of your image
files, including the use of your own camera
profiles if you wish. Many contemporary RAW
converters have a wide range of built-in image

editing tools, making separate image
processing software increasingly redundant.
Lightroom can be used to output RAW image
files using all standard RGB profiles and can
convert files to any RGB profile you like during
export for transfer to a print service. 

If you do want to use a separate editing
program, first convert you files to the larger,
8-bit-compatible eciRGB color space.
Unfortunately, Lightroom doesn’t offer an
eciRGB option for file import (the External
Editing preferences only offer sRGB, AdobeRGB
and ProPhoto RGB), so the only alternative is to
use the appropriate export function. Lightroom
uses the ProPhoto color space for its internal
processing, thus saving you a conversion step
if you use it from the start. The other potential
advantage of using the ProPhoto space is that
in future, when monitor quality has improved,
you might just benefit from your prescient use
of a large gamut and 16-bit processing. For
now, ProPhoto still exceeds the quality offered
by most of today’s output devices.

Working with Color Spaces:
Two Basic Concepts
Most pro-grade image processing programs
support device profile management and
assignment and some (such as Photoshop and
Photo-Paint) even have their own color
management module (CMM). 

There are two basic approaches to
contemporary color management. The more

modern of the two was introduced by Adobe
with Photoshop 6.5 and gives the user a great
deal of technical freedom but only alters
image files if you explicitly tell it to. The
application is in effect the stage on which you
use an appropriate monitor profile to present
your images in their best possible light.

Using this model, images retain their original
profiles (however exotic these may be), but can
also take on other profiles – either as an
additional layer that doesn’t affect the original
image data but gives the image a new look, or
as an integral part of the file’s bits and bytes that
changes its structure but not its appearance.
The ‘working color space’ plays a less significant
role in programs that work this way, and is only
assigned to newly created files or ones whose
color space the program cannot detect. Adobe
labels images with no recognizable profile ‘no
tags’. The program’s working color space is only
assigned to a file for as long as it is open, so an
image can look quite different if opened using
an alternative program.

The second basic color management
concept takes the term ’working color space’
literally, and the program performs all image
processing tasks exclusively within this space
(also known as ‘internal RGB’). If you open a
file saved using a different color space, it will
be automatically converted to your program’s
working color space – in other words, every
image is given the same ‘costume’ for the
duration of its ‘appearance’ on the program’s
stage, regardless of whether it actually fits. If it
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doesn’t, the image data is automatically
adjusted accordingly. No conversion takes
place if the file’s profile and the working color
space match completely, by name as well as
in reality. This is not usually  a problem for a
workflow in which all images come from a
single source and have a single output
destination. All you have to do is set the
working color space to match the space of the
incoming images or your chosen output
medium. 

Not all programs allow you to select the
working color space. For example, before the
introduction of the X version, PaintShop Pro
only supported sRGB, and this is still the case
with Picasa and FixFoto. Today’s images come
from multiple sources and are often destined
for use in multiple output formats, making this
particular color management concept
inflexible and – to be blunt – outdated.
Among the more expensive programs we
looked at, PaintShop Photo Pro was the only
one still using it.

The latest (X5) version of Corel’s Photo-
Paint uses a completely revised color
management concept that is very similar to
the Adobe model. GIMP and PhotoLine also
offer flexible color management functionality,
although GIMP is not yet 16-bit compatible.
Photoshop Elements offers a compromise,
allowing you to open and process any type of
image file, but offering only sRGB and
AdobeRGB as working color space and output
conversion options. The program supports
neither CMYK nor third-party RGB profiles. The
sections on the following pages describe the
color management settings for the programs
mentioned here. Lightroom is an exception, as
it requires virtually no mandatory settings.
The steps necessary for Lightroom are
described in the ‘Workflow’ section above.

Application Setup

The first step is to check that your freshly
installed application is using the correct
monitor profile. The second step involves
selecting a working color space. We
recommend that you use either sRGB or
eciRGB depending on the software you use
and the structure of your workflow (see page
33). Select a grayscale color profile with a
gamma value of 2.2. CMYK profiles aren’t
relevant to the current process. The settings
you choose at this stage determine how your
software handles images that have a different
profile or no profile at all. The color
management dialog (and often the soft
proofing settings too) can usually be found in
the File or Edit menus. Where applicable, we
will also show you what to look out for when
assigning and converting color profiles.
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Photoshop’s libertarian color managment system (above) gives the user complete freedom of
choice when it comes to profile conversion, assignment and use. Every open file can have a
different color profile. The dictatorial concept used by PaintShop Pro (below) automatically
force converts all files to the program’s working color space during loading. The program
behaves like an additional workflow ‘device’ with its own color profile.
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Adobe Photoshop
Photoshop’s Color Settings have hardly changed since
the release of the 6.5 version. The program uses the
monitor profile stored in the operating system, which is
displayed in the list of RGB color spaces. Photoshop has
its own CMM, called the Adobe Color Engine (ACE),
which is usually the best option. Always check the Use
Black Point Compensation option and Use Dither for
photographic purposes – this reduces the risk of

producing color smears in soft color transitions when
you are converting files to smaller color spaces. The
four rendering intents are always available but are only
relevant if you are using table-based (LUT) profiles for
printing or processing by a third-party print service,
although even then, you won’t always need them. The
Relative Colorimetric option nearly always produces the
best results.

Adobe Photoshop Elements

Photoshop’s little brother offers only sRGB and
AdobeRGB as native options, but is capable of
processing other types of RGB profiles and embedding
them when saving files. 16-bit images can be opened
and processed using a restricted set of tools. sRGB and
AdobeRGB are the only target color space options and
profiles cannot be manually assigned at all.
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Corel Photo-Paint X5

Corel’s Color Management dialog has been available in
its current form since the release of the X5 version of
Photo-Paint and differentiates clearly between default
(program) and document settings. In contrast to earlier
versions of the program, the color profile of an open file
can vary from the working color space, which can be
selected in the ‘Color profiles’ section of the dialog. The
current monitor profile is also included (without an
obvious label) in the list of RGB/monitor profiles that

Windows assigns to the monitor you are using. You can
choose from three color engines that don’t include the
Adobe competition. Corel’s color management policies
are slightly more detailed than Adobe’s, and profile
conversion and assignment options are clearly grouped
in the Document Color Settings dialog. The Preserve
pure black option is part of the Default Color
Management Settings dialog. 

Corel PaintShop Photo Pro
We recommend that you use eciRGB as your working
color space. In the upper dialog, you can choose from
the color profiles that Windows has assigned to the
(primary) monitor. There is no choice of printer profile –
you have to use the system's default profile, which can
only be changed in the Windows device manager. The
rendering intents only play a role when you are printing
or soft proofing. There are no dedicated profile
conversion or assignment options, making it impossible
to convert images to use a third-party printer profile. In
such cases, you should save your images to eciRGB with
an embedded profile. You can save a file to the sRGB
space without an embedded profile by using the Save
for Office option.
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PhotoLine

PhotoLine’s Color Management settings are split into
Standard and Devices categories. The profiles selected in
the Standard dialog are only relevant for new files or
ones without tags. If you select the System option, the
program uses the settings made in the Windows color
management dialog. The Devices settings can be used

to select printer and monitor profiles. You can switch
printers in the Print dialog (in the File Menu) without
having to change any system settings, but the
appropriate printer profile has to be selected manually
in the Color Management dialog. The soft proof profile
can also be selected in the Devices section.

Uniquely, PhotoLine allows you to assign different
profiles to individual image layers – a feature that can be
useful when comparing layers, but has no other obvious
use, as no other program is capable of reading such a file
and all layers are saved to the document’s own profile
and embedded when you save a file in PSD format. 

GIMP
GIMP uses the operating system’s monitor profile but
allows you to make other settings too, which can be
important if you are using it in a Linux environment. The
only global policy you can select is File Open Behavior,
and selecting the Keep Embedded Profile option causes
the program to behave like most of the others

mentioned here. GIMP automatically reduces 16-bit
colors to 8-bit when it opens a file, so a smaller,
8-bit-compatible color space such as eciRGB is the best
option when you are exporting images from a RAW
converter. The tools for converting and assigning color
profiles are located in the Image > Mode menu. 



It wasn’t so long ago that ‘color management’
was a concept unknown to most print service
providers. A quick Web search reveals that
many online services now offer full color
management and at least one soft proofing
profile. For our test, we used only services
that print on photo paper (i.e., no inkjets), and
paid between 40 cents and US$10 for a 
6x8-inch print. Rather than making any
direct comparisons, our aim was to get a
handle on the print scene in general, from
‘cheap and cheerful’ to high-end. We noted
that some vendors specifically advertise their
color management support and provide links
to Web pages that supply ICC soft proofing
profiles for particular paper types, and some
even offer 3D color space comparisons.

The soft proofing profiles provided by
most vendors proved to have significantly
more cyan/blue tones available than sRGB,
AdobeRGB and eciRGB. The number of
available tones can be compared by means of
the ‘Cubic Colorspace Units’ (CCUs) used by
web services like ICCview. Our test vendors
produced values between 480,000 and
725,000, but the size of a printer’s available

color space still doesn’t tell us anything about
the quality of the prints we will receive or
whether the resulting colors are the ‘right’
ones. The real art of producing faithfully
colored prints involves filling the color space
of the output device as precisely as possible
with the colors contained in the image. This
process is called mapping.

We ordered a series of seven test images
from each of our chosen vendors (see the box
below). We saved these in sRGB and
eciRGB  (v2) as well as using the supplied
device profile. Virtually none of our test
candidates’ websites actually specified
whether the downloadable soft proofing
profile they supplied was also intended for
use with an actual order. After enquiring, we
were told that we shouldn’t convert our
images using the provided profile, but we did
anyway and ended up getting pretty good
results: some were even better than those we
got using standard color spaces. Before we go
into more detail on our test results, let’s look
at what the process of soft proofing actually
entails and how it can help achieve better
results.

Soft Proofs

With access to the appropriate output device
profile, you can not only calculate how specific
colors will look, but also display them –
provided, of course, that your display has a
larger color space than the output device you
want to simulate. This is why it is preferable to
use a wide gamut monitor rather than a
conventional sRGB model for soft proofing.

If you don’t have access to a wide-gamut
monitor, you can use a software-based
out-of-gamut warning to help you avoid
making mistakes. Not many programs include
out-of-gamut warning functionality, but once
again, Photoshop comes to the rescue.
PhotoLine has soft proofing functionality but
does not support out-of-gamut warnings.
GIMP supports both, but doesn’t support
16-bit processing, making it less suitable for
use as part of a RAW processing workflow.

Lightroom has all the features necessary for
setting up a complete, high-end color
managed workflow and is capable of
exporting images using your choice of output
profile. Soft proofing functionality is built into
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We used RAW images with strong colors
that we developed using Lightroom. We
concentrated on producing well saturated
but differentiated colors and saved the
images as 16-bit TIFFs using the ProPhoto
RGB color space. We then created a
collage of the images in Photoshop and
added a color gradient (converted directly
from L*a*b*), a Fuji reference sRGB image,
color graphics and some gray reference
wedges. The final image measured
30x40 cm (at 300 ppi) and was converted
for printing by each vendor to sRGB and
eciRGB, as well as using the downloaded
proofing profiles (with both perceptive
and relative colorimetric rendering intents
if applicable). Depending on what was on
offer, we had the images printed either at
full size or in 20x30/15x20 cm with the
best available quality and without
‘optimization’.

How We Tested

The major hurdles in our test images are the red and blue colored petals, which
lie way outside the sRGB and AdobeRGB color spaces. Color gradients are a
good tool for judging if and when color and contrast will be altered during the
printing process. A successful color management system will keep any
discrepancies here and in the sRGB image at top left to a minimum, regardless
of which profile is used to save the image. 

How to Get Consistent Colors in Print



version 4 of the software (see page 118). 
There is a commercial plug-in available 
for earlier versions (for GB£10) at
www.lightroom-plug-ins.com/ProofIndex.php,
which you can use to create up to four profile
presets, each with its own rendering intent.
However, images can’t be edited in the soft
proofing view, so exporting your images as
16-bit TIFFs in the largest possible color space
(i.e., ProPhoto RGB) and then processing them
in Photoshop (or any other 16-bit-compatible
program) is a more useful option.

You need to set up the soft proof view
before you begin soft proofing. In
Photoshop, navigate to View > Proof Setup >
Custom. You can then toggle between the
normal and proof views using the Ctrl+Y
keystroke, while Ctrl+Shift+Y switches the
out-of-gamut warning on and off. The proof
and warning views can be combined. You
can save your custom proofing profile as a
preset that subsequently appears in the
Proof Setup menu. This is a highly user-
friendly approach, as most other programs
require you to make your settings in the

program’s preferences before you start
work.

In Lightroom 4, the S key switches to the
proof preview. You can select a profile and a
rendering intent in the Proof Settings panel,
where there is also a check box that switches
on a Simulate Paper & Ink option. Lightroom 4
doesn’t support CMYK profiles and the proof
preview can only be viewed in the main
program window – a serious drawback for
users with dual monitors. There are image and
monitor gamut warnings and any
adjustments you make are non-destructive, as
they are applied to virtual copies of your
images.

Improving Your Results

The proof preview highlights where problems
might occur during printing. Highly saturated
colors – especially green and red – are often
difficult to print correctly, even if they can be
properly displayed on a monitor. Conversion
to a smaller color space results in a loss of
detail and can cause color shifts. 

Make a copy of your original image 
(Image > Duplicate) and Tile your windows to
position the two copies next to each other.
Now switch on the Proof Colors view and the
Gamut Warning. The original image remains
untouched and serves as a comparison.
Create a new Hue/Saturation Adjustment
layer in your image copy, select the color
range where the gamut warning shows and
reduce saturation in these areas until the color
warning disappears. If necessary, you can
repeat these steps for other color areas. If the
resulting image looks too dull in the Proof
Colors view, increase contrast using a Curves
adjustment layer, but note that this will have
the side effect of once again increasing
saturation. You can reduce this effect by using
Luminosity blending mode on the Curves
layer. To correct color shifts, select the
affected color and adjust the Hue slider in the
Hue/Saturation adjustments panel.

The disadvantage of this method is that, as
well as adjusting out-of-gamut colors, it also
influences all the other colors in an image,
including the less saturated ones that would
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Soft proofing settings for various programs:
Photoshop (top left) and Lightroom 4 (bottom right) allow you to simulate paper white and ink black (which is never quite pure
black). In Photoline (bottom left), the proofing profile setting is located in the Color Management > Devices section of the
program’s main Options dialog. GIMP’s settings (top right) are located in the Color Management section of the Preferences
dialog or under View > Display Filters. Activating both instances applies the profile twice.



have fitted into the new color space anyway.  In
other words, we have the same problem that
occurs when we convert to a new color space
using a ‘perceptive’ rendering intent. There is
no perfect solution to this dilemma, so we
always have to find a compromise and judge
the results by eye. It would be much better if
we were able to adjust only the colors that lie
outside the target gamut. The Photoshop Select
> Color Range dialog offers the Out of Gamut
option when selecting a range, but this
unfortunately applies to the CMYK working
color space selected in the Convert to Profile
dialog and not that of the proofing profile. RGB
profiles of the type we require for printing on
photo paper cannot be selected here at all.

The only alternative left is to adjust colors
manually. This is more complex and
time-consuming, but it is the most flexible
method of all. The following sections describe
the method using Photoshop, but the
individual steps can just as well be applied to
other programs that have gamut warning
functionality:

–ˇSwitch the Gamut Warning on
(Ctrl+Shift+Y).

–ˇCreate a new Hue/Saturation adjustment
layer on top of the image layer.

–ˇReduce saturation until the gamut warning
color completely disappears. It is better to
repeat this step for each affected color
rather than to apply it globally.

–ˇSelect the new layer mask (which is
produced automatically when a new
adjustment layer is created). Invert the mask
or fill it with black to block the effect of the
adjustment layer and allow the gamut
warning color to show.

–ˇUse a white brush with an appropriately
sized soft tip and about 30% opacity to
paint over the image areas that are covered
by the warning color. Because the layer
mask is active, you are actually painting 
into the mask, making it partially 
transparent in the areas where you have
reduced saturation. Apply the brush
repeatedly until the warning color has
completely disappeared.

A mask that is used exclusively to work on
out-of-gamut colors has an effect similar to
using a ‘relative colorimetric’ rendering intent
to convert color spaces, and runs the risk of
blurring the differences between otherwise
finely differentiated tones. The advantage of
using a mask instead of a particular rendering
intent is that it can be adjusted to precisely fit
the needs of a specific image. The aim of the
exercise is to preserve as much color detail as
possible when converting an image from a
larger to a smaller color space. The luminosity
of monitor colors can never be reproduced in
print anyway, so the process always involves
compromise.

If you are testing a new print service or
output process for the first time, it is a good
idea to save the image with its adjustment
layers and masks in its original color space
before making any changes. You can then
compare the original with a test print of your
converted image to see where you might
need to make further corrections. The image
file that you wish to have printed should be
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Correcting out-of-gamut colors using a Hue/Saturation adjustment layer and a layer mask.
Reducing saturation for the yellow tones (as shown in the right-hand half of the frame) preserves
details that would be lost during conversion using a conventional profile (shown on the left).



saved as a JPEG file with the new (i.e.,
converted) color space embedded. You can
choose whether to use the ICC profile you
used for soft proofing, a standard profile such
as eciRGB or your vendor’s ICC profile.  

Theoretically, an output device’s own
profile should produce the best results,
although we found that the eciRGB versions
of our test images often looked better in print.
This could be because the vendor’s soft
proofing profiles match a series of machines
rather than a specific one. Fuji, for example,
provides generic profiles for various types of
minilab and photo paper.

It is important to note that soft proofing is
not reliable if a printer or lab machine has a
larger color space than your monitor. In this
case, the gamut warning won’t register any
discrepancies, but the colors on the monitor
might end up looking muddy, and it is all too
easy to overcorrect them as a result – even 
if the printer in question is capable of
reproducing all the tonal differences present
in the image. Photoshop’s Monitor RGB setting
(in the View > Proof Setup menu) reduces the
saturation of the colors displayed on the
monitor, which gives an image a slightly dull
look, but makes tonal differences in highly
saturated areas visible. You can achieve the
same effect in other programs by globally
reducing saturation.

Hard Proofs

We had our smaller test images printed on
minilabs such as the Fujifilm Frontier or Agfa
D-Lab and our larger formats on Durst
Lambda and Theta or Océ Lightjet machines.
Our enlargements were made on Fujifilm and
Kodak photo paper using RGB laser and LED
machines. These have an internal working

color space that is larger than sRGB but are
nevertheless described as sRGB devices. This
makes sense when they are used as part 
of a mass market sRGB workflow, but the 
process usually includes automatic image
‘optimization’ that has to be switched off in
order to conform to a properly color-managed
workflow. The machines themselves cannot
interpret individual profiles, but usually have
an sRGB mode that can be switched on and
off. The Fujifilm Frontier calls this
PD/no-convert mode and requires image data
to be delivered in the machine’s own color
space, ideally using a profile that is custom
built to suit the specific machine and paper
type being used. Conversion has to be
performed either by the customer or the
service provider before printing, so achieving
colors that are better than standard sRGB
involves a lot of hard work and probably
produces a lot of reject prints too. The end
result is that there are very few print service
providers who are prepared to take the
trouble to use non-standard color spaces.

Making Test Prints

A simple test print of a rainbow gradient will
show whether your chosen vendor can handle
embedded color profiles. Save your gradient
in sRGB and convert the resulting image to all
the color spaces you wish to test. Send these
images (with embedded profiles) to your
chosen vendor(s) for printing. The colors in an
sRGB rainbow gradient all fit into other
standard color spaces (such as AdobeRGB or
eciRGB) as well as the printer’s device color
space, so they should all look identical in print.
This test also shows whether the vendor
applies any ‘optimization’ to color contrast in
order to produce crisper looking results. This

type of process produces obvious steps in
otherwise soft color transitions.

Our across-the-board test produced only
average results. A couple of the vendors we
tested provided adequate color management,
while one failed to detect the embedded
profile and converted the image a second
time, producing obviously brightened
shadows. One provider only sent us a soft
proofing profile on request, but asked us to
convert our images to eciRGB for printing. This
appeared to be the kind of approach we were
looking for until we discovered that the
eciRGB print looked exactly the same as the
sRGB print produced by the same vendor. 

Only one of the vendors we tested
explicitly recommended that we convert our
images to their device profile for printing,
although in this case, the result was of lower
sRGB print made using the same machine.
None of our test vendors provided clear
online information regarding the profiles they
sent us. We assume that they are only
intended for soft proofing use and are generic
profiles that don’t relate to specific output
devices. Vendors who do use machine-
specific profiles are generally reluctant to
distribute them. This represents a degree of
logistical precision that is difficult to provide
in the real world and, even if a vendor is able
to provide a profile that applies to just one
machine and one type of paper, it is difficult
to guarantee that exactly that machine will be
used for a specific print job. The same
problem applies if you send an image of a
target to a vendor for remote profile creation,
and many vendors simply aren’t prepared to
make the effort. And if you want to share and
output files using device-independent
profiles, you can always use a standardized
color space anyway.
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The limitations of the sRGB
color space are particularly
evident in the blue tones 
(in the center). Using the
device profile (on the left) or
eciRGB (on the right) produces
a much larger color range.
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Curiously, we also had one case in which a
vendor’s proofing profile produced better
results than any of the standard profiles, even
though the vendor explicitly requested that
we don’t use the supplied profile for output.
We also achieved better results using device
profiles with slightly increased saturation than
we did using eciRGB profiles.

Test prints are essential if you want to use
a device profile for output. The use of different
rendering intents produced varying results at
some of our test vendors and made no
difference at all at others. Although all 
of the services we tested had their
idiosyncrasies, it is generally safe to say that
using a relative colorimetric rendering intent
produces stronger colors but tends to reduce

the degree of differentiation between tones
in highly saturated image areas that contain
out-of-gamut colors. We achieved our best
results using the manual correction methods
described above and a relative colorimetric
rendering intent.

Among the vendors who were able to
handle different profiles, the differences
between sRGB and eciRGB prints were much
more obvious than those produced by using
paper from different manufacturers. sRGB
generally produced paler colors that didn’t do
justice to the color reproduction capabilities
of the paper, especially for blue tones. Inkjet
technology has recently overtaken traditional
photo print techniques as far as image quality
is concerned, and the advantages of using

larger color spaces are particularly obvious in
high-end fine art inkjet prints. Machines with
even finer print heads are likely to be
introduced to the commercial printing
environment in the near future.

When rainbow gradients end up looking as varied as this, you can be sure that
the print vendor concerned doesn’t allow for embedded color profiles

The ColorChecker Mini (in the center) and four prints made from shots of the target
taken in LED light and developed using the indicated profiles

Conclusion
There is a lot of tinkering and compromise
involved in setting up a usable color
management system, but it is definitely worth
the effort! 

Always start by calibrating your monitor.
Setting up your image processing software
and operating system is not as tricky as it
might seem at first and enables you to edit,
output and share your images without any
loss of color or tonal quality. It is then also
much easier to find out whether your printer,
the print service or the images themselves are
at fault should you end up with sub-optimal
results.

Never trust a vendor’s claims regarding
color management without making test prints
first. There are no hard-and-fast rules for
‘getting it right’ and even using sRGB for all
your images doesn’t guarantee success. Many
vendors use sRGB profiles to cater for a mass
market that often prefers bubble-gum colors
to faithful tonal reproduction. Test prints
using supposedly identical paper and print
processes are especially valuable if you are
planning to make expensive large-format
DiBond or acrylic prints. You will usually be
able to tease a quite a lot of extra color out of
your images if you use a large color space
such as eciRGB.

Our acid test was to see whether 
the image of the ColorChecker target we 
used to calibrate our camera earlier on was
reproduced accurately in print. Faithful 
colors in a print like this indicate a reliable
end-to-end color management system. 

Camera calibration is often only important
for one or two ‘critical’ colors, as
demonstrated by the illustration on the left.
These discrepancies are not usually obvious in
everyday photos, and the Adobe standard
calibration profile in Lightroom produces very
good colors in daylight and fluorescent light.
The profile we produced using the
ColorChecker Passport (for LED light) and the
dual illuminant profile we made using the
DNG Profile Editor (for shaded daylight and
LED light) ended up being the best of the
bunch. (keh)  c
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Maike Jarsetz

Precision Selections
The Supreme Image Editing Challenge



There are many selection tools around, but
they quickly reach their limits when faced

with complex or advanced tasks. You can only
really master truly complex selections if you
thoroughly understand the interrelationships
between selections, masks and channels 
and are well versed in advanced masking
techniques. 

This article presents all the grass-roots
knowledge, tools and techniques you need to
make perfect selections as part of your daily
workflow and gives you the edge when it
comes to tackling tougher jobs too. 

We use six in-depth examples to help you
get to grips with the concepts and techniques
involved, and sample images are included 
on this issue’s free DVD for you to practice on.

In addition to the tools built into
Photoshop, there are a number of dedicated
selection plug-ins on the market that compete
for creative users’ attention. We will be testing
some of these in future issues of c’t Digital
Photography and we will let you know
whether you are better off relying on your
own manual selection skills or the latest
advanced algorithms.
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Perfect selections are one of the great challenges for any
Photoshop user, and everyone has their own particular way of
approaching them. The most difficult selections involve hair, 
fur and other complex subjects. This workshop gives you a
comprehensive overview of the techniques you can use to
extract flawless selections from many different types of images.
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You will need good basic knowledge of
Photoshop selection and masking techniques
before you start to make any selection. That
might sound complicated, but in fact, the
differences between a mask and a selection
are minimal. Both serve to display and save
selections and differ only in the ways they can
be edited and fine-tuned.

Masks are the more versatile alternative
and allow you, among other things, to feather
the edges of a selection – in other words, you
can edit its individual pixels. Nevertheless, or
rather because this is the case, it is often a
good idea to make an initial selection and
some basic adjustments using the program’s
automatic tools. They are easy to use and are
quite smart at doing what they were designed
to do.

Once you have made a rough selection,
you have to fine-tune its edges. The best tools
for doing this can be found in the Refine Edge
dialog that was introduced with Photoshop
CS3 and has been getting bigger and better
ever since, but you will still have to correct any
serious flaws in your mask by hand. To do this,
experienced users switch to Quick Mask
mode, which temporarily transforms a
selection into a mask and enables you to edit
it using pixel-level tools such as brushes.

Younger Photoshop users have grown up
using layer masks, which can be used to
permanently save a mask or selection. This
approach enables you to edit a selection at
any time while leaving your original pixels
untouched. Photoshop CS4 saw the
introduction of the Masks panel, which makes

working with masks even more user-friendly.
The Masks panel includes direct access to the
Refine Edge options and other popular
selection tools, such as Color Range as well as
a number of non-destructive edge editing
sliders of its own.

While we are on the subject, the term
‘non-destructive’ leads us straight to one of
the cardinal rules of making selections,
namely: Don’t delete anything! Not a single
pixel! You never know what it might be good
for. But seriously, the Del key and the eraser
should be taboo – unless you use them on the
mask itself. And even in a mask, it’s better to
use a brush to make adjustments. It is all too
easy to delete valuable pixels at the edges of
a selection that won’t actually cause any
problems in front of a new background or can
be integrated into a new image using other
techniques.

At the end of the day, we always work with
pixels. You might think that you are selecting
parts of a subject, but what you are really
doing is sorting pixels arranged in an orderly
pattern into the categories ‘good’ and ‘bad’. If
you are selecting hair, for example, you will
always find pixels that include both hair and
background, and you will have to decide
which are actually useful and which will spoil
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The Basic Principles of Object Selection 

A layer mask like the one shown in the center saves a selection permanently. Advanced masking 
techniques and channels can then be used to make its details visible and editable.

Photoshop’s selection tools are equipped
with differing degrees of built-in
smartness
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the effect you are aiming for. Some pixels will
always fall victim to your image editor’s knife. 

Perfectionists like to create their own
custom brushes for teasing as much detail as
possible out of hair selections. Remember,
there is no such thing as a perfect selection,
but it’s always worth trying to get as close to
perfection as you can.

Selections, Masks and Channels

The distinctions between selections, masks,
channels and layer masks are often blurred.
Channels and masks are pixel-based and are
well suited to analyzing and fine-tuning a
selection’s edges and soft transitions. The
difference between selected and
non-selected image areas is clearly visible in a
mask. 

A mask consists of black pixels that are
displayed red and semi-transparent on the
monitor. The mask is displayed if you switch

to Quick Mask mode by pressing the Q key
and by default in the Refine Edge dialog,
where you can also switch to solid black or
white mask views.

You can use the options in the Refine Edge
dialog to adjust the whole of a selection’s
edge at once. These include smoothing,
feathering, contrast adjustment and Shift
Edge, which increases or decreases the size of
the selection radius. Quick Mask mode is
particularly suitable for refining small details
using the built-in Refine Radius tool. 

The Select > Save Selection command
either saves a selection as a channel or applies
it to the current layer in the form of a layer
mask. The selected areas are unmasked and
are represented by white pixels, while masked
areas are displayed in black. Soft or
semi-transparent transitions are displayed
using gray pixels. Channels and masks 
can be edited and altered at any time using
pixel-based tools.

A selection saved as a channel is not
immediately visible in the image preview, but
can be loaded at will or extracted using video
or layout software. The quickest way to
transform a channel back into a selection is to
press the Ctrl/cmd key and click on the
channel’s thumbnail.

If you click the ‘Mask Edge’ button in the
Masks panel, the Refine Mask dialog appears.
This contains all the same options as the
Refine Edge dialog and enables you to apply
all the same fine-tuning options to your layer
mask.
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A layer mask (on the right) is
the most flexible tool to use
for saving and editing
selections. A selection saved
in the Channels panel (on the
left) is always available,
even though it is not visible
in the image during editing.

Digitally captured hair
always shares its pixels
with the background
(top).
Inevitably, some ‘hair’
pixels will have to go
when you are making a
selection.
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The options
included in the

Refine Edge
dialog allow you

to combine the
best tools for

fine-tuning the
edge of a
selection



In addition to the standard Rectangular,
Elliptical and Row/Column Marquee tools,  the
Lasso and Polygonal Lasso tools are part of
Photoshop’s basic selection toolset. The
Magnetic Lasso tool is where things start to
get really smart – it automatically draws
outlines that snap to the edges of defined
areas within your image. Its width is freely
configurable and you can select it’s sensitivity
to edges and the frequency with which it sets
fastening points. 

Although it is one of the most widely used
Photoshop selection tool, the Magic Wand is
really only suited to making relatively simple
selections, such as single-color shapes. Its
Tolerance value is adjustable but the tool is
still not particularly flexible. However, if you
deselect the Contiguous option, the tool looks
for similar pixels throughout the entire image.
The self-explanatory Sample All Layers option
is also very useful.

The Quick Selection tool has been part of
the Photoshop toolset since the release of CS3
and is a lot smarter than the Magic Wand, as it
combines the features of the Magic Wand
with a Color Range selection. The tool’s

tolerance is controlled by the size of the brush
tip you use and all the pixels within the tip
that have appropriate tonal values are
selected. You can often make genuinely
effective object selections just by moving the
tool vaguely around the appropriate part of
your image and clicking.

The following general rules apply to all of
Photoshop’s selection tools: you can add to a
selection by holding down the Shift key while
extending the outline; you can remove part of
a selection by holding down the Alt key while
tracing the outline of the part you wish to
discard; and the intersection of two selections
can be selected by pressing Shift and Alt while
clicking between them.

The results you can achieve using the tools
mentioned so far are seldom perfect and
usually require tweaking in a mask to get
them just right. You can do this either in Quick
Mask mode or by transforming your selection
into a layer mask – the basic principles and the
tools you can then use are the same. In Quick
Mask mode, the non-selected (i.e., masked)
areas are displayed in semi-transparent red by
default, and any adjustments you make are
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Basic Selection and Masking Tools

The tolerance of the
Quick Selection tool is
controlled by adjusting 
its size (in pixels)

The Magnetic Lasso tool can be tricky
to use and is particularly difficult to
use effectively when selecting straight
edges. A great workaround involves
pressing the Alt key to switch
temporarily to the Polygon Lasso and
using it to draw the straight section of
your outline. The next click you make
switches back to the Magnetic Lasso.

Quick Tip
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How to Define a Custom Brush

Advanced brushwork in Quick Mask mode isn’t
limited to using soft brush tips and varying opacity.
Reached either by  clicking the icon next to the
brush size indicator in the control panel or by using
the Window > Brush command, the Brush dialog
options enable you to define all manner of natural
and random-looking brush tips. There is also a large
number of preset tips with names like Spatter, Star
or Chalk, which you can combine with adjustable
parameters such as Spacing, Scatter, Noise and Dual
Brush to produce endless brush variations.

Step1

You can define a completely customized brush tip
by using the Pencil tool with a really small (2 px)
black  tip to scatter a few dots on a new white
canvas. Use the Rectangular Marquee to select
these dots and define the size of your new brush tip
preset. Now select Define
Brush Preset in the Edit menu.

Your new preset will appear
at the bottom of the list of
Brush Presets. Use the Shape
Dynamics options to define a
suitable Fade value or use a graphics tablet to set
the size of your brush using the tablet’s pressure
sensitivity controls.

Step 2

Photoshop CS5 saw the introduction of a whole new
generation of brush tips alongside the already
enormous range of options. You can now define
parameters such as bristle length, thickness, angle
and stiffness individually. A graphics tablet is a must
if you want to get the most out of the choices this
fantastic tool offers. 

Step 3



performed using black and white pixels, as
they are in a layer mask or when you are
working on a separate channel. This way, you
can correct major flaws with a brush, and, if
required, apply a global feathered edge using
a Gradient. 

In Quick Mask mode, in a channel or in a
layer mask, you adjust a black-and-white or
grayscale image using any of the pixel-based
tools available to you. The most widely used
tools are the Brush (with varying hardness
settings), the Gradient tool, Blur filters, and the
Dodge and Burn tools. Always use the
available options to the full, whether these be
different brush hardnesses or varying opacity
and exposure settings. The Brush Tip options
are extremely wide-ranging and you can even
use them to define your own brushes. The
Dodge and Burn tools are based on traditional
darkroom development techniques and can
be used to selectively adjust highlights,
shadows and midtones, or to precisely apply
partial masks that extend or delete parts of a
selection.

Paths and the Pen Tool

The Pen tool and the Paths it produces are a
relic from earlier times when paths were the
only selection tools that most layout
software was able to interpret. Nowadays,
layout programs like Adobe InDesign are
able to process alpha channels and layer
masks and all their transparent and semi-
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The Pen and Direct
Selection tools use
Bézier curves to
produce precision
edges in selections

If you switch from Quick Mask mode
to the Channels panel, your mask will
be displayed as a temporary channel.
Double-clicking the temporary
channel opens the Quick Mask
Options dialog, where you can select
the mask’s color and opacity. If
necessary, you can also invert the
color to mark the selected areas
instead of the masked ones.

Quick Tip

Use the Refine Radius tool to correct
minor errors in Quick Mask mode
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transparent data. Nevertheless, many
experienced graphic designers and creative
users still like to use paths, if only because
the Pen tool uses the same anchor points,
tangents and Bézier curves that they are
used to. Path creation works exactly the
same way as it does in Illustrator and
InDesign: a click creates an anchor point,
while clicking and dragging creates a curve.
If you press the Alt key while drawing a path
you can alter the position of the anchor
point. You can alter every corner, curve and
smooth point later too, by clicking and
shifting an anchor point with the Ctrl/Cmd
key pressed or by using the Direct Selection
tool (the white cursor arrow).

Completed, temporarily saved paths can
be saved permanently in the Paths panel in a
similar way to the alpha channels described

earlier. Saved paths can then be loaded as
selections using the Ctrl/Cmd key.

A path has to be defined as a Clipping Path
using the options in the Paths panel menu if
you want to use it as a selection that can be
interpreted by older layout software. Leave
the Flatness box empty if you want the
smoothness and complexity of the path to
match the output resolution of your printer.

Mask Editing Tools

To transform a selection into a layer mask,
simply click the Add a mask button at the
bottom of the Layers panel while your
selection is active or click the thumbnail in the
Masks panel if you want to create a mask for
the background layer. Once you have
transformed your selection, you can edit it
using all the usual tools as well as the
additional fine-tuning options included in the
Masks panel.

The advantage of the Masks panel is that it
shows the effects of the adjustments you
make to your selection in real time. To
temporarily hide the mask, simply click the
eye icon next to it in the Masks panel or click
on the layer mask icon in the Layers panel
with the Shift key pressed.

In addition to the Density, Feather and
Color Range options, the Masks panel also
offers the Refine Mask dialog, which contains
exactly the same options as the Refine Edge
dialog described earlier. These include:
– Smooth: smooths obviously pixelated edges
–  Feather: creates a transparent transition

with the selected pixel width
– Contrast: sharpens edges that are too soft 
–  Shift Edge: globally increases or decreases

the size of the selection
The View Mode selector is used to select your
preferred display background.

The additional Smart Radius function was
introduced with Photoshop CS5. This option
automatically detects the optimum selection
edge radius but also allows you to adjust the
results using the Refine Radius tool. This
creates a broader zone along the original
selection edge that is subject to dedicated
reinterpolation – a great solution for the
‘frayed’ edges that often occur when you are
selecting fur or individual hairs. In many cases,
it makes sense to give a selection a custom
radius using the Brush rather than just
applying a standard radius to the entire
selection. As when making a selection, you
can adjust the radius setting using the Alt key.

Colored fringing (i.e., the remains of the
original background) is a common artifact that
remains after making complex selections, and
the Decontaminate Colors option in the
Output section of the dialog offers a solution.

Activating this option reinterpolates the edge
pixels of a selection, removing any extraneous
colors while simultaneously creating a new
layer mask in order to prevent image data loss.
This is great in theory, but is not perfect in
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Paths can be scaled steplessly without
any loss of quality. This is one of the
advantages of working with vectors
rather than pixels. Vector masks fulfill
the same function as layer masks and
are also losslessly scalable.

Quick Tip

c’t Digital Photography 8 (2012)

The Masks panel gives you direct access
to all of the most important selection
editing options

Defining paths as
(external) clipping
paths is no longer
necessary for most
modern layout
programs

The Refine Edge and Refine Mask dialogs
both contain a wide range of viewing options



practice, often producing results that are too
monochromatic and not particularly realistic.

Reducing the Density setting in the Masks
panel can brighten black pixels by making the
masked portions of the background more
transparent. The great thing about the
Density slider is that you can adjust it up or
down at any time. The same is true of the

Feather setting in the Masks panel, making it
superior to the version included in the Refine
Edge/Refine Mask dialog.

The final option in the Masks panel is the
Color Range dialog, which allows you to
modify the colors in your selection. The tool
works in the same way as the corresponding
one in the Select menu, and uses an

eyedropper to select the colors that you want
to include in a new layer mask.

The new Localized Color Clusters option
determines the zone surrounding the original
selection in which color selection is to take
place. This prevents unwanted colors from
other parts of the image from accidentally
becoming part of the selection.
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This photo provides
a perfect demonstration
of Photoshop’s automatic
edge detection
functionality.
Critical areas that are not
detected automatically can
be selected manually using
the Refine Radius tool.

The Decontaminate Colors
option is a small slider that
sometimes has a big effect
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For subjects with monochromatic or uniform
backgrounds, it is often possible to make
perfectly acceptable selections using the
Magic Wand tool. However, using the Color
Range dialog can be simpler and more
effective. The Color range command in the
Select menu enables you to select colors
using an eyedropper either in the image
itself or in the mask preview. Once again, you
can add selections using the Shift key or
subtract them using the Alt key. The
Fuzziness setting determines the tolerance
of your color choice. The new Localized Color
Clusters option helps you to build a more
accurate mask if you are selecting multiple
color ranges in a single image, and the
Range slider controls the radius of the
selection thus made.

Objects with Clean Edges

Objects with clear-cut edges (even on
non-uniform backgrounds) can usually be
effectively selected using the Quick Selection
tool. But don’t forget to fine-tune your tools: a
small tip reduces the selection radius and you
can remove erroneously selected areas by
pressing the Alt key during selection. You can,

of course, make this type of selection in Quick
Mask mode too, although you will often find
that the original quick selection only requires
a little smoothing using the Smooth tool in
the Refine Edge dialog. 

Simple shapes can also be effectively
selected using the Pen tool – provided of
course that you are comfortable with using
paths. This approach means you can track the
edge of an object precisely as you work and
don’t have to correct any mistakes that an
automatic tool might make. Not only that, but
you can easily edit paths using the (cursor)
selection tools, should you need to.

Blending Modes

Some apparently complex selections are
easier to perform than you might think.
Multiply blending mode makes it easy to
transplant dark structures such as tree
branches at sunset can be easily transplanted
onto a new background using , while bright
details can equally effectively be given a new
background using Screen blending mode.
This approach is often used for rescuing
valuable edge pixels in selections that 
involve hair or fur. 

Transparent and 
Semi-transparent Objects

Semi-transparent objects such as glass or
gauze can be quite simple or really
challenging to select. One approach is to
make a luminance selection in the Channels
panel: click on any channel with the Ctrl/Cmd
key pressed to create a selection that
encompasses the luminance data stored in
that channel. This technique produces very
finely graded selections, and no selection tool
can differentiate so well between different
levels of transparency. Again, this type of
selection can be fine-tuned using the Refine
Mask dialog, where the Shift Edge slider can
be used to increase or reduce overall
transparency. Use the Contrast slider to
sharpen soft transitions.

Here too, Photoshop offers us an
alternative approach. Double clicking the
layer you wish to select from opens the
Blending Options dialog, where you can use
the ‘Blend if’ sliders to seamlessly show or
hide light or dark image areas. It is
particularly important to use the Alt key to
keep your transitions soft when using this
technique. The advantage of this particular
approach is that you can alter your selection
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You can make Color Range selections either directly in
an image or in the preview window. The same options
are also available in the Refine Mask dialog.

The luminance selection is shown on the left and the
corresponding ‘normal’ selection on the right
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at any time, although it won’t be visible in
the Layers panel.

Fur and Fraying

The Refine Mask/Refine Edge dialog is a real
boon when it comes to selecting fur, hair or
any subject that shows signs of fraying. It is
important to ensure that your rough selection
doesn’t contain any background pixels – you
can use the Refine Radius tool’s edge
detection functionality to work on the edges
later. Select a View mode that gives a good
overview of the active selection and
non-selected details at the edges of your
object. You can then use the Refine Radius
tool to mark areas where you want Photoshop
to select edge pixels – the rest of the selection
will be added automatically. This process
works very well for evenly textured subjects
such as animal fur and, if things don’t quite
work out, it is usually sufficient to redefine the
selection zone slightly using the Smart Radius
slider. The exact location of the current radius
can be displayed by selecting the Show Radius
view mode option.

Selecting Hair

Human hair still presents the ultimate
selection challenge, and there is no single
technique that is guaranteed to do the trick.
The usual starting point is a mask based on
the channel with the highest contrast plus

a few tonal corrections. An appropriate
channel often has to be created using the
Calculations dialog, and it is common for a
mask to be constructed of various separate
components that use different selection
techniques for individual image areas.
Combining channels is just as simple as
combining selections.  

Various techniques are required to
complete the details of a hair mask. One
option is to use the automatic edge detection

functions in the Refine Mask dialog, but
applying Dodge and Burn effects manually is
generally more accurate when it comes to
slight differences in masking for single
strands of hair. The Blur tool is also great for
softening details that have turned out too
sharp during a first run-through.

The quality of a selection really only
becomes evident when the object is mounted
onto a new background – and that is when
the work really starts!
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These eyeglasses are not selected but instead blended using Multiply blending mode. 
A couple of details in the frames were added using a mask.

Photoshop’s automatic edge detection functionality made selecting these fur details a quick and easy task



The moment of truth comes when you insert
your selection into a new background. This is
when all those pesky little background pixels
that you weren’t able to see against a
transparent working background show up .

Bright colors in the remaining pixels are
difficult to remove, but even neutral-colored
background pixels show up strongly if you are
switching from a bright to a dark background
or vice versa. Such edge artifacts are relatively

simple to remove, although manual
corrections using layers and various tools
usually produce better results than the
automatic tools built into the Refine Edge
dialog. 

Decontaminate Colors

The new Decontaminate Colors option in the
Refine Edge dialog offers an antidote for color
fringes at the edges of selections. The tool
replaces fringe pixels with the color of nearby
fully selected pixels and, because the process
alters the image data, stores the result in a
layer copy with a new layer mask. The theory
is great, but the practice often produces
blocky results and sometimes even fails
completely.

The alternative is to recolor the fringe
pixels manually. This approach gives you
more flexibility and allows you to work
more sensitively than a preset automatic
tool. Use the Color Replacement tool and
place its crosshairs in the middle of the
colored area you want to correct. The
Amount value ensures that only similar-
colored pixels get recolored (much like the
Color Range Fuzziness setting). If you
alternate between selecting unwanted
colors and selecting surrounding
replacement colors (using the Alt key), you
can produce really smooth, seamless edges.
Surrounding pixels with the same color as
your new background are also great for
recoloring fringe pixels.

Using Layers

If fringe pixels are evenly distributed along
the edge of a selection, you can correct
them on a separate layer. To do this,
duplicate the layer that contains your layer
mask and use the Shift Edge option in the
Refine Edge dialog to reduce the size of the
duplicate selection by one or two pixels. You
can then use Multiply blending mode to
blend the pixels in the lower layer that
extend beyond the new edge to make
them darker than the background itself.
You can apply the same technique to
bright fringes using Screen blending
mode to blend unwanted pixels into a
bright background (see the Correcting
Fringing section on page 68).

56 c’t Digital Photography 8 (2012)

Precision Selections | Montage

The Dodge, Burn and Blur tools are great for fine-tuning hair masks

Use low exposure values when applying
Dodge and Burn effects. This way, you
can build an effect gradually rather than
running the risk of applying too much at
the first attempt.

Quick Tip

The Perils of Photomontage



Selective Extension and
Subtraction 

It isn’t possible to edit a complex hair mask
using conventional brush tools, as these
would simply produce strange-looking stripes
and brush-strokes. Even using a custom brush
tip, you will need to apply a lot of manual
corrections to produce a realistic-looking
result.

If you want to adjust only part of your
mask, remove a couple of particularly
stubborn fringe pixels or emphasize a
particular strand of hair, the Dodge and Burn
tools are probably your best choice.

Even if their functionality is comparatively
prehistoric when it comes to retouching
normal image pixels, these tools can be
extremely useful for tweaking the edges of
selection masks. Limiting the effect of these
tools using the Highlights or Shadows
options enables you to brighten or darken
the appropriate pixels without altering the
corresponding white or black parts of the
mask, thus enlarging or reducing the
overall  selection.

Partial Blur

Sometimes, individual strands of hair are
captured out of focus or parts of a mask end
up looking unnaturally sharp. In order to get
rid of fringe pixels in these areas, you have to
blur the mask. Take care to use low Strength
settings when using the Blur tool and never
use Normal mode, as this produces uniform
gray pixels in the mask, which then allow the
background to show through. If you use
Darken mode, the mask will be blurred and
the selection will become smaller.

c’t Digital Photography 8 (2012)

1. The rough selection. This worked well,
but the edges require attention. 
2. The Decontaminate Colors tool has visibly
improved the situation 
3. Placing fringe pixels on their own layer
makes it possible to blend them with the
background without having to recolor them

1

2

3
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Up Close and Personal with Pen Tools and Paths

Working with the Pen tool: The Pen tool is simple to
use but takes some getting used to. If you are
experienced in using vector-based drawing programs
like Illustrator or InDesign, you will find it a lot easier
than if you are just starting out. A simple click creates
an anchor point, while dragging the cursor with the
mouse button pressed produces a curve whose
characteristics (i.e., steepness and length) are defined
by an accompanying tangent. 

Step1

Adjusting a path: The fewer anchor points you
create the better. Curves with too many anchor
points are often bumpier than they need to be. Don’t
be put off by small imperfections in your path – you
can correct these at any time while you are drawing
or later when your path is finished. Select the Direct
Selection tool either directly in the Tools panel or by
pressing the  Ctrl/Cmd key, which also automatically
switches you back to the previous selection tool that
you used. The Direct Selection tool can be used to
select and shift individual anchor points or direction
points. 

Step 2

Converting Points: The Convert Point tool changes
the nature of anchor points, and allows you to turn
corner points into smooth points and vice versa.
Clicking on a curve point with this tool collapses its
direction points or converts anchor points into curve
points by clicking and dragging to form a new curve. 

Pressing the Alt key while you are using the Pen tool
automatically switches to the Convert Point tool. 

Step 3

Curves with multiple segments: Clicking on a
direction point with the Convert Point tool separates
the curve’s tangent into two parts and defines two
new, separate curves on either side of the curve point.
This is fine if you do it deliberately, but it often
happens unintentionally. Curve points represent

connections and transitions that are used regularly –
for example, to add a curve to the end of a straight
segment or to select organic shapes that don’t
precisely match the shape of the system’s
automatically generated splines.

Step 4

Using paths is not an especially modern way to make selections and is a technique that only
really works for simple shapes with obvious edges. It is nevertheless useful to know how the Pen
and Direct Selection tools work, and you can often use them to produce more accurate results
more quickly than you can using contemporary automatic pixel-based tools.
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Completing a path: The Pen tool does many things
automatically – for example, if you have corrected a
path and you want to carry on from your previous
end point, all you have to do is click on it. The icon
with the slanted tangent symbolizes the connection
with the existing path.

If you move the cursor to the start point of a path, the
circular icon symbol indicates that clicking there will
close/complete the path.

If you move the cursor over the middle of an existing
path, a ‘plus’ symbol indicates that you can add
anchor points to it. A ‘minus’ symbol indicates that
you can delete an existing anchor point by clicking it.
There are separate commands for performing both of
these tasks, but the Pen tool’s built-in automatic
functionality makes them redundant.

Step 5

Path area options: If you want to add or subtract
paths or parts of paths, you can use the path area
option buttons in the tool’s options bar. The options
include adding a new area to an overlapping path
area, removing a new area from an overlapping path
area, restricting a path to the intersection of a new
area and an existing area, and excluding the overlap
area in a consolidated path. To create an opening in
your path, click the second option button before
creating a new inner path.

Step 6

Saving a path: The path you are working on is
displayed as a temporary work path in the Paths
panel. To save a path as a permanent part of a file,
double click the path thumbnail, enter a name for it
and click OK.

Step 7

Convert a path to a selection: A finished path can
be used as a selection path in layout programs like
InDesign, or as a preset selection for making local
corrections. A path can also be converted into a
selection and later into a layer mask. There are many
ways to do this, but the quickest involve either
clicking on the path thumbnail in the Paths panel
with the Ctrl/Cmd key pressed, or selecting the
thumbnail and then clicking the ‘Load path as a
selection’ button at the bottom of the panel.

Step 8

Quick Tip

When using the Pen tool, use keyboard shortcuts to switch
to the other correction tools when necessary. The Ctrl/Cmd
key activates the Direct Selection tool and the Alt key
activates the Convert Point tool.
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Chroma Key – Selecting Colored Backgrounds

Select a color range: Navigate to the Select > Color Range
command. Click on the background color and check the
white areas in the image in the main program window to
see which parts of the image the current settings have
selected. If the selection isn’t clear enough, select a different
option in the Selection Preview pop-up menu.

Step1

Extend your selection: Press the Shift key and click multiple times
in the preview image to add other colors to your selection. This
process works in the Color Range preview window and in the main
program window. You can also switch temporarily to the view in
the main program window by pressing the Ctrl/Cmd key. At this
stage, you should keep the fuzziness value low to prevent too
much scattering.

Step 2

Fuzziness and Localized Color Clusters: Use the Fuzziness slider to extend
your selection to include similar colors, but take care not to extend it too far by
selecting too high a value. Activating the Localized Color Clusters option
activates the Range slider that you can then use to limit the size of the area in
which you can make a selection.

Step 3

Remove unwanted color areas: While fine-tuning a selection, you will
often end up selecting too many areas that you don’t actually want to
include. To remove them, simply press the Alt key and use the eyedropper
the same way as before (Alt+eyedropper is also known as the ‘negative
eyedropper’). Once you have removed any unwanted areas, reduce the
Fuzziness value a little and continue with your selection. Repeatedly
clicking the sky and Alt-clicking the foreground combined with slight
adjustments in Fuzziness and Range will soon produce the results you are
looking for.

Step4

Blue screen and green screen (or ‘chroma key’)  compositing techniques are widely used in the
worlds of film and photography and are based on the fact that it is relatively simple to make
selections using color values combined with appropriate fuzziness values. There are dedicated
chroma key plug-ins available, which we will be looking at in future issues, but for now, we will
describe how to produce chroma key effects using the options offered by the Photoshop Color
Range dialog.
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Fine-tune your mask: Because we are selecting from
the background rather than the foreground, select
the Invert option before clicking OK to confirm your
selection. Now switch to Quick Mask mode using the
Q key and correct any slight inaccuracies. Double
click the mask icon in the Tools panel or the Quick
Mask channel to open the Quick Mask Options
dialog. This is where you can alter the opacity and
color settings to make individual details easier to see.
You can now use the Brush tool with black or white
set as the foreground color to expand or curtail your
mask. Pressing the Q key once again switches back to
the normal selection view. 

Step5

Convert your selection into a layer mask: Once you have finished refining the
edges of your selection you can select the Layer Mask option in the Output To pop-
up menu. This creates a brand-new layer mask with your selection as its contents,
which you can then fine-tune using the Brush tool with black and white foreground
colors the same way as you can in Quick Mask mode.

Step 7

Refine Edge: Now all we have to do is refine the edge of the
mask edge. If the ‘Refine Edge’ button in the control panel is
grayed out,  switch to one of the selection tools or select the
Refine Edge command from the Select menu. Select an
appropriate view mode, as we did previously. Use the
Smooth slider to smooth the edges and the Radius setting to
increase the breadth of the edge region and include any lost
details. The Contrast slider can be used to sharpen edges
that have become too soft and the Shift Edge slider moves
the position of the edge of the selection in and out to help
you select just the right contents.

Step 6
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Semi-transparent Selections

Make a rough selection: Start by using the Quick
Selection tool – fine-tuning comes later. Use the tool
to roughly select the bride and her veil, then reduce
the size of the tool and use the Alt key to subtract any
unwanted details. Add a new mask from this
selection and switch to the Masks panel and click on
the mask icon. You have now made your rough
selection.

Step1

Make a new fine-tuning layer: Duplicate this layer
in the Layers panel and load the selection by clicking
the mask icon with the Ctrl/Cmd key pressed. Press
the Alt key so that a ‘minus’ sign appears in the
center of the Quick Selection tool and select all areas
that you want to appear transparent in the finished
image. Switch to Quick Mask mode using the Q key
or by clicking the mask icon in the Tools panel and
continue to fine-tune your mask. Use the Brush tool
with a hardness value of approximately 75% and
white as the foreground color to extend the edge of
the selection edge between the bride’s face and
body. 

Step2

Using the layer mask:
Quit Quick Mask mode, invert
your selection using the
Shift+Ctrl/Cmd+I keystroke
and activate the layer mask in
the upper layer. Open the Fill
dialog (in the Edit menu or
using Shift+F5). Fill the mask’s
selection with 100% black. The
upper layer’s layer mask will
now show only the core
selection that we want to
show completely.

Step3

Transparent subjects are tricky to select, especially if they are located in front of
non-uniform or brightly colored backgrounds. But never fear, there are ways of
working around this kind of challenge too. We discussed the luminance
selection approach on page 54. This section uses a veil shot outdoors to
demonstrate techniques for partially selecting image areas using layer masks
and Layer Style options.
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Hide the background: Now switch to the lower layer
where we are selecting just the veil. Double click the
layer (not its name or icon!) to open the Layer Style
dialog. Use the ‘Blend if’ options to hide the
background behind the veil. To do this, switch to the
Green channel using the pop-up menu. The upper scale
represents all green tones on the current layer (from
dark on the left to bright on the right). Move the black
slider as far as possible to the right to completely hide
all of the green background pixels. This is not yet an
elegant solution to our problem, but is a good first step.

Step 4

Create soft transitions: Press the Alt key and move the
left-hand half of the slider back down the scale. This
creates a soft transition to the hidden green tones. Use
both halves of the slider to adjust the hardness and scope
of the color selection. This transition is independent of
the changes you make to the edges of your layer mask.

Step 5

Fine-tuning: Create a new layer beneath the other
two and fill it with an appropriate background color.
This helps to judge whether the selection has
worked – you can still edit the transitions by double
clicking the veil layer. If the transitions between the
layers are too hard, you can soften them in the layer
mask using a soft brush. Obstinate colored pixels can

be neutralized using the Color Replacement tool.
Select a neutral foreground color or pick it from your
new image background and simply ‘paint’ over any
obvious fringes.

Step 6
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Shaggy Selections

Create a core selection: Even for a subject as
complex as this, you can start by making a rough
selection using the Quick Selection tool. Drag the
tool around the entire subject, but take care not to
include any background pixels at this stage. As
before, you can deselect any excess using the Alt key.
You can fine-tune your selection either by reducing
the size of the selection tool or by switching to Quick
Mask mode.

Step1

Check your results: Click the ‘Refine Edge’ button in
the control panel or navigate to the Select > Refine
Edge command. Now select an appropriate view
mode. Pressing the F key cycles through the various
View Mode options. You can also press the L key to
switch directly to the On Layers view, which displays
the selection preview on a transparent background.

Step 2

Select a Radius setting: Start your fine-tuning by
increasing the Radius setting. This automatically
includes more details in the selection. Checking the
Show Radius option displays a black mask that shows
only the edge of the selection. The breadth of this
line represents the Radius value you have selected
and is the area within which the program will search
for high-contrast edges. The edge of the selection
will then be moved correspondingly to fit the new
radius value.

Step 3

Before the introduction of the Radius slider in the Refine Edge dialog, selecting fur and
other non-uniform edges was just as difficult as selecting human hair. The slider
transforms the edge of a selection into a kind of perimeter zone within which the program
automatically detects the edges with the strongest contrast. The method is the same as
the one used by the Extract filter that disappeared from the Photoshop repertoire with the
introduction of CS4. The version built into the Refine Edge dialog, with its View modes and
Shift Edge settings, is far superior to its predecessor.
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Activate Smart Radius: Deactivate the Show Radius
option – this helps you to better judge the preview
image. You may have noticed that some of the
details in the selection are a little soft. If this is the
case, activate the Smart Radius option. This uses a
different algorithm and is capable of selecting edges
with different degrees of contrast within a single
radius. You will see that this improves detail
definition within your selection. Smart Radius doesn’t
always produce better results than the conventional
Radius slider, but you can use the various View mode
options to help you judge which works best for your
particular image. 

Step 4

Manual Radius adjustments: You can also use the
Refine Radius tool to selectively extend or reduce
the radius of your selection so that it exactly
matches the size of the details it encompasses. In
this case, we simply ‘paint’ over the tips of the fur to
adapt the radius zone to include details that don’t
yet lie within it. You can use the same technique to
exclude details that belong to the core selection
from the radius zone. Once again, pressing the Alt
key switches the tool to subtract mode and allows
you to erase any unwanted refinements you have
made. Although this action appears to delete pixels,
it actually only adjusts the Smart Radius.

Step 5

Shift Edge: Now use the Shift Edge slider to adjust the borders of your
selection. Shift it inward with negative values or outward with positive
ones. Shifting these borders inward can help remove unwanted
background colors from selection edges. Take care not to move the slider
too far, otherwise you might end up with a hard, unnatural-looking edge.

Step 6

Decontaminate Colors: This tool recolors background pixels instead of
deleting them. Instead of adjusting the mask it analyzes the colors in the
fringe pixels of your selection and recolors them using the color it detects in
neighboring pixels. This works very well for the polar fox in our sample
image. Moving the slider to the right increases the size of the area that the
tool affects. 

Because it alters the original
image data, applying the tool
automatically creates a new
layer for the results. Select the
New Layer with Layer Mask
output option from the pop-
up menu to preserve your
original layer.

Step 7
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Selecting with Channels

The Channels panel: The red, green and blue
channels are displayed as grayscale thumbnails, and
their corresponding layers can be used to construct
an effective selection mask. Click through the
individual channels to see which makes the best
base channel. The red channel is not suitable for
this example because the model’s hair and the
background share too many tones. However, the
green channel shows good contrast between
subject and background and serves as the basis 
for our selection mask.

Step1

Hair-based selections are some of the most
difficult to master, and none of the techniques 
we have introduced so far work for this particular
example. Conventional tools simply can’t cope,
color-based selections can’t differentiate
sufficiently between subject and background, 
and even Edge Detection – with its Smart Radius
and Refine Radius tools – cannot adequately
select the soft curls in our model’s hair. The
solution here is to resort to a combination of
channels and conventional selection techniques.

Copy the base channel: Duplicate the base
channel via the Duplicate Channel command
in the context menu or the panel menu. 

Step 2

Save an additional channel: An additional
channel is required later to deal with the model’s
shoulders separately from her hair. Select the
shoulder area using the Magnetic Lasso or Quick
Selection tools. Smooth the edges of this
selection using the Smooth slider in the Refine
Edge dialog.
Depending on your
particular subject, it
may be necessary to
feather the edge
slightly too. Navigate
to the Select > Save
Selection command
and save your new
selection as a new
channel. This is now
visible as a new alpha
channel in the
Channels panel.

Step 3
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Building the selection channel: Now concentrate
on separating the hair from the background. Start
by correcting contrast in the copied green channel.
Levels and Curves are both useful for this kind of
adjustment, but Levels is easier to handle when
editing critical transitions. Navigate to Image >
Adjustments > Levels and drag the black and white
point sliders toward the center of the scale. This
reduces the number of gray tones and makes the
edge of the selection clearer. However, be sure to
retain a midtone zone that is 40-70 tones wide to
help you create soft transitions in the extreme hair
ends.

Step 4

Brush-based corrections: The previous step
concentrated on the selection edge at the hair ends.
We now have to allocate the remaining foreground
and background areas using the Brush tool. Set
hardness to 100% and cover the remaining parts of
the face in black. Here, you don’t have to account
for the zones that you have already saved in the
new alpha channel.

Step 5

Calculate channels: Contrast corrections based on
channels are often too intense. In such cases, you
can perform a channel calculation, using blending
modes to underscore the effect of a particular
channel or combine the effects of multiple channels.
Start with the edited green channel copy and
navigate to Image > Calculations. Select the
channels that you want to combine as Source 1 and
Source 2 (in our case, these are the same) and select
the Overlay Blending option. This underscores the
effect of both bright and dark images areas.

Step 6

Merge channels: Invert the newly created alpha
channel (Ctrl/Cmd+I) and combine it with your
saved selection by clicking on the channel while
holding down the Ctrl/Cmd key. Add the saved
‘Shoulders’ selection by pressing Shift+Ctrl/Cmd
and clicking on the channel. At this point, the
individual channels have served their purpose.
Select the composite RGB channel to show the
entire image and transform the complete selection
into a layer mask by clicking the ‘Add a pixel mask’
button in the Masks panel.

Step 7
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Correcting Edges and Fringing Effects

Create a new background: Create a new layer and
fill it (Shift+Del). Be sure to deactivate the Preserve
Transparency option for the fill and select a color
from the pop-up menu that contrasts with the old
background color. This makes any remaining
background pixels in the selection easily visible.

Step1

This section fleshes out the example we introduced on the previous pages. We can only
really see how good our selection is when we mount it on its new background. If color and
brightness in the new background vary, fringing/halo effects are unavoidable. The
following sections explain techniques that help to reduce fringing effects while retaining
maximum detail in the individual hairs.

Correct any remaining glitches: There are still some
areas where the Levels adjustment failed to turn
background or fringe pixels black. To correct these,
click the layer mask and use the Burn tool to darken
the mask in the appropriate places. Use the Shadows
setting and work carefully using a maximum
Exposure value of 15%. The tool won’t affect the
bright areas in the mask.

Step 2

Fringe pixels and core selection: You can, of course,
correct all fringes using the Burn tool, although
simply reducing the size of the selection’s edge is not
the most elegant solution. A more effective approach
is to use the Layers panel to create two separate
masks: one that makes the fringing in the details of
the hair ends invisible and one for the main core of
the selection. To do this, duplicate the selection layer
and rename the two mask layers ‘Core Selection’ and
‘Fringe Pixels’. 

Step 3
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Select a blending mode: Switch the blending
mode of the lower of the two mask layers to
Multiply. This makes sure that the pixels on this layer
darken the pixels in the layer beneath (conversely,
you can use Screen blending mode to correct dark
fringe pixels that stand out against bright
backgrounds). The next step is to make the core
selection on the upper layer slightly smaller so that
its bright fringes disappear and allow the dark fringe
pixels that we have just created to show through.

Step 4

Scale down the core selection: Activate the upper
layer mask and click the ‘Mask Edge’ button. Use the
L key to switch to the On Layers view mode in the
Refine Mask dialog. This helps you to judge the
interplay between the various layers. Use the Shift
Edge slider to reduce the size of the selection. The
bright edges will now disappear and the dark fringe
pixels on the lower layer will show through.

Step 5

Feather the transitions: If the transitions between
the two layers appear too abrupt, you can soften the
upper mask a little. But take care: if you introduce
too much blur, the upper mask begins to expand
beyond the edges of the lower one. Adjust the
Feather setting either directly in the Refine Mask
dialog or using the Feather slider in the Masks
panel. The latter has the advantage of being
adjustable at any time.

Step 6

Fine-tune the hair ends: Some of the ‘sharper’ hair
ends still look a little unnatural and the mass of our
model’s hair still has to become a little more blurred
to look realistic. Use the Blur tool to partially blur the
mask. Be sure to use Darken mode if you want to
avoid spoiling all the hard work you have already
put into your mask. This way, the Blur tool only
produces darker pixels that reduce the size of the
mask. Use the tool on the lower Fringe Pixels layer,
but have the image layer showing the whole time so
that you can see the effect of your adjustments. Use
a low Strength value to keep the effect subtle.

Step 7

c





Petra Vogt

Time-lapse Photography

Time-lapse techniques allow you to make amazing short videos from
sequences of individual images. We show you how to get started,
which subjects are suitable and which software tools perform best at
creating and optimizing time-lapse scenes. You’ll find sample videos
and source images on this issue’s free DVD. 
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Cast your eye over a lump of dough 
or flowers in a vase, and they appear

motionless, unexciting. But time-lapse
photography can bring them to life. The
results are impressive, but the secret behind
their creation is comparatively simple: while a
conventionall film continuously shoots many
images per second to capure the subject in a
way that appears fluid to the human eye, the
movement in a time-lapse sequence is based
on a sequence of a few images shot over a
longer period of time. When the video is
played back later at normal speed, time seems
to have been compressed – hence the name
‘time lapse’, which highlights the fact that
there are gaps between the images.

You don’t need video functionality in your
camera because you actually compile the
images into a sort of digital flip-book later,
using a computer. The advantage over
working with video is that you still have access
to all the creative options of modern stills

photography, from user-controllable depth of
field to the use of RAW format for more
flexible image processing.

Interval Timers and Basic
Equipment
While some other photo projects require a lot
of time and complex equipment, you can
shoot time-lapse films using very few
accessories and you get to see the results very
quickly. In many cases, all that is needed is a
digital camera, and even a webcam or a
mobile phone camera will do the trick. Some
cameras have a dedicated interval timer
function. If yours doesn’t, you will have to
release the shutter manually at regular
intervals or use a remote shutter release with
built-in interval timer functionality.

You can buy a remote shutter release from
major manufacturers like Canon (TC-80N3)  or
from third-party accessory makers. Asian
manufacturers make models for Canon, Nikon
and Sony that cost as little as US$20, and for
Olympus, Panasonic and Pentax from about
US$60. Most of these models are very similar
in terms of the range of functions they offer,
but check before you make a purchase how
many shots you can set and the range of timer
intervals (which should start at 1 second or
more). It is also an advantage if the maximum
number of shots can be set to infinity.

If you don’t want to purchase extra gear,
there is a range of software-based solutions
available that do a similar job. Although
connecting the camera to a computer restricts
mobility, the ability to make camera settings
on a large monitor makes things much easier.
Canon, for example, has been including a CD
of its EOS Utility program with DSLRs for quite
some time, and there are many iPhone and
iPad remote control interval timer apps
available. DSLR Camera Remote from onOne
Software does the same thing for Nikon and
Canon cameras, although the camera still has
to be connected to a computer via wireless
Internet or USB. There are also apps around

that use the built-in camera to turn your
smartphone into a dedicated time-lapse
photo camera. Owners of Canon compact
cameras have the option of installing the
CHDK firmware extension using an SD card.
CHDK (chdk.wikia.com) is an open source
project with no affiliations to Canon that
extends the functionality of a wide range of
Canon compacts to include – among many
other things – an interval timer.

In addition to specialized control systems
you will also need a stable base for your
camera. A tripod is best, but if you have to
improvise, a wall or table will do. Unless you
want to include pans in your film, it is
important that the camera doesn’t move at
any time during the entire process if you want
to get good results. Pans are, however, 
an advanced technique and are difficult 
to shoot smoothly without the use of 
expensive additional equipment. Inventive
photographers like Hamburg-based  
time-lapse enthusiast Gunther Wegner have
come up with innumerable ideas including a
converted egg timer that serves as a rotating
support for small cameras. If that sounds like
too much work to you, you might find
software-based pans more appealing (more
on that later).

The Right Subject

Once you have assembled the basic
equipment, you’ll be on the lookout for a
suitable subject for your first time-lapse film.
Any process that takes place over an extended
period of time and in which no particular
moment in the process is crucial will probably
be suitable (see http://vimeo.com/16917950,
for example). Good first choices include the
setting sun or a growing plant.

As our examples on this issue’s free DVD
show, everyday kitchen tasks can make very
interesting subjects. Sequences of photos of
ordinary things like dough rising or a person
cutting zucchini suddenly become quirky
animations when seen in time-lapse mode.

Time-lapse Photography | Basic Equipment

Some cameras use a remote shutter release
to shoot time-lapse sequences automatically 
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Time-lapse films can be quite exciting,
because they often allow us to see structures
and processes that are invisible in real time.
Our video Berlin Alexanderplatz is a good
example. We photographed the square from
above for a while but it was not until the
images were played back at high speed that
the patterns formed by large numbers of

people moving about in a public space
became apparent.

With the subject settled, you’ll want to
make sure that you find the best possible
conditions for capturing your images. For
landscapes, for example, you will get the best
results on fine days with a few clouds, as the
sharp contrasts and outlines will emphasize

the time-lapse effect later on. A graduated
gray filter will provide the necessary balance
between sky and landscape, and a wide-angle
lens will usually make the shot look more
dramatic. With time-lapse subjects, it is
generally worthwhile including a combination
of moving and static elements in the frame.
Try positioning a building or place of interest

Time-lapse Photography | Subjects

Situations with strong sunlight and heavy cloud are susceptible to flicker when shot using
time-lapse techniques. Tools such as LRTimelapse are great for removing flicker effects.
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in front of moving elements like clouds or
pedestrians. Be careful, though, not to have
too many moving elements, as they compete
for the viewer’s attention and your video will
appear disjointed because of the lack of a
central element.

Camera Settings

Since a time-lapse project is essentially about
making a video, the individual photos have to
be compatible with your chosen video format
and your output device. This means that you
need to shoot in landscape format with an
appropriate TV-style aspect ratio. If you are
aiming to make a 16:9 film, you’ll need to check
whether your camera can capture images at
the appropriate resolution and whether the
software recognizes the format you have
selected. If necessary, you can crop your
images to fit later on, although this can entail
an awful lot of work. Once you have picked an
image format, make sure that you have enough
space on your memory card, fully charge the
camera’s battery and switch off the monitor
preview.

It is a good idea to make as many camera
settings as possible manually. Automatic
exposure systems constantly fine-tune the
camera’s settings and are likely to produce a
flickery final clip. The best way to prevent
flicker is to set the exposure time, aperture,
white balance and ISO manually. If the
lighting is likely to change dramatically during
the shoot (at sunset, for instance), using
aperture priority auto mode at least ensures
that depth of field remains constant. Switch
off autofocus once have made your initial test
shots, otherwise you run the risk of the
camera changing or even completely losing
focus during the sequence.

JPEG is a more suitable file format for
time-lapse shots than RAW, as it will be
JPEGs that are required later to make the
film and it is not necessary for any single
shot to be top quality. Perfectionists 
who prefer more flexible post-processing

options can, of course, shoot RAW and
convert the files later, but if you do, make
sure that your camera can save large
amounts of image data quickly enough to
be ready for the next exposure in the
sequence. If the camera is still writing data
to the memory card when the next shot is

due, you will end up with gaps in your
sequence.

When shooting JPEG, the camera can
usually be set to a very small format,
depending on your planned film or crop size.
Full HD has a resolution of 1920x1080 pixels.,
which is smaller than the ‘Small’ setting in

Time-lapse Photography | Camera Settings
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functionality. The

options are similar
to those available
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2.

First, set the start
time – either to

‘Now’ or a time of
your choice



most Nikon DSLRs, which has a resolution of
2464x1632 pixels. The smaller the image size,
the greater the number of images that fit onto
the memory card. Depending on the length of
your planned time-lapse film, this can be an
important criterion. For example, if you take
one photo every five seconds for 30 minutes,

you will suddenly have 360 image files filling
up your memory card.

Selecting the Right Interval

The right exposure frequency depends on the
situation. A good rule of thumb says that

frequency should increase with the speed at
which the subject is moving. For landscape
shots that include moving clouds, an 
interval of between 1 and 10 seconds usually
produces good results, while passing 
cars require a shorter interval. For growing
plants, or other types of long-term action 
(such  as the building project 
shown at www.ndr.de/fernsehen/sendungen/
hamburg_journal/zeitrafferfilm100.html),
intervals of minutes, days, or even weeks may
be more appropriate. If in doubt, it is better to
have too many images to choose from than too
few, as it is easier to leave some out than to
have to fill any gaps later on. If you find yourself
getting impatient and want to get an idea of
what your film is going to look like, most
cameras have a ‘Slide Show’ playback mode for
viewing your images in running sequence.

The main factor that influences the total
number of exposures is the final length of the
film. The number of exposures divided by the
frames per second (fps) shooting rate will give
you the total length of your film in seconds. By
way of comparison, cinema films are usually
shot at 24 fps, while the PAL and NTSC
television standards use 50 fps (or 30 half
frames per second in interlaced mode). If 
you have made 360 exposures over a 
period of half an hour, this will be enough to
make a video that lasts 15 seconds using a
cinema-style frame rate.

If it hasn’t already happened, this will be
the point at which stills photographers
realize that they will have to adjust to
making images on a completely new scale
when they move into time-lapse work, and
why factors like memory card space and
shooting formats take on a new significance.
Since increasing the number of images also
increases the amount of time and work
involved, we recommend that you stick to
short sequences for your first attempts to
get a feel for the medium. Taken at 5-second
intervals, 100 source images will take 8
minutes to shoot, which is a good place to
start.

Time-lapse Photography | Camera Settings

3.

4.

Next, enter your
desired interval.

1, 5 and 10
seconds are some

of the most
frequently used

settings.

Then set the
number of shots

(like the 250
shown here).

Nikon cameras
are capable of

taking multiple
shots for each

interval.
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Video Creation Software

You’ve taken all the photos and transferred
them to a computer, so now you have to turn
them into a time-lapse video. The available
software ranges from the utility that 
came free with your operating system (such
as Windows Movie Maker), to dedicated
freeware and shareware and commercial
plug-ins for expensive pro-grade programs
like Photoshop and Premiere Pro. Any of these
will provide the necessary basic functionality
– i.e., importing a series of images and
exporting them as a video – but they 

differ greatly as far as user-friendliness and
flexibility are concerned.

Some programs stick to preset frame rates
for video export, while others allow you more
creative freedom. Video formats and
compression algorithms are another thing to
consider – does the software support these,
and if so, how? Movie Maker and other
programs for beginners who are not familiar
with the characteristics of different file types
have dedicated buttons for exporting to
YouTube and other sharing sites. In VirtualDub
and other more sophisticated applications,
the availability of a specific export format

depends on whether the appropriate codec is
installed as part of the operating system.
Some video applications require a fair degree
of know-how to be used successfully but
reward the user with flexible compression
settings that can be set to suit specific output
deivces. Appropriate codecs (DivX, Xvid, etc.)
can be installed at any time and are then
available for immediate use. For more
information about video formats and codecs,
see the box on Page 81.

In addition to basic functionality, some
time-lapse software offers extra features that
eliminate or speed up individual steps in the

Time-lapse Photography | Software

Instead of image frequency, Windows Movie Maker requires you to select the duration of
display for each image – 24fps equates to a display duration of 0.042 seconds.
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video creation process. VirtualDub and Time
Lapse Assembler don’t require you to
customize your images in advance and
instead reduce them to an appropriate size
automatically during loading. VirtualDub,
Avidemux and LRTimelapse all include options
for applying various creative effects and/or
preventing flicker. 

Programs vary greatly in terms of
user-friendliness, too. Comprehensive video
processing packages like VirtualDub and
Avidemux require you to put in some time
learning how to operate them, whereas Movie
Maker takes new users step by step through
the process of creating a video.

For your first few time-lapse projects, try
using free or pre-installed programs that
don’t require a lot of training. For Windows
users, that means Movie Maker, which is
located in the Accessories > Entertainment
Media folder for versions up to and
including Vista. The program is known as
Live Movie Maker in Windows 7 and is part of

the Live Essentials package that can be
downloaded from the Microsoft website. For
Mac users, using  QuickTime Pro (US$29.99)
is the easiest way to produce time-lapse
movies. The program is also available for PCs
at the same price.

A cheaper alternative for Mac users is the
TimeLapse Assembler donationware. If you
think you’ll be doing a lot of time-lapse

photography and want to get to know the
different programs better, try VirtualDub
(Windows freeware) or Avidemux (multi-
platform freeware). FFmpeg, MEncoder and
Stopmotion are all good choices for the Linux
environemnt.

When looking for an easy entry into the
world of time-lapse video creation, it’s worth
checking out the additional functionality of
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Programs like
VirtualDub

allow the user
to enter a

custom frame
rate when

making a video
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the software you already have on your
computer. Photoshop (from CS3 Extended
onward) includes easy-to-use sequence-
building functionality, and Lightroom also
works well once you have installed
downloadable templates for video export
and reducing the display duration in the
slideshow module (see the LRTimelapse
section on the next page). Finally, you can
also use specialized programs 
like Adobe After Effects or video editing
programs like Premiere, Premiere Elements or
Final Cut to create time-lapse films. However,
these are expensive, sophisticated software
packages and it would be over the top to
buy one purely for the sake of its time-lapse
functionality.

Assembling a Video 

Depending on the image format, the number
of source images and the video creation
program you have chosen, it may be
worthwhile copying the images into a
separate folder and downsizing them before
doing anything else. This uses less memory
and speeds up your work later on, especially if
you have a large number of large-format
images. You can now begin selecting your
images. There are two ways to go about this:
either select and import all images (as in Movie
Maker) or, in QuickTime Pro and Photoshop,
simply select the first image and check the
Image Sequence option. VirtualDub requires
you to use the ‘Open a video file’ command in

the File menu, which is anything but self-
explanatory. Then, before you go any further,
some programs also require you to drag your
images to the timeline.

All that’s usually left to do is to define the
frame rate. In QuickTime, you can enter any
number you like, while other programs use
preset frame rates. If you have a choice, it’s best
to start with the cinema frame rate of 24 fps.
Once you have gained some experience, you
can tinker with your frame rates – try 30, or 16
(the rate used in silent movies) and try to get a
feel for the way different rates affect the look
of the finished video. Movements start to
become fluid at between 14 and 16 fps. At
slower speeds, movements are generally too
jerky for comfortable viewing.

Time-lapse Photography | Video Creation

Creative image
processing does not
necessarily have to be
a separate step that
you perform before the
video is actually made.
Programs such as
Avidemux offer a wide
range of filters and
effects that you can
apply during video
generation.
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Each program sets the frame rate
differently. Some allow you to enter a value
directly, while others use amount of time each
image is displayed as their starting point. In the
previous (Vista) version of Movie Maker, the
frame rate is set in the Advanced tab of the
Tools > Options menu. In the newer Windows
Live version, the Duration setting is hidden in
the Edit menu. Converting a frame rate a
duration value is simple: a frame rate of 24fps
corresponds to 1/24 s, or 0.042 seconds per
image (see the illustration on page 76).

No further settings are required and all you
have to do now is export your sequence as a
video. It is usually possible to select the file
format and compression algorithm, which
determines file size and output quality.
Output is very easy with Live Movie Maker,
which provides one-click buttons for direct
export to everything from YouTube to DVD. In
the earlier versions of Movie Maker, wizards
guide you through the output process. 

Using LRTimelapse to Perfect
your Videos

While Movie Maker and Time Lapse
Assembler make it easy to produce your first
time-lapse video, the results may not always
be as good as you had hoped. Videos often
flicker, even if you couldn’t tell from looking
at your source images that this might be the
case. This is usually because the tolerances
in digital exposure systems allow for slight
discrepancies between shots. Some flicker
can be prevented by using manual
exposure settings, but this doesn’t always
cover all eventualities. Specialized software,
such as the MSU Deflicker and Graft Deflicker
plug-ins for VirtualDub, can help you
process the images so that the transitions
are less obvious. An alternative for
Lightroom and Photoshop users is Gunther
Wegner’s LRTimelapse donationware
(lrtimelapse.com).

LRTimelapse reduces flicker by smoothing
the transitions between one exposure and the
next, using a moving average of brightness
fluctuations to calculate the necessary
corrections. This ensures that slow changes,
such as those caused by moving clouds, are
preserved, while unattractive flicker is
removed. LRTimelapse only alters image
metadata and leaves the original image data
untouched. It uses the Adobe Camera Raw
(ACR) RAW development module, which
writes all the development settings –
including exposure, white balance and even
cropping – to the metadata of  JPEG and RAW
files. The modified metadata can then be read
by editing software like Lightroom or
Photoshop, which automatically applies the
new metadata settings to the image files.

LRTimelapse is always used in conjunction
with another image editing program and the
following sections describe the process as it
takes place in Lightroom.

Time-lapse Photography | Video Creation

TIME-LAPSE PHOTOGRAPHY TOOLS
Avidemux FFmpeg LRTimelapse QuickTime Pro Time Lapse Assembler VirtualDub Windows Movie Maker

Manufacturer/Developer Mean The FFMpeg Project Gunther Wegner Apple Daniel Bridges Avery Lee Microsoft

URL http://avidemux.org www.ffmpeg.org http://lrtimelapse.com www.apple.com/
quicktime

www.dayofthenewdan.
com/projects/time-lapse-
assembler-1

www.virtualdub.org http://explore.live.com/
windows-live-movie-
maker

Operating System Linux, Mac, Windows Linux, Mac, Windows Mac, Windows Mac, Windows Mac Windows Windows

Category Video editing/conversion Video editing/conversion Time-lapse tool, standa-
lone image editing, videos
using Lightroom template
or other tool

Video editing/conversion Tool for time-lapse videos Video editing/conversion Basic video
creation/editing

Frame Rate Freely selectable Freely selectable, depen-
ding on codec

15, 24, 25, 30 fps Freely selectable Freely selectable Freely selectable Display time per image
freely selectable

Image Editing Effects Downsizing; numerous
filters, e.g. color effects

Downsizing Cropping; 
deflicker and alignment
directly in LRTimelapse.
Extensive further editing
in Lightroom.

Extensive video 
post-processing possible

Downsizing Downsizing; numerous
filters, e.g. color effects;
more filters can be instal-
led

Downsizing via output
formats

Other Wide range of video
formats

Command-line program Best used with Lightroom
or other programs that
support Adobe Camera
Raw

None None Filters (MSU Deflicker and
Graft Deflicker) available

Includes wizard for video
creation

Price Free (GNU GPL) Free (GNU GPL) Donation US$45 Donation Free (GNU GPL) Free
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The process begins by editing the first
image in the sequence so that it looks the way
you want it to in the final film. Next,
synchronize all of your images to the first
image and edit the final image to your liking.
Make sure you activate the Save Metadata To
File option in the Catalog Settings dialog.

LRTimelapse then leaps into action with its
twin-slider deflicker tool. The program’s
developer recommends adjusting the
smoothing of the reference curve manually
using the Average Smoothing slider while
leaving the Exposure Effect slider at its default
value. It is even possible to set a reference detail
to make the corrections more balanced. There
are also buttons for S-shaped, Fade In and Fade
Out transitions. These are not particularly

Time-lapse Photography | Fine-tuning
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Adding video export and
additional slideshow templates
transforms Lightroom into an
excellent time-lapse film
creation application

LRTimelapse is designed to smooth
transitions and eliminate flicker in

time-lapse image sequences



relevant to the deflicker process but can be
useful for jazzing up your video with creative
effects if you wish. Unfortunately, due to its
metadata-based correction methods, the
program doesn’t let you preview your changes.
Use the Save Data button to apply the new
parameters to all your images. Then, back in
Lightroom, you can use the Metadata > Read
Metadata From File command to import the
changes. That completes the image editing
part of the process and you can now load  your
images into one of the video creation
programs mentioned earlier. 

Alternatively, you can use the Lightroom
Slideshow module to play your film.
Unfortunately, the program’s fastest standard
frame rate is 10 fps, which is not really fast
enough for most time-lapse films. Gunther
Wegner has programmed free additional
templates that increase the display rate to 24,
25 or 30 fps.

Wegner also supplies video export
templates with different sizes, bit rates and
display refresh rates for Lightroom 3 and 4. These
turn Lightroom into an easy-to-use, full-featured
time-lapse video creation program. 

LRTimelapse also enables you to produce
smooth white balance transitions and virtual
pans using the Ken Burns Effect (i.e., by
constantly changing the detail being
displayed). It is worth using the program for
this feature alone, as it is much easier to create
pans from cropped images than it is to
perform them smoothly during shooting. If
you shoot high-resolution source images, you
will have plenty of processing leeway and you
will be able to produce results of a better
quality than you can when using the zoom
feature in a video editing program. (jub)  c

Time-lapse Photography | Fine-tuning
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The digital storage of sound and video
data involves a compression process that
produces the smallest possible file size
while keeping image quality loss at an
acceptable level. The algorithm required is
part of the operating system and is known
as a ‘codec’. Codecs are usually available to
all programs, although some proprietary
codecs, such as the RealPlayer and
QuickTime ones are installed exclusively
with the corresponding software. The
process of creating a new video file is
known as ‘encoding’, and when you play a
file, your software ‘decodes’ it in real time.

MP3, WMA and Ogg Vorbis are all
well-known audio codecs with filename
extensions that are obvioulsy related to
their names. Video codecs are a little more
confusing, and while it is true that MPEG
(Moving Picture Experts Group) file formats
dominate the video world, there are 
many differnet variants from various
manufacturers on the market. For example,

the MPEG-4 category includes the popular
Xvid open source format as well as DivX,
Nero Digital and many other formats.
Furthermore, the file name does not
necessarily reveal which codec was used,
because the data is stored in a container

file, which could have the .avi (Windows) or
the .mov (Apple) extension. All that an
extension tells you is that the file is a video
file. A container usually contains a header
that includes all the relevant details and
separate audio, video (and sometimes
subtitle) data. This structure means that
audio and video files can be compressed
using different algorithms. For example, An
.avi file can contain MP3 audio data and
DivX video.

There is no simple answer to the question
of the ‘best’ codec to use for a video file.
The one you use will depend on the
purpose of the file and the output device
you use to view it. MPEG-2 is the best
format to use for burning files to DVD,
whereas an HD-compatible codec like
H.264 is better if you want to display your
footage on an HD TV. If your material is
destined for viewing on the Internet, a
browser-friendly format such as Flash (.flv)
is a better choice.

A Beginner’s Guide to Video Formats and Codecs

Container Format

Header
data

Video

Audio

Container files can use different
compression algorithms for audio and
video files. The relevant information is
stored in the header.





Photographers often turn to smoke and fog for impressive effects,
whether for a steaming coffee in a food shot or spectacular clouds of
swirling mist surrounding a rock band on stage. Here we explain the
most common methods of producing these types of effects and walk
through some practical examples to show you how to create your own.ˇ

Cyrill Harnischmacher

How to Create and Photograph

Smoke and Fog Effects
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The difference between smoke and steam is
easily explained: smoke consists primarily of
the products of combustion, i.e., solid
particles, whereas steam consists of very fine
droplets of liquid. In either case, the tiny
particles reflect light as it strikes them, and
thus become visible.

There are several ways of creating smoke
or steam in the studio, but not every kind of
smoke or steam is equally suitable for  all
purposes. The amount produced and the
intensity vary greatly, as do the appearance,
behavior and length of time that the effect
lasts. The best method to use will depend on
the subject and the effect you want to create.
Chance affects the results too, so you will
usually have to take a series of photos in order
to achieve ythe desired result.

Fog Machines and Hazers

The classic stage prop that we are all familiar
with from discos and parties is the fog
machine, which works by vaporizing a special
‘fog fluid’. Even small machines have a
relatively powerful output, which makes them
unsuitable for low-key effects like a steaming
cup of coffee. They are more suited to
large-scale applications, such as producing
fog for a stage or filling a whole room. The
effects can be very impressive, especially if
you shoot using colored flash.

You can pick up a fog machine quite
cheaply online or from events suppliers and
music stores.

Hazers are a special type of fog machine
that create a fine haze rather than thick fog.

They are used in stage shows to fill the entire
stage area with haze so as to make the beams
of light from the stage lighting visible. You can
achieve a similar effect in a home studio by
using a fog machine and blowing the fog
around to fill the space.

Dry Ice

If you want your fog to really billow, dry ice is
your best bet, although can be difficult to
obtain and store. Dry ice is actually carbon
dioxide (CO2). At -78.5 degrees Celsius, it
changes from a solid state directly into a gas.
The CO2 gas thus created is heavier than air
and sinks to the ground.

Dry ice is particularly useful in situations
that require the fog to remain close to the
subject, or you want to use it in a targeted
fashion to cover a small area. Since this type
of fog sinks, it does not work too well to
simulate hot food, but is great if you are
photographing themes such as a chemistry
lab or fantasy scenes.

Dry ice comes in the form of pellets or
blocks. Because it has to be kept frozen at
extremely low temperatures, it cannot be
stored for long, and you can only keep it for
two to three days before it literally vanishes
into thin air. Consult your local telephone
directory to find a supplier. You can also buy
dry ice online, but bear in mind that if you
order five kilos with a two-day delivery
schedule, you will end up with only about two
kilos of product.

If you plan to use dry ice, read the safety
instructions very carefully and wear
appropriate protective equipment, including
gloves and safety glasses.

To make fog, pick up a few clumps of dry
ice with a spoon and put them into a

Smoke and Fog Effects | Introduction
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Here, the fog machine
was placed behind the
metal screen and
activated just once,
shortly before the
exposure

60 mm | f16 | 1/200 s | 
ISO 100

A small fog machine
does not cost a lot and
can be used to create
some really interesting
effects in the studio
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Hazers create a fine mist
that makes beams of light
visible on stage without
obscuring the action

28 mm | f6.3 | 1/20 s | ISO 160



Just add a little dry
ice to water tinted
with food coloring
and hey presto – you
have a delicious
witches’ brew

60 mm | f18 | 1/160 s |
ISO 100
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container, then pour some warm water over
them. Alternatively, add a lump of dry ice to
some warm water – the effect is the same.

Smoke Tablets

No, we’re not talking about products to help
you give up smoking, but rather about a
commonly used method of detecting cracks
in industrial buildings. Smoke tablets are also
used to create spectacular vapor trails at
model airplane shows. Most tablets burn for
up to two minutes and produce about four
cubic meters of smoke, making them
unsuitable for studio photography. They are
better kept for outdoor use – for example,
when photographing musicians.

Be careful if you are using large-scale
effects, as some types of smoke or artificial fog
will trigger any nearby smoke alarms! It’s a
good idea to let neighbors know what you are
doing before you start a shoot, not only to
prevent undue concern, but also to avoid the
fire brigade getting called out on a false alarm.

Tobacco and Incense Sticks

Burning a little tobacco in a tea light holder is
a great way of generating small amounts of
targeted smoke. The smoke rises quickly,
creating a thin plume of smoke that is not
particularly suitable for creating large-scale
effects but is ideal for enhancing small details.
If you don’t like the smell of tobacco smoke,
try incense sticks or cones instead. Tobacco
often has a slight blue cast, but this is easily
removed later during processing, usually by
reducing saturation.

Vapor Effect

Photographic accessory stores stock a
two-component product  that is often used in
food and still life photography. The chemical

reaction that occurs when you mix the two
liquids produces very photogenic plumes of
vapor. The liquids can be used in very precise
quantities and here too, it is important to
observe the manufacturer’s safety
instructions.

Smoke Generators

Model railway enthusiasts use tiny smoke
generators to simulate the steam from a
locomotive. This is done by filling the
generator with ‘smoke oil’ and heating it with

an electric coil. In photo studios, these
generators come in very handy for producing
small amounts of smoke in just the right place. 

Steam

In food photography, a popular way of
simulating the heat of hot food is to use water
vapor – hardly surprisingly, since that is
exactly what does waft up from a bowl of hot
soup! What is tricky, however, is getting water
vapor to stay in the right place at exactly the
right time.
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SMOKE AND STEAM GENERATORS
Description and uses Source Price Notes

Hazers Wide-area haze on stage or in a photo studio Music retailers, event suppliers From US$75 –

Fog machines Wide-area smoke on stage or in a photo studio. 
Sometimes also for tabletop use.

Music retailers, event suppliers From US$40 –

Incense sticks/cones Targeted smoke for tabletop and food photography Fair Trade shops, Christmas markets, etc. From US$1 –

Smoke generators Targeted fine smoke produced using ‘smoke oil’ Modelmaking shops From US$30 Age restrictions may apply

Smoke oil Targeted fine smoke produced using smoke generators Modelmaking shops From US$10 Age restrictions may apply

Smoke tablets Intense smoke effects for outdoor use when large amounts are re-
quired. Also available colored.

Specialist pyrotechnics stockists From US$15 Age restrictions apply

Tobacco Targeted smoke for tabletop and food photography Tobacconists About US$10 Age restrictions apply

Dry ice Fog that sinks to the ground for partial and wide-area fog effects Specialist suppliers, consult directory From about US$45 Note safety instructions. Limited storage
period.

Vapor effect Targeted smoke for tabletop photography Specialist pyrotechnics stockists, photography 
accessories retailers

About US$40 Liquids can be corrosive

Steam Fine, delicate steam, ideal for simulating hot food. Effect does not 
last long.

Available in any home – Very cheap but not very intense

Tobacco, model railway ‘smoke oil’ and incense cones or sticks are all you need to
produce a range of tabletop smoke effects



Smoke and steam only become fully visible
when illuminated using flash. The best results
are achieved using targeted lateral light and
as dark a background as possible. White
smoke against a white background is
obviously not the best setup. If a dark
background is not possible for whatever
reason, try to position darker parts of your
subject so that the smoke or steam rises in
front of them and therefore remains visible.

Pure Smoke

Let’s concentrate for a while on appreciating
the inherent beauty of smoke. The fascinating
shapes that come from a candle immediately

after it has been extinguished are worth
looking at more closely. The smoke is swirled
about as the warm air rises and the air around
it moves, forming new, unpredictable
patterns. Sometimes it rises in a fine, thin
thread and sometimes as a sumptuous
‘bloom’. Often the shapes seem to be regular
or symmetrical, but then, in the twinkling of
an eye, they disappear. Like snowflakes,
smoke patterns are unique.

The methods described below can be
applied to just about any photographic
project that uses smoke or steam.

All you need is a candle or a few incense
sticks, an accessory flash, two pieces of black
card, a black background and a darkened
room. A normal accessory flash set to ¼ power

will provide sufficient light to shoot at ISO 100
and f8.

The black card is used to shape the beam
of light into a thin strip. This way, the
background stays truly black and no stray
light reaches the lens. The ‘hard’ lateral light
this creates is ideally suited to photographing
smoke. The flash is fired either using a sync
cord or a remote trigger.

First, mount the camera on a stable tripod,
then pre-focus on the subject – in our case,
the candle. The constantly changing contrast
will confuse autofocus, so keep it switched off.
Set your camera to manual exposure mode.

Set the exposure time to match the 
flash sync speed quoted by your camera’s
manufacturer and take a few test shots at f8 to

Smoke and Fog Effects | Technique

Practical Applications

‘X-ray’
60 mm | f7 | 1/50 s | ISO 100, reduced saturation
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Corkscrew
60 mm | f7 | 1/50 s | ISO 100, reduced saturation



check whether the images are properly lit or
whether you need to increase flash output.

The most spectacular smoke trails are
created at the moment the candle flame is
blown out and the wick is still glowing, or, in
the case of a cigarette or an incense stick,
when the flame goes out after you have lit it.
Using a remote release eliminates the need to
rush back to the camera after extinguishing
the flame and helps you concentrate on
capturing the best smoke trails.

Smoke reacts to even the tiniest air
movements and you can exploit this to create
amazing shapes – but take care to block drafts
and avoid making quick movements as these
cause the air around the subject to eddy and
spoil the natural shapes. With practice, you’ll
develop a feel for how to move your hand
back and forth to make different smoke
designs. Another interesting variation is to use
sudden small movements to make incense
sticks produce smoke rings.

This is the time to let your imagination and
instinct for play run wild. Interpreting the
shapes of the results and seeing what shape
they are, finding faces in them and giving
them names  can be a lot of fun. In the photos
below, the two on the left were created using
a candle and the ones on the right using an
incense cone.

Smoke and Fog Effects | Technique

Statue of Liberty torch 
60 mm | f7 | 1/50 s | ISO 100

You don’t always need studio
flash. Here, two pieces of

black card shape were used to
shape the light beam from a

single accessory flash.
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Lady in evening gown 
60 mm | f7 | 1/50 s | ISO 100

Ionic column 
60 mm | f7 | 1/50 s | ISO 100
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A beauty dish with a honeycomb filter produces ‘hard’ lateral light. Two pieces of
black card were used to shape the light beam and prevent any stray light from
spoiling the overall effect.

A burning cigarette stub is hidden in the barrel of a pistol. 
Non-smokers may prefer to use incense sticks or cones.

Smoking Pistol

In this example, we used burning tobacco  to
produce the smoke. We set up the
composition, lighting and props so that the
lantern’s flame was reflected in the knife
blade. After several trial runs and several
checks on the monitor, we set up the version
with the smoke using tweezers to carefully
place a burning cigarette stub into the barrel
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of the pistol. The key to composing this image
was allowing enough space for the smoke to
act as a central visual element.

We used a beauty dish with a honeycomb
filter to produce targeted lateral light that
helped the smoke to show up against the black
background as a thin, contoured trail. To
prevent stray light from spoiling the scene, we

used black card to shape our light source.
Instead of using the manufacturer’s
recommended flash sync speed, we used a
longer (¼ s) exposure so that the warm light
from the lantern could create a golden glow. In
a situation like this, the room has to be almost
completely dark to prevent ambient light from
spoiling the mood of the shot.

Here, instead of using the standard flash
sync speed, we used a long exposure of
¼s to allow the warm light of the lantern
to emphasize the mood of the scene. We
then used an additional flash to ‘freeze’
the movement of the smoke trail 

40 mm | f13 | 1/4 s | ISO 100
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Hot Coffee
Here too, we used tobacco, this time to
simulate the steam coming off a hot coffee.
Strictly speaking, we should have used 
real steam from hot water, but this cannot be
positioned as precisely and does not produce
as intense a result. To make the tobacco smoke

look more like steam, we used an accessory
flash with a strip-light to produce targeted but
soft light. This makes the steam from the
coffee look a little softer and makes it spread
out a little more than the smoke from our
flintlock pistol. A second accessory flash with

a red filter was placed beneath the subject to
produce the color gradient on the black
background.

To make the coffee cup appear to float, we
fixed it to a metal bracket using hot-melt
adhesive. This type of glue hardens very
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Smoke and steam show up particularly
well against dark backgrounds 

50mm, f6.7, 1/180s, ISO160

quickly and is easy to remove from most
materials. In our example, we used several
small blobs of glue to fix the cup in place for
some test shots, before applying large
amounts of glue to keep the setup stable while
we shot the final version of the photo.

We painted the bracket with matte black
acrylic paint to keep it from reflecting in the
shiny saucer. During post-processing, we
also removed a few final reflections and
used the Dodge tool to emphasize the
smoke a little.

Most of our images looked really good
straight from the camera, but a little 
post-processing in Photoshop can always
make them even better. We duplicated
the original background layer and
switched the new layer’s blending mode
from Normal to Screen. The intensity of
the smoke trail can then be intensified by
altering the layer’s opacity.

Partial corrections can be made using
the Dodge tool with its Highlights
setting. With tobacco and incense
smoke, it is often necessary to prevent
color casts by reducing saturation using
the Sponge tool.

After a while, you will build up a ‘smoke
archive’ that you can use to add smoke
effects to other images.

To do this, select an appropriate smoke
shot, place it on a new layer above the
background layer and switch the
blending mode to Screen. You can now
position the smoke trail anywhere you
like. The only prerequisite for producing
seamless smoke montages is that the
smoke itself is photographed in front of a
compeltely black background. 

Image Processing

The ‘coffee’ emphasizes the movement 
of the cup, and is actually made of shiny
black foil set at a slight angle and fixed
in place with a few drops of glue. A piece
of burning cigarette was dropped into
the cup through the opening at the side
just before the shot was taken so that
the smoke from the cigarette wafted 
up like steam from a hot cup of coffee.
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Hot Soup

This is another shot for which it is really
important to get everything (especially the
lighting) set up correctly before starting to
shoot. In order to prevent the ingredients from
sinking to the bottom of the soup, we built the
it up layer by layer from the bottom.

The first step was to mix some of the soup
with a couple of packets of gelatin and pour it
into the bowl. We filled the bowl just enough
so that we could see the soup through the
viewfinder. This layer then served as a base
for the rest of our soup model. Placing the
gelatin soup in the refrigerator accelerated
the cooling process, and we placed a saucer

over the bowl to prevent dust from settling
into the liquid.

Once our gelatin layer was set, we soaked
the noodles in hot water for about 10 minutes
and, once they had cooled, arranged them
with the vegetables, mushrooms and herbs on
top of the gelatin base. We then added a ladle
of (still runny) soup until the ingredients were
two-thirds covered with liquid.

The next step involved boiling a large
potato, which served as our source of steam.
We placed the potato behind the soup bowl
where it couldn’t be seen and cut it open just
before we made our exposure. Steam from a

hot potato looks realistic in flash light or in
long exposures but dissipates quickly,
making it necessary to work fast. We used a
sheet of paper to gently waft the steam
toward the bowl to make it appear to rise
form the soup itself.

In our example, the soup bowl was lit from
the left using light from a strip-light that we
shaped using black card. A second flash with a
spot attachment was set up at the same height
as the rising steam. We also used several small
mirrors to delicately reflect the light from the
flashes onto the mushrooms to the right of 
the bowl and we used a piece of white card

The hot potato was positioned
directly behind the bowl to prevent it
from appearing in the final image

The ingredients look totally natural suspended in
gelatin and do not sink to the bottom of the bowl.
Since virtually no liquid is visible in the final image,
no-one will notice that the soup is a little too grainy.
Perfectionists can always filter the soup and use a
brush to paint some soap-based foam around the
edges of the bowl.



positioned to the right to highlight the shape
of the bowl.

Instead of a potato, you can use a bowl 
of hot water to produce a similar effect. If
you have space, you can also use a small
hotplate and a saucepan of water, which will
provide a steady supply of steam for much
longer.

Steam is just as unpredictable as smoke
and fog and you will need to spend quite 
a bit of time experimenting until you 
come up with the best way to arrange the
subject, background, lighting and smoke
source to produce the effect you are

looking for. Always take as many shots as
possible so you can select the best when
you are done. 

Perseverance during a shoot will be
rewarded not just with a learning experience
but also with spectacular photos. Even used
sparingly, steam and smoke are powerful
visual signals and immediately trigger any
number of associations in the viewer’s mind.

The result is exactly what the
photographer intended: a single image that
tells a whole story. (anm) c
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Most of the steam from the potato lies outside the very limited area of focus. We wafted it 
forward using a sheet of paper to ensure that it appeared above and not just behind the bowl.

60 mm | f6.3 | 1/200 s | ISO 200
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The rise of affordable digital imaging
technology has been the downfall of many

traditional photo companies. One of the best
known of these is the Polaroid Corporation –
once one of the driving forces of the
photographic industry. The sale of much of the
company and impending bankruptcy have
brought the Polaroid brand to the brink of
extinction, not only affecting thousands of
employees, but also threatening the existence
of a unique collection of photos. 

The Polaroid Collection’s global reputation
was based on works by many of the all-time
greats, including Ansel Adams, Robert
Mapplethorpe, Helmut Newton, Gunter Sachs
and Andy Warhol, and the outcry was huge
when it was announced in the summer of 2010
that the collection was to be auctioned off.
Large parts of the collection are now privately
owned and only a batch of 4,400 originals that
had previously been loaned to the Musée Elysée
in Lausanne was saved in its entirety. 

Two hundred and thirty of these photos
have now been immortalized in this wonderful
book, which catalogs an exhibition that took
place at the Westlicht photographic museum
in Vienna in the summer of 2010. This selection
covers a period of more than 50 years of
photographic history and spans just about
every genre. Due to the nature of the Polaroid
instant photo medium, all of these photos are
unique originals, and reproducing them in this
way – complete with their borders and traces
of the chemical processes that formed them –
is the logical way to pay tribute to their
importance. The hand-written notes made by
some of the photographers give the photos
added appeal.

As well as documenting bygone instant
photo art, From Polaroid to Impossible provides
a history of recent efforts to revive a format
that has often been written off due to the
complete non-availability of film. The title of
the book hints at the ‘Impossible Project’
launched by Austrian Florian Kaps that saved
the last remaining Polaroid film factory from
demolition. Film production was restarted
there in 2010. The book also includes recent
works created using the new film, testifying to
the great response the rebirth generated
within the photographic world. Could it be that
analog photography will end up living longest
in the unique and unpredictable world of the
instant photo?

Saved by the Bell! From Polaroid To Impossible

Achim Heine (Editor), 
Ulrike Willingmann (Editor) 
Text by Barbara P. Hitchcock 
Published by Hatje Cantz 
192 pages 
230 color illustrations, 25x32 cm 
US$60 
ISBN 978-3-7757-3221-5

From Polaroid 
To Impossible

From Polaroid 
To Impossible
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Heung Shing Liu searched through the
archives of 88 Chinese photographers to

create this fantastic collection of images of
historical moments and everyday events. The
result is a big, 424-page book that documents
the history of China since 1949. The volume’s
subtitle, Portrait Of A Country, indicates the
breadth of the editor’s ambition, and the
resulting pictorial history covers 60 years of
revolution, violence, hunger, poverty and
dictatorship. Even if freedom in a Western
sense is still a distant dream, modern China
offers its people prosperity, irrespective of
whether the questions of contemporary values
and a system of government that extends
beyond centralized control still remain
unanswered. How can a single book hope to
cover so much territory?

The book’s editor, Heung Shing Liu, grew up
in Hong Kong and China and studied politics
and photography in the USA before spending a
number of years working as a photographer for
AP. Perhaps it is this combination of deep
personal roots and wide-ranging experience
that made this extraordinary project not just
possible but also such a resounding success.

China unites powerful visuals with detailed
background information without once
appearing condescending. Heung Shing Liu

doesn’t make value judgments – or at least, not
unless you consider such a welter of photos
depicting violence to be a judgment in
themselves. But this book is not only about
violence, and peaceful moments from the lives
of the people in the street (and their masters)
are just as much a part of the visual feast 
on offer. 

Heung dedicates 120 pages to the great
leap into the capitalist present, and this is
where his personal feelings and motivations
are clearest. The images in this section include
portrayals of agitative art and the Potala 
Palace in Tibet, flanked by a quote from the
Dalai Lama. 

The map of China included in the appendix
shows no border between Tibet and the rest of
the country – a detail that is surprising to
Western eyes in an otherwise persuasive
masterpiece available at a price that makes it 
a real gift. (Robert Seetzen/rst)

Heung Shing Liu (Editor) 
Published by Taschen 
424 pages 
25x34 cm 
US$29.99 
ISBN: 978-3-8365-3089-7

China, Portrait
of a Country

A Masterpiece at a Bargain Price: 
China, Portrait of a Country
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This photo shows a
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traditional Peking
opera.





Image Processing Tools

Windows
GIMP 2.6.12

GIMP Portable 2.6.12

GREYC’s Magic Image Converter 
(G’MIC) 1.5.1.2

Image Analyzer 1.34

ImageJ 1.45

Inkscape 0.48.3.1

Inkscape Portable 0.48.2

JDraw 1.1.5

Mosaizer Pro 9.2.140

Paint.NET 3.5.10

Picasa 3.9.0

PSPI 1.0.7

ShiftN 3.6

StylePix 1.9.2

StylePix Portable 1.9.2

Mac OS
GIMP 2.6.11  for Leopard

GIMP 2.6.12  for Snow Leopard, Lion

GraphicConverter 7.6.2

GREYC’s Magic Image Converter (G’MIC)
1.5.1.2 for Leopard, Lion, Snow Leopard

ImageJ 1.45

Inkscape 0.48.2

Linux
GREYC’s Magic Image Converter 

(G’MIC) 1.5.1.2

ImageJ 1.45

PSPI 1.0.5 for Ubuntu

Photo Tools
Windows
AmoK Exif Sorter 2.5.6
EXIFeditor 2.2
Exifer 2.1.5
ExifTool 8.89
Gallery 3.0.3
GeoSetter 3.4.16
GeoSetter Portable 3.4.16
IrfanView 4.33
IrfanView PlugIns 4.33
IrfanView Portable 4.33
jAlbum 10.6
Smart Shooter 1.1.14
XAMPP 1.7.7

Mac OS
AmoK Exif Sorter 2.5.6
ExifTool 8.89
Gallery 3.0.3
jAlbum 10.6
MacPorts 2.0.4

Rawker 2.3.4
Smart Shooter 1.1.14
ThumbsUp 4.5
XAMPP 1.7.3
Xee 2.2

Linux
AmoK Exif Sorter 2.5.6
ExifTool 8.89
Gallery 3.0.3
jAlbum 10.6
XAMPP 1.7.7

Sample Images
Color Management Test Images
Precision Selection Sample Images

Videos
Time-lapse Photography Sample Clips
Photoshop Tutorials

Video Tools
Deshaker 3.0
PhotoLapse 3.0
VirtualDub 1.9.11
VirtualDub Portable 1.9.11
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Interiors
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Interior photography follows its own rules and presents
the photographer with a unique set of challenges. This
workshop goes into detail on how to choose a subject
and effectively shoot various types of indoor scene in a
variety of different lighting situations.

Choosing a Subject 102
Photographing Enclosed Space 108
All About Light 112

In this article



Compared with selecting outdoor
architectural subjects, choosing a suitable
interior subject can seem a daunting task to
the inexperienced. The range of easily
accessible and interesting subjects is simply
much narrower (see also Know Your Rights on
page 107). Nevertheless, there is no limit to
the number of ways you can photograph a
room and it is not the nature of the space itself
but rather the way you portray it that
determines the effectiveness of the resulting
image. Shot cleverly, even a bare loft or a
cellar can make an interesting subject.

In the example shown below, the form of
the care-worn, abandoned loft produces an
unusual, almost abstract look, while the dusty
chair and the light entering the space from
outside accentuate the special feel of the
scene. 

There is a wealth of similar subjects and
interesting details to be found in derelict
buildings everywhere, whether an old railroad
shed, a factory building or maybe even an
abandoned hospital. But castles, museums,
churches and concert halls, with their impressive
inner spaces, make great subjects too. 

Fixtures and Fittings

The structure of the building itself is rarely the
main subject of an interior photo, and it is
nearly always the combined effects of the
building and its interior that make the photo
interesting. While the interior design of public
buildings is usually reduced to a functional
minimum, private spaces are a different
matter entirely. In this case, the objects
located within a space often play a significant
role in the overall composition. For example,
in the image reproduced on the opening page
of this article, the intense colors of the
furniture, the lamps and the plants contrast
strongly with the white pillars and the circular
window and play an important role in the
overall mood of the image.

As soon as everyday objects such as
newspapers, paintings or lamps begin to
attract the viewer’s attention, the architecture
itself recedes almost completely into the
background. Because the building serves only
to give the space its shape and because the
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It is not the nature of the subject
itself, but rather the way you portray
it that determines the effectiveness of
an interior photo 

Choosing a Subject
The first thing you have to do is ask yourself what exactly you
want to portray and how you want to utilize the interplay between
the space and the objects it contains. Once you know what to look
out for, it gets easier to develop effective image ideas.
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A room that contains very few objects and accents will produce an image
with a clearly structured composition



fixtures and fittings convey a domestic feel,
images of obviously lived-in spaces can more
often be found in lifestyle magazines than in
architectural periodicals. 

On the other hand, architectural interior
shots often appear almost clinically clean and
tidy. In order to effectively communicate the
functionality of the design, photographers
often remove all objects that don’t play a
specific role in emphasizing the merits of the
building itself. The only objects that remain
are those that offer subtle visual accents, such
as the statues and the receding pattern
created by the vase and the candles in the
image on the previous page.

Preparing for a Shoot

Always carry a cleaning cloth for removing
dust and grease when preparing a room for a
shoot. Stray fingerprints on windows and

other polished or reflective surfaces are very
difficult to retouch once an image has been
captured, and the same is true for dust and
dirt on the floor. Once your scene is ‘clean’,
you can arrange the remaining objects to suit
your purposes. Chairs that aren’t quite aligned
with a receding axis or tables that are not
positioned parallel to a wall can cause
unwanted tension in an image and quickly
make a scene look cluttered rather than
carefully arranged. 

When arranging interior objects, you have
to choose between two extremes: go the
whole hog or simply leave everything as
found. You either have to arrange everything
perfectly or break all the rules by deliberately
arranging things to be out of kilter and attract
attention. For example, a photo of a dining
table and chairs can be enlivened by moving
a single chair slightly to face the camera.
However, if you are in any doubt, leave things

tidy – a badly placed accent can spoil an
interior image to a much greater degree than
a nonexistent one.

Framing and Composition

Once you have chosen and arranged your
subject, you will have to give some thought to
the framing and composition of the image
you wish to create. Although you can adjust
your framing a little at the editing stage, the
overall composition is basically set in stone
the moment you release the shutter. You will
need to consider how to produce a well-
thought-out image from the interplay
between the objects, shapes, edges and
proportions that make up the scene you are
photographing. The aim of the exercise is to
capture and hold the viewer’s attention with a
composition that accentuates the look and
feel of the scene in question. If you are
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This image of a relatively narrow room was composed according to the Golden Ratio



successful in performing this tricky balancing
act, you will have the freedom to experiment
with contradictory compositional elements
without spoiling the overall effect of your
shot. On the other hand, a sub-standard
composition can make a spectacular room
look quite ordinary, or even make the
architecture itself appear badly designed. 

Using Limitations Creatively

The same rules that apply to producing
interesting and effective exterior shots also
apply to interior situations, although in this
case, the photographer’s room for maneuver
is much more limited. Including elements of
the surroundings or the sky is impossible, and
composing a shot to include just one specific
part of a room quickly reduces the magnitude
of the photo to a scale at which the building is
no longer recognizable as such. In such cases,

individual architectural details or aspects of
the interior design take on the role of the main
subject. 

However, these limitations also present
opportunities for taking a more artistic
approach to your photography – for example,
by focusing on specific details such as the
weather-beaten elements of a façade.
Sequences of similar images with a common
theme are also an effective way to portray
architectural details, as is the use of unusual
perspective or blocky, monotone
compositions. There are no limits to what you
can try out – skylights, staircases and mirrors
are great features for experimenting with.

Using Proportions Creatively

It is important to analyze each room
individually and to look for ways to emphasize
its best features. The Rule of Thirds and the

Golden Ratio are both useful guidelines for
producing well-proportioned images. The
latter (approximately 1 : 1.618) is widely used
in the arts and architecture to symbolize ideal
proportions and harmonious aesthetics. If you
arrange important features of a compositon
to correspond with these proportions (as
shown in the image on page 104), the results
are virtually guaranteed to be interesting and
captivating.

The Rule of Thirds divides an image into
nine sections using imaginary lines that divide
the length and breadth of the frame into
thirds. Arranging windows, door frames or
walls to correspond with the vertical ‘thirds’
lines is another way to virtually guarantee
effective results.

Creative use of doorways, arches, and
other gaps in the surrounding structure often
helps to produce interesting and unusual
photos. Portraying the transition from an
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Making the transition between the interior and the world outside part of the composition adds tension to this image



106 c’t Digital Photography 8 (2012)

Interior photography | Formats and People

interior to an exterior view also offers a whole
range of new photographic possibilities. For
example, the image on the previous page
perfectly illustrates the seamless transition
from interior to exterior that the building’s
architecture evokes. In cases like this, the
unusual design immediately captures the
viewer’s attention and constitutes an
unfamiliar, mixed form of interior/exterior
photography.

Formally speaking, exterior spaces that
behave in a similar way to interior scenes can
be photographed using interior photographic

guidelines. Many of the tips and tricks
mentioned in the course of this workshop can
be applied just as well to capturing images of
enclosed squares and yards that only differ
from ‘normal’ rooms in that they have no roof.

Image Formats

The image format you choose can
significantly influence the effect of an
architectural image. Raw image data is
captured using the format of the camera’s
sensor, which is usually 3:2 or 4:3. You also

have the choice of shooting in portrait or
landscape format. If you want your results to
look authentic, the format you choose should
reflect the overall proportions of the space
you are photographing. Obviously vertical
structures such as the spiral staircase shown
below cry out to be photographed in portrait
format. In contrast to exterior situations in
which the photographer can include
elements of the surroundings (such as trees or
the sky) to alter the composition, it is seldom
possible to capture interior situations
effectively using a format that doesn’t
correspond to the shape of a space or its
features. 

Experiments with formats that contrast
with the basic shape of a space usually
produce unattractive results. A portrait-format
shot of a broad, low room will generally
produce a poorly balanced image, with
unimportant features such as the floor or
ceiling taking up too much space in the
overall composition. This is one of the reasons
why the landscape format is the dominant
form in interior photography. 

People

Because they tend to dominate the scene and
attract the viewer’s attention, people are
rarely included in interior shots. They also take
the emphasis away from the structural side of
the image and give it an overly personal
touch. And because the size of the windows,
doors, and other fittings is implicit within the
space being photographed, human subjects
are also rarely required to illustrate scale. 

If precise representation of the design is
less important, you can use artistically blurred
or implied human subjects to emphasize the
feeling of space in an interior shot. To create
this type of effect, select a long exposure time
(in the case of the image shown on the 
right, 0.8 seconds) and have your human
subject perform a preplanned movement or
sequence of movements while the shutter is
open. The result will be an unusually dynamic
interior photo.

Using an image format that 
accommodates the dominant
feature of the subject gives you
plenty of freedom when 
composing an image 
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Using movement to add artistic flair to an interior shot

f10 | 0.8 s | ISO 100

It is not always permitted to take pictures
in every building that is theoretically
photographable. The laws applying to
interiors and their contents are more
restrictive than those that apply to
photographing exterior scenes. This
usually means that you require explicit
permission to photograph the inside of
public or private rooms for personal and
commercial purposes. 

Owners and landlords usually have the
power to exercise property rights and, as

such, can decide whether to grant or
refuse permission to take photographs
and/or to allow the use of photo
accessories such as flash or a tripod. If you
plan to publish interior architectural
photos, you will often require the
architect’s permission too.

It is easiest to secure permission to shoot
interiors if the owner is someone you know
personally. 

It is particularly important to ensure that
you have the correct permissions to shoot

inside airports, railway stations, banks and
government buildings, as these are nearly
always subject to additional security
considerations. Never assume that you can
shoot without permission in any public
place, especially indoors.

The rules and regulations that apply vary
from country to country, so if you are in
any doubt at all as to whether you are
allowed to shoot, it is always better to miss
a shot than to get embroiled in legal
difficulties.

Know Your Rights
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The choice of camera positions when
shooting in indoor situations is severely
limited compared to the freedom you have
when working outdoors. It is only really
possible to produce realistic-looking interior
shots if you work backed up against a wall or
if you use openings in the architecture, such
as arches or doorways, to increase the
distance between the camera and the subject.

Perspective 

Interior spaces usually have square or
rectangular floor plans, giving the
photographer the basic choice of shooting
with one-point or two-point perspective. A
shot with one-point perspective like the

left-hand one below involves positioning the
camera along the room’s central axis and
shooting in the direction of the rear wall (i.e.,
directly at the cubic object). The wall is
oriented parallel to the sensor/film plane, thus
limiting the feeling of depth and preventing
the appearance of vanishing points. This type
of composition works well in small rooms,
although the overall effect is not particularly
dynamic. 

In contrast, photos with two-point
perspective are shot with the camera pointing
diagonally into the space, so that all non-vertical
lines converge towards imaginary vanishing
points on the (usually invisible) horizon and all
horizontal lines contribute to the feeling of
depth. As the right-hand photo below

illustrates, this approach produces a greater
feeling of depth. However, this type of image
is sometimes too dramatic and can result in
inharmonious compositions, especially in
narrow spaces. 

When comparing photos taken using a
single lens, the larger a room, the more distant
the rear wall and the more accentuated the
feeling of depth will be. In very large rooms,
the strongly converging horizontal lines in the
walls make the resulting image quite dynamic.
This effect is particularly strong in images of
symmetrical spaces that are shot to
emphasize their symmetry. 

The viewpoint you choose will depend not
only on how you wish the finished image to
look, but also on physical limitations, such as
the arrangement of the furniture or fittings,
the direction the incident light comes from
and any light emanating from mixed sources.
You may find that it is simply impossible to
shoot using one-point perspective because
the relevant parts of the room are full, or
because a central viewpoint would produce
unwanted reflections that would require
subsequent retouching. 

Positioning the Camera

Shooting at eye level (approximately 180 cm
above ground level) produces natural-looking

Photographing
Enclosed Spaces
Once you have found your subject and decided how you want 
to portray it, you can concentrate on producing a feeling of 
three-dimensional space within the image. The following 
sections detail some useful tips and grass-roots knowledge 
about how to view space and capture it photographically. 

One-point perspective gives this shot a clean, uncluttered look
(17mm equivalent focal length)

Photographing the same space using two-point perspective gives the
image a much more dynamic feel (17mm equivalent focal length)
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interior shots. The viewer usually instinctively
assumes that interior shots have been taken
from this position, and you can make 
low-ceilinged rooms appear more spacious if
you shoot from slightly lower (between about
100 and 120 cm above the floor). However,
lower camera positions also increase the risk
of some objects within the space blocking the
view of others. As an example, you should
consider whether the view under a table is
preferable to the view along its surface. Only
shoot from above eye level if you have to – for

example, to prevent a piece of furniture or an
architectural feature from spoiling your
composition. Shooting above eye level can
also be necessary if you need to emphasize
the depth of distant objects within a space.

Room Height

Converging verticals are less of a problem in
interior situations than they can be when
shooting outdoors because the difference
between the height of the space being

photographed and the vertical scope of the
image is much less pronounced. Because
interior shots contain fewer important visual
elements in the upper parts of the frame, it is
easier to shoot in landscape format than it is in
exterior situations. However, even slightly
off-kilter verticals quickly make interior shots
look strange, so it is important to ensure that
your camera is aligned correctly. If you still
end up with verticals that need correcting,
you can use dedicated software such as ShiftN,
which is included on this issue’s free DVD.

Shooting from a low viewpoint helps to give a small space
a feeling of added depth and height
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If you are photographing the interiors of
churches or other extremely high-ceilinged
spaces you will need to shoot either from a
high viewpoint (for example, from a gallery)
or using a shift lens that is capable of
eliminating converging verticals while you are
shooting.

Alternatively, you can shoot using a lens
with a wider angle than the situation actually
requires and shoot with the camera oriented
vertically instead of horizontally. This
eliminates converging verticals but shifts the
subject itself toward the top of the frame,
leaving large areas of the ground visible in the
lower half of the frame, which you can correct
later by cropping. 

You can, of course, use converging lines
deliberately as an additional compositional
element. The extremely dynamic photo

shown above was shot from a very low
standpoint with the camera pointing almost
vertically upward from the center of the room. 

Lenses

In order to capture as much of an interior as
possible, interior shoots generally require the
use of wider-angle lenses than most outdoor
situations.  We recommend lenses with
equivalent focal lengths of 24 mm or less – i.e.,
with an angle of view of 84 degrees or more. A
good example is the Canon EF 14mm f/2.8L II
USM. Most DSLR systems include one or more
lenses in this range. 

An ultra-wide-angle zoom lens is a very
useful tool in interior situations. 7-14mm  
(14-28mm equivalent) lenses designed for use
with the Four Thirds system can cost as much

as US$1800, but 9-18mm (18-36mm
equivalent) lenses are avilable for more
resonable prices of around US$700. Owners of
APS-C or DX-format cameras have the widest
choice of manufacturer’s own or third-party
lenses made by Sigma, Tamron and Tokina.

The Sigma 8-16mm F4.5-5.6 DC HSM for
Canon, Nikon, Pentax, Sony and Sigma
cameras offers its users an astonishing
equivalent minimum focal length of 12 mm
and costs around US$700. There is also a wide
range of ultra-wide-angle prime lenses and
zooms available for full-frame cameras
manufactured by Nikon, Canon and Sony.
Wide-angle zooms start at 16 or 17 mm and
have ranges that extend up to 28, 35 and even
40 mm. Nikon’s AF-S Zoom Nikkor 14-24mm
f/2.8G ED AF is an excellent choice, as is the
Sigma 12-24mm F4.5-5.6 EX DG ASP HSM II,

Converging verticals are used as part of the composition to increase the tension in this photo of a high
ceiling (17mm equivalent focal length)
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currently the widest-angle zoom  on the
market. Alongside these lenses, specialized
tilt/shift models, such as the Canon TS-E
17mm f/4L and TS-E 24mm f/3.5L II are perfect
for interior shoots – if you can afford them! 

Fisheye lenses are rarely used to shoot
conventional interior photos, but can come in
handy for shooting the source material for
360-degree spherical panoramas that can be
viewed using interactive Web-based tools (see
also our article on presenting gigapixel
images in Issue 7 of c’t Digital Photography).

Spatial Depth

The combination of wide-angle lenses with
broad angles of view and short subject
distances often create an impression of space
that exceeds that of the room being

photographed, which can produce photos
with misleading proportions. In contrast to
most exterior situations, in which realistic
reproduction of size and space are very
important, most architectural photographers
accept the disproportionate nature of interior
shots, especially as it rarely spoils (and can
sometimes even enhance) the effect of the
design. Real estate agents often use this effect
to produce attractive promotional photos.

However, even if ultra-wide-angle lenses
and panorama techniques allow us to capture
images of rooms with limited space, it is
important to exercise caution when choosing
a lens. A good rule of thumb for choosing
focal length is: as short as necessary but as
long as possible. Our aim is not to test the
physical limits of our equipment, but rather to
produce interestingly composed, well-lit

images with a clear message. Extreme 
wide-angle effects are seldom beneficial to 
an image. Having said all that, there is, of
course, nothing to be said against using 
ultra-wide-angle lenses to produce
intentionally artistic effects. For example, the
use of an extreme wide-angle lens in the
image shown above accentuates the
symmetrical look and the receding lines that
dominate the image. 

The best lens to use also depends on the
nature of the room itself. The taller and
shallower a space, the wider the angle
required to reproduce its volume in a
harmonious, realistic-looking way. The
converse is also true: the longer and lower a
space, the longer the focal length you should
use to photograph it if you want to retain
realistic proportions in the finished image.

The use of an ultra-wide-angle lens emphasizes the receding lines that dominate this image
(14mm equivalent focal length)
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Interior photographers constantly have to
deal with as many as three separate sources
of light, namely: incident natural light, artificial
indoor light and photographic flash. These
not only have varying intensities but can also
have very different color temperatures,
thereby confronting the photographer with
the twin challenges of extreme ranges of
brightness and mixed lighting moods. 

Extremes of Brightness

The differences in interior and exterior
lighting are particularly obvious in and around
windows, which often produce extreme

ranges of contrast that neither digital nor
analog cameras can capture in a single image. 

The simplest approach to this problem is
just to accept that windows will appear
extremely bright and detail-free if you want to
produce a balanced exposure for the rest of a
room. It is often the case that objects and
elements outside the room are irrelevant or
distracting anyway. All you have to do is take
a matrix or center-weighted meter reading for
an averagely bright area that contains no
windows. Once you have selected your
exposure values (in manual mode) or saved
the meter reading (refer to your camera’s
manual to identify the appropriate button)

you can reframe the image to include the
over-bright areas and release the shutter.

Always use the histogram display to make
sure you have captured the maximum range
of tonal values – the histogram curve for a
well-exposed image should reach but not
intersect with the left-hand (shadow) end of
the scale and should cross the right-hand
(highlight) end at as low a level as possible.

Although wirelessly controlled flash units
can spoil the precisely calculated look of a
room’s lighting, they do balance interior and
exterior light sources effectively. The units
should be positioned so that they do not
produce any obvious shadows and are not
visible within the frame. Ideally, they will make
it look as if the darker areas of the scene are lit
by natural light. The powerful, flexible flash
units necessary to create this type of effect 
are beyond the budget of many hobby
photographers, although smaller dedicated
flash units with built-in radio- or infrared
remote control functionality can be used off-
camera to brighten darker image areas, as
shown in the image opposite. In this case, the
flash was positioned to the right and below
the camera and was fired from close to the
wall.

The larger the room and the brighter the
light entering the windows (and the stronger
the subject contrast), the more difficult it 
is to produce adequate lighting using
conventional flash equipment. For example,
to light a medium-sized room with large
windows and no artificial light, the solution is
to deliberately underexpose to keep details
beyond the windows visible and light the rest
of the frame by firing several indirect, 
high-power flashes in different directions
while the shutter is open. 

If the shutter speed you are using makes it
impossible to fire multiple flashes during the
exposure, you can always use a sequence of
images to produce the result you are looking
for. Position your flash for each image so that
it illuminates a different part of the scene
without itself being visible in the frame, but
try to avoid positioning it behind or to the side
of the camera. It is then relatively simple to
use layers and masks in an image processing

All About Light
Reflective surfaces, exterior and interior light sources and your 
own flash gear are all factors that have to be controlled and used 
selectively in interior photographs. Sometimes, post-processing is 
the only way to tease the right look out of a tricky scene.

The color temperatures of natural and
artificial light sources can be adjusted to
suit each other during post-processing 
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In this photo, the otherwise unlit
foreground has been brightened 

using off-camera flash
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program to merge a sequence of source
photos into a single, well-exposed image.
There is also specialized software available for
performing light-balancing tasks, such as
HDR ReLight by Oloneo, which allows you to
control the impact of the light sources in your
source images individually. This technique can
also be used to photograph unlit rooms with
no windows at all.

Another effective way to produce interior
shots with balanced lighting is to shoot a
bracketing sequence and merge the resulting
images using HDR or DRI techniques. This
ensures that the finished image contains detail
across the entire frame and that deep shadows
and bright highlights are not clipped It is
important not to overdo HDR and DRI effects,
as they can quickly produce unrealistic-looking
results. The image on page 116/117 is a good
example of a successful merged image that
isn’t immediately recognizable as such.

Don’t attempt to darken your highlights so
much that they could pass for midtones, as this
only produces photos that look like paintings.
Always aim to keep contrast realistic-looking
while preserving visible detail in both
highlight and shadow areas. A bracketing
sequence should consist of at least three (or,
in situations with an extreme range of contrast,
five) source images with exposure values
ranging between -2 and +2 (or -3 and +3).
These figures represent the numbers of f-stops
(i.e. EVs) below or above the standard
exposure that the camera’s meter calculates
for the scene at hand when using a fixed
aperture value.

Mixed Light Sources

Bright room lights generally dominate in
mixed light situations.  Artificial light sources
with different color temperatures can be tricky
to capture, and the simplest workaround here
is to switch off any lamps whose color
temperature differs widely from that of the
dominant light source. Interior (warm) and
exterior (cool) color temperature differences
always present a chalenge, so if you want to be
able to adjust white balance after shooting
without reducing image quality, you will have
to shoot using your camera’s native RAW
format. 

If you use additional flash to brighten a
room that has little or no artificial light, you can
use special blue-colored filter gels (for example
from LEE filters) attached to the flash to adjust
the temperature of the flash light to match that
of the immediate environment. There are also
filters available that warm flash light to match
a dominant artificial light source. 

Attaching colored gels to windows to
match the outside light to the artificial indoor

lighting is often too complex an approach to
apply successfully. It is simpler to shoot after
dark – provided that this doesn’t spoil the
intended mood of the image. The temperature
of daylight during the ‘blue hour’ just after
sunset is particularly cool, so if you can, it is
best to wait until dark. Take care that
reflections of the interior in the room’s own
windows don’t change the look of the space
too much. If necessary, you can always close
curtains or blinds to deal with this.

The blue tint of natural light can always be
corrected during post-processing. For
example, selective color correction and a
number of adjustment layers were used to
correct the cool natural light in the image on
page 112 to match the warmer interior
lighting. The result is a balanced image with
harmonious overall color temperature. 

The results of this type of processing
depend on how much image editing
experience you have had. If you are still
learning this type of technique, always err on
the safe side when applying untried effects –
an image that has been tweaked too little
usually looks better than one that is obviously
overcorrected. 

If you are using HDR or DRI techniques and
your image contains a significant amount of
natural light, you can use cooler white balance
settings to ‘develop’ the overexposed source
images, and warmer settings for the
underexposed ones. This approach assumes
that brighter image areas are lit by daylight
and that darker areas are lit artificially and is an
effective way to attenuate strong differences
in color temperature, even if it cannot
eliminate them entirely. 

There are no hard and fast rules governing
the number and strength of lamps you can
use to light a room, so the best solution is to
give yourself a choice by taking multiple
shots of a single scene using as many
different lighting setups as possible. Bright
overall lighting is better in some situations
(such as offices or technical situations), while
selective use of individual accents is better in
cozy living room, bedroom or dining room
shots. If, for example, the sun is low in the sky
and its light enters a room via a window, the
best approach can be to do without artificial
light altogether, as illustrated by the image
above. In this case, the sun is the only light
source, and gives the image a balanced
overall look, allowing the photographer to set
a precise white balance value and prevent
color casts.

How to Avoid Camera Shake

It is difficult to exercise significant influence
over the found lighting in interior situations,

so you will generally have to adjust your
exposure to fit each situation individually.
Regardless of how well lit it is, the interior of a
building is usually darker than its exterior,
which means you will generally have to use
longer exposure times to prevent
underexposure in indoor situations. This is not
usually a problem as the exposure time is the
most flexible shooting parameter and there is
very little risk that the subject (or part of it) will
move during an exposure is extremely low.
However, longer exposure times also increase
the risk of camera shake spoiling handheld
shots.

It is generally inadvisable to shoot
architectural photos with the aperture wide
open, especially if you are not using a high-
end lens. Wide apertures produce more visible
lens errors and the resulting shallow depth of
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field can cause close or distant details to be
reproduced out of focus. Stopping the lens
down to a medium aperture generally helps
to reduce the risk of camera shake and also
makes the image sharper. Wide-angle lenses
generally produce their best results at
apertures between f8 and f11.

Only use your maximum aperture if you
have already increased your ISO value as far as
you can. A correctly exposed image shot using
a high ISO value nearly always looks better
than one with edge blur, chromatic
aberrations, vignettes, or too little depth of
field. However, exercise caution when
increasing your ISO setting. It is best to use the
camera’s lowest default value (usually ISO
100) if you want to make sure that you have
enough image quality in reserve for editing
later on.

The surest way to ensure shake-free
images is to shoot using a tripod, a remote
shutter release and mirror lock-up. However, if
you are travelling, a high-quality tripod is
often too heavy and too complicated to set up
for spontaneous shots. In such cases, a
monopod is a great alternative tool. A quality
monopod made of carbon fiber is compact,
can weigh as little as 500 grams (one pound)
and often works just as well as a tripod. You
can also lean a monopod with a mounted
camera on walls or chairs for extra support in
particularly dark spaces. Some monopods
double as hiking sticks too. 

A beanbag is another alternative camera
support. Although not quite as versatile as a
monopod, a leather or cloth beanbag is even
easier to use and can be placed on walls,
ledges and items of furniture to help support

and orient your camera as well as absorbing
unwanted vibrations. See our article on home-
made studio gear in Issue 6 of c’t Digital
Photography for details on how to make your
own.

If there is no tripod or horizontal surface at
hand, you can even use the wall to support
your camera (and a fingertip to support the
lens) while taking portrait format shots. If you
lean against the wall while doing so, your
upper body will remain still when you release
the shutter. 

If none of the above options apply to your
situation, you will simply have to rely on the
steadiness of your hand. Breathe steadily and
try to release the shutter between breaths. In
critical situations, taking multiple shots of a
subject increases your chances of producing
at least one shake-free image. (anm)  c

The balanced color temperature in this shot was achieved
by using only natural light 
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Here, DRI techniques were used to combine multiple source photos from a bracketing
sequence in an effective finished image
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Maike Jarsetz

Lightroom 4
Not only does Lightroom 4 offer the completely new Map and Book
modules for organizing and editing GPS data and creating photo books, 
it also includes a new process version, video editing functionality, a whole
bunch of enhanced editing tools and a number improvements in the
overall workflow. This article runs through the new features and goes 
into detail on some of the highlights.



Once again, the latest version of
Lightroom presents its users with a

new process version for converting RAW
data into RGB files. As always, this process
plays a major role in determining overall
image quality. Process Version 2012
(PV2012) is an integral part of the program’s
Develop module and includes revised tone
controls that have been designed to have
less direct effect on one another. The
Highlights, Shadows, Whites and Blacks
sliders are used to control bright and dark
tones as well as highlights and shadows, and
they replace the Recovery, Fill Light and
Blacks sliders found in version 3. The
Exposure slider is responsible for adjusting
midtones, making the Brightness slider used
with earlier process versions redundant. 

Shadows and highlights can be more
precisely adjusted using the new process
version, providing better overall detail
rendition. The improved quality of the new
algorithm is highly visible when switching
between the 2010 and 2012 process versions,
giving us finer shadow detail and more
rescued highlights. If you prefer to avoid any
potential surprises it is, of course, possible to
retain earlier process versions for images that
you have processed using earlier versions of
the program.

Many of the development tools have
been revised, and my personal favorite is the
color temperature tool that has been added
to the local adjustment options. This great
tool enables you to produce highly realistic
images of subjects that include varied color

temperatures – an adjustment that was only
possible in earlier versions of the program
by applying a partial mask. You can now
adjust local color temperature using the
Adjustment Brush and the Graduated Filter
tools.

Noise reduction, too, can now be applied
locally, enabling you to adjust shadow detail
selectively without adversely affecting the
sharpness of the rest of your image.

The Lens Corrections panel now includes a
much wider range of built-in lens profiles. The
Chromatic Aberration correction tool, which
now has its own algorithm, is no longer
directly integrated into the lens corrections.
This means that it can be used to analyze and
correct image data independently of the lens
profile in current use. 
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Local adjustments to
color temperature
and tint make it
simpler to process a
wide range of tricky
subjects

The revised Tone
sliders underscore
the increased
precision with which
the new process
version processes
highlights and
shadows (the PV2010
version is shown
above left, PV2012
below left)



Advanced users will recognize an extra
portion of Photoshop in the new Lightroom
version in the form of separate red, green and
blue channel Tone Curve adjustment
functionality. This new finesse gives advanced
users the opportunity to perform better
selective midtone adjustments and more
balanced weighting between shadows and
highlights.

Managing and Editing Video 

Lightroom 3 allowed its users to import video
files, but didn’t include any video processing

functionality, and even previewing video files
involved the use of an external editor.
Lightroom 4 allows you not only to play videos
in the preview window, but also to perform
basic video editing. The main video tool is the
video playback control bar, which you can
adjust in size to fit into the Library module’s
preview window.

The control bar includes basic video
editing functions such as trimming and stills
capture. There are sliders for selecting new
start and end points, or you can use the
Shift+Alt+I and Shift+Alt+O keyboard
shortcuts to perform the same tasks. To

capture a frame, simply click the Frame button
and select the Capture Frame option in the
pop-up menu that follows. The Set Poster
Frame option sets the selected frame as the
thumbnail for the clip you are working on.

At a first glance, all of the tools in the
Develop module are grayed out when you
view video files. However, a simple
workaround allows you to apply develop
steps to an entire video clip. All you have to
do is edit a captured frame, save the edit steps
you perform as a preset and apply it to the
video file in the Quick Develop panel in the
Library module. It’s simple when you know
how!

Creating Photo Books

The new Book module is probably the
widest-ranging of all the changes Adobe has
made to the program, although – just like
iPhoto and Aperture – it is limited to the use of
a single service provider for printing your
finished book. In Lightroom’s case, this is the
international Blurb service, which produces
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The Book module
offers a wide range
of layout options,
but currently only
works with the
Blurb online photo
book service

A simple workaround enables you
to develop video files using exactly
the same tools as for still images 



high-end products at high-end prices. If you
prefer not to use Blurb, you can always save
your book project as a PDF and have it printed
elsewhere. It remains to be seen whether
Adobe will use the Lightroom Exchange
Server or other interfaces to link to other
providers.

Making a photo book using the program’s
default settings is simple, and you can tweak
your layout using a wide range of tools. All
you have to do to get started is select a
format, a paper type and the type of cover you
want to use. You can then select one of the
page templates provided. These offer various
numbers and layouts of photos and text
boxes per page and you can drag and drop
photos  to insert them. The Auto Layout tool
does just what it says and automatically fills
preset page layouts with your selected
images. You can customize image positions,
sizes etc. yourself once the program has done
the donkey work. Text boxes can be
automatically filled with image metadata and
formatted text can be saved as a preset that
you can then select for use with the Auto
Layout tool.

Additionally, you can select custom
background colors, images or graphics and
choose from a wide range of captioning
options for whole pages or individual photos. 

Working with GPS Data

The new Map module automatically
integrates GPS metadata from your photos
into a Google Map. You can then search for
places using a search box or simply drag and
drop photos that don’t (yet) have geodata
associated with them to the map, where GPS
data is automatically added. You can also use
a GPX log file recorded using a logger or a
smartphone to automatically add an
annotated path to the map. Any photos you
then drag to the map are automatically placed
at the correct location using the metadata
time stamp as a reference.

Saved Locations is one of the really cool
features of the Map module, and enables you
to define the mutual proximity of a set of
photos. For example, if you travel to Greece
for a shoot, you can create a Saved Location
that encompasses the islands you visit by

setting the Radius value (in feet, miles, meters
or kilometers) to cover your chosen area. All
photos with GPS coordinates that lie within
the selected radius are then automatically
allocated positions on the map. This is a great
tool for finding all the images that belong in
large geographical areas.

Other Improvements

Built-in soft proofing is one of the major new
features in Lightroom 4 that Adobe
announced in advance of its release, although
it hasn’t yet lived up to everyone’s
expectations. Because Lightroom processes
RAW image files in the ProPhoto RGB color
space, it is only capable of displaying soft
proof previews for images with RGB color
profiles. This limits the usefulness of the Soft
Proofung feature to photographers who want
to output their images to the Web or a
profiled printer. CMYK soft proofing is not yet
part of the Lightroom deal, but we will be
following future developments in this area
with interest. 

Once Soft Proofing has been activated
(View > Soft Proofing), the clipping warnings
in the histogram switch functions and
become out-of-gamut warnings instead. This
enables you to tweak your image adjustments
to suit your chosen output medium. The Print
module now also includes dedicated sliders
for adjusting print brightness and contrast,
but be warned: adjustments made at the
printing stage have nothing to do with ‘real’
color management.

E-mail delivery has also been streamlined
in the new version and can be accessed
directly instead of having to save your
favorite e-mail client as an external editor in
an export preset. You can now configure
your e-mail account, add recipients’

addresses and adjust the quality of the
attached images directly in a separate
window. In its beta version, Lightroom 4 still
worked with its own address books, making
it less practical for sending one-off
attachments. However, the release version
has better address book integration that is
sure to be further improved in future.

The new DNG compression options are
another useful addition to the program’s
export functionality. You can now not only
adjust the quality of the Preview, but also
apply (lossy) adjustments to image resolution
that reduce DNG files to an eighth of their
original size. 

Adobe has also opened up the Lightroom
Web publishing interface, allowing you to use
the Find More Galleries Online button to add
services to the Lightroom Exchange Server. 

One final improvement that is also worth
mentioning: the Develop Presets that used to
appear as a long list in the Presets drop-down
in the Quick Develop and Import dialogs are
now displayed using the same folder structure
used to save them in the Develop module.
This may appear to be a small detail to some
users, but is an enormous help to others. This
is just one of a wide range of small but
eminently useful changes that have been
made, including new zoom levels, custom
aspect ratios in the Crop dialog, an improved
loupe view when adjusting white balance and
much more besides.

Conclusion

Lightroom’s two new modules and many of
the smaller changes are Adobe’s direct answer
to the many user requests it receives. The new
process version represents a significant
improvement in the program’s core RAW
development functionality. (pen)  c
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The Soft Proofing tool marks image
areas that lie outside the gamut

(i.e., the color range) supported by
your display or output device



Dmitri Popov, Andrea Mueller

Publish and Share 

Self-hosted Photo Sharing 
with Gallery
There are a lot of advantages to hosting your own Web-based photo
publishing solution instead of using the Flickr, SmugMug and others.
Self-hosting gives you full control of your content and eliminates
concerns about losing your work if your chosen provider changes its
terms of service or shuts down. And, perhaps most importantly, if you
run your own gallery, you can customize anything and everything. 
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When it comes to sharing photos on the
Web, there is no lack of commercial

services out there. Flickr, Picasaweb, SmugMug
and 500px are all popular choices among
amateur and professional photographers alike.
The major disadvantages of using a third-party
service are the (usually) limited disk space and
the fact that you have to trust your precious
work to a stranger. What would happen if your
chosen provider has technical difficulties or
goes out of business? What security measures
does the provider take? Third-party providers
are also no use if you need to publish your
material on a company intranet. 

The obvious solution to issues like these is
to host your photos yourself, either on a
rented server or on a computer attached to
your local network. An additional advantage
of doing things this way is that you have
complete freedom regarding the design of
your gallery, allowing you to precisely specify
fonts, thumbnail sizes, background colors and
the overall look of your Web presence. You
can also modify themes to your liking or
create your own from scratch, and you can
extend the default functionality of your photo
sharing system using plug-ins.

First Things First

Of course, there are a few things you need to
consider before you switch to a self-hosted
photo publishing application. Hosting your

own gallery means that you are responsible
for deploying and managing it and, although
most open source photo sharing solutions
are pretty straightforward to use, some 
basic technical skills are required during
installation and for performing routine
maintenance. If you choose to host your
photo gallery on your own server from the
convenience of your home or office, you 
also need to have a fast and reliable 
Internet connection and possess a 
working knowledge of server administration. 
If all these challenges don’t sound
insurmountable to you, you might just be
ready to take the plunge and deploy your
very own self-hosted photo publishing and
sharing solution.

Installing and 
Configuring Gallery

The first thing to do is choose your photo
publishing and sharing software. There are
various excellent solutions available, from
simple web-based applications like Zenphoto
to more advanced, feature-rich systems like
Piwigo and Coppermine. However, if you are
looking for a mature, well-documented
platform with a lively community of users and
developers, you can't go wrong with Gallery
(http://gallery.menalto.com/). The software is
written in PHP and runs on any server that

supports PHP and MySQL. This article looks at
the installation and use of Gallery in Windows
and Linux environments. Even if Linux is a
niche operating system on home computers,
it is still used on most hosting providers’
virtual and root servers.

Installing Gallery in Linux

Gallery is very quick to set up in a Linux 
home computer or server environment. The
simplest solution is to run it on a rented
server, as all the required components – 
such as an Apache Web server, a MySQL 
database and PHP – are pre-installed. using
your own server keeps you in full control 
of both hardware and software, but 
you need to set up a dedicated machine 
and you will be responsible for keeping
everything running smoothly. Going with 
a hosting provider makes sense if you 
alreadyhave a website and your provider 
offers the required components (you 
can view the list of requirements at
codex.gallery2.org/Gallery3:Requirements).

If you decide to run Gallery from home,
you will first need to install appropriate
Apache, PHP5 and MySQL distros on your
system. The operating system itself will
ensure that all required dependencies are
installed. Depending on which flavor of Linux
you are using, the first time you open Gallery
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An album and slideshow created using Gallery



in a browser window, you may find that
some of the PHP modules required to run
Gallery are missing. Details about what to do
if this happens are listed later. Many Linux
distros require you to select a MySQL root
user password during installation. If this is
not the case with your system the root
password remains empty, and you should

run the following commands at the first
opportunity to rectify the situation:

mysqladmin -u root password “my_password”

mysqladmin -u root -h localhost password “my_password”

You can now download Gallery3 from
gallery.menalto.com or copy the ZIP archive
from this issue’s free DVD. Open a terminal

and use the command cd to navigate to the
Web server’s document root. The folder is
usually located at /var/www/html, although
OpenSuse uses /srv. Now navigate to the user
root using the su command (or sudo su for
Ubuntu and its derivatives) and unpack the
Gallery archive using

unzip /pfad/zu/gallery-3.0.3.zipt

Now navigate to the newly-created Gallery
folder using cd gallery3 and use the mkdir var

command to create a new ‘var’ sub-folder and
apply chmod 777 var to give it appropriate user
rights. Now all that remains to do is create a
new My SQL user and a Gallery Database –
otherwise you will have to create and
administer the Gallery database as root user,
which is not advisable for security reasons
(the root user has unrestricted access to all
MySQL databases).

To create a new Gallery database user
profile, start the interactive MySQL client in a
terminal window using

mysql -u root mysql -p

and your previously defined root password.
The following commands create a new,
empty Gallery database and a new user called
‘gallery’ with full access to the contents of the
database:

CREATE USER 'gallery'@'localhost' IDENTIFIED BY 'password';

CREATE DATABASE gallery3

GRANT ALL PRIVILEGES ON gallery3.* TO 'gallery'@'local-

host' WITH GRANT OPTION;

All other changes and adjustments can now
be made directly in a browser window via the
Gallery interface, which is described below in
the sections following the description of the
Windows installation process.

Installing Gallery in Windows

The simplest way to install Gallery in 
Windows is to use the XAMMP package
(www.apachefriends.org/en/xampp.html),
which automatically installs Apache, MySQL
and PHP. If you decide not to run Apache and
MySQL as system-level services during
installation, you can still start the server at any
time via the Windows Start menu. 

Before installing Gallery itself, you have to
create a new database and a dedicated user.
Start the MySQL client either in a command
prompt window using the same commands as
described in the Linux section above, or using
the Web-based MySQL administration tool
PHPMyAdmin that is installed with the 
XAMPP package. You can start the tool either 
using its Start menu entry or by entering
http://127.0.0.1/phpmyadmin in your Web
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The first time a browser
accesses the program, it
checks whether all system
requirements are fulfilled and
lists any missing modules

The installer requests input
regarding the database
details. This is where you
enter the name of the
database and the
administrator’s user name.

Installation

Installing Gallery is a
straightforward process and
uses a wizard to guide you
through the required steps
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browser. Once you have taken these steps, you
can unpack the Gallery archive (downloaded
from gallery.menalto.com or copied from this
issue’s free DVD) to the Web server’s document
root located by default at c:\xampp\htdocs.
The unpacking process automatically creates a
folder called ‘gallery3’. Now create a sub-folder
called ‘var’ for your photos and use the
Properties options in the context menu to
deactivate its write protect option. 

Getting Started

The rest of the setup process takes place
within a browser and is the same for the
Linux and Windows versions of the program.
The URL for your installation will be either
http://localhost/gallery3/ is you are hosting
locally or http://my_domain.com/gallery3 is
you are using a third-party provider. The
installer will now check whether all the
required PHP modules are present. This is
automatically true if you used XAMPP, but
can produce surprises for some Linux 
distros. Install the missing module (in our
case, php-iconv) using your system’s
package management tool and use the
Check Again option to make sure that you
have installed all the required modules.

The installer will now ask you to enter the
name of your database and the name of the
new user you have created. Click Continue to
complete the installation and check the user’s
name and password.

Before you populate Gallery with photos,
there are a few administrative tasks to take
care of. First off, you might want to replace
the stock theme with something more
distinctive. To do this, grab the theme you
like from the official theme repository
(codex.gallery2.org/Category:Gallery_3:Them
es), unpack the downloaded archive and
move the resulting directory to the Themes
folder in your Gallery installation. On the
Gallery main page, navigate to Admin >
Appearance > Theme choice, where you
should be able to see the newly-added theme
in the ‘Available Gallery themes’ section. Click
on a theme to preview it and click the
activation link to enable it. You can then
tweak the theme's settings in the Admin >
Appearance > Theme options section, where
you can specify the number of photos per
page and thumbnail size, as well as header
and footer text. The latter option can come in
handy if you want to add a copyright notice
or replace the default Gallery logo with
custom text or graphics. 

Although Gallery uses English by default,
registered users can choose from a wide range
of interface languages. Additional languages
are enabled in the Admin > Settings >

Open Source Gallery | Interface
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You can customize Gallery's appearance by installing an alternative theme,
and the official theme repository contains dozens of themes to choose from

The Admin tab includes all the basic user, user group, plug-in, interface,
maintenance and language settings

Gallery supports a wide range of languages. You can install as many languages
as you need and specify a default language for each user on your system

Setting up the Interface



Languages options. Mark the languages you
require and press the ‘Add languages’ button
to install them. You can also change the default
language by clicking the ‘Default language’
radio button next to your chosen language.

As with many commercial photo
publishing solutions, Gallery can handle
multiple users and enables you to organize
them into groups. Furthermore, the
application allows you to specify individual
privileges for each group, giving you a flexible
mechanism for controlling access to your
photo collection. To add a user, navigate to the
Admin > Users/Groups options and click the
‘Add a new user’ button. In the ‘Add user’
dialog window you have to specify a user
name, full name, password, e-mail address and
the preferred interface language. If you want
to give the user administrative rights tick the
‘Admin’ check box, then click the ‘Modify user’
button to complete the process and close the
dialog. To create a new group of users, simply
click the ‘Add a new group’ button, give the
new group a name, and hit ‘Add group’. You
can then add users to the group by dragging
and dropping entries from the Users list.
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Gallery can handle multiple users, and adding
a user to the system is a simple matter of
providing some basic information. To keep
tabs on users and their access rights, you 
can organize them into groups.

Gallery features a
built-in upload tool.
Once photos have been
added to your collection,
you can group them into
albums.

You can specify access rights
for each album and existing

user groups in the Edit
Permissions dialog window

Gallery provides a simple and intuitive interface for performing routine maintenance tasks
such as rebuilding the search index, updating Exif data and fixing common problems

Basic Settings



Gallery comes with a handful of modules
enabled by default, and you can further
extend the application's functionality by
activating other bundled modules. To do this,
navigate to the Admin > Modules options,
select the modules you want to activate and
click the ‘Update’ button. The modules you
select will depend on your specific needs, but
some that are generally useful include the
Akismet module, which protects comments
from spam), Exif data, which displays Exif
metadata for the current photo and the 
REST API module, which allows external
applications to interact with Gallery.

Working with Gallery

There are other actions you can perform using
the Admin options, but at this stage you are
ready to put your new Gallery installation to
some practical use. The first step is to populate
the system with photos and group them into
albums using the commands included in the
Add tab. Gallery has its own built-in photo
upload tool which can be found under Add >
Add photos. Once you have uploaded one or
more images, you can alter each photo’s basic
info by hovering over it with the mouse and
clicking on the ‘Edit this photo’ command in the
Options menu that then appears at the bottom
of the frame. You can then specify a title and
add a brief description and tags. Gallery
automatically recognizes and displays tags that
you have added using other programs.

If you receive a warning message that
requests you to deactivate the PHP Suhosin
security option (which is activated by default
in most Linux distros), you have to add the
following line to the /etc/php.ini file:

suhosin.session.encrypt = Off

To keep your photos organized, Gallery
includes options for grouping them into
albums. To create an album, choose ‘Add an
album’ from the Add menu in the root album,
enter the required information and click
Create. Albums can contain multiple 
sub-albums, so you don’t have to just pile all
of your photos into a single collection. For
example, you might want to create an album
for your travel photos and then create 
sub-albums for individual countries. You can
drag photos between albums in the Album
options > Organize album view. Album
options > Edit Permissions allows you to
adjust individual access rights for each album
and user group.

Gallery puts all essential image viewing
features at your fingertips. Clicking a photo
displays it at high resolution in a pop-up
window, and the Photo Info panel in the 
right-hand sidebar displays any data stored
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The Amazon S3 module allows you to use the Amazon Simple Storage Service
as a content distribution network. This can help to lighten the load on your
server and improve the performance of your Gallery installation.

The Basket module adds a PayPal-based shopping cart, allowing you to
sell prints of your photos

Adding Shopping Modules



with the image. If you have activated the Exif
data module, you can display the photo's
metadata by clicking the ‘View more
information’ button. The Slideshow feature
does exactly what it says and displays the
photos in the current album as a slick
slideshow. You can allow visitors to comment
on your photos by selecting ‘Everybody’ from
the Permissions drop-down list in the Admin >
Settings > Comments section of the options
window, and you can view or delete
comments and remove spam in the Admin >
Content > Comments section. 

Hosting your own photo publishing
solution requires regular maintenance to keep
everything running smoothly and Gallery
makes it simple to perform basic maintenance
tasks. Switch to the Admin > Maintenance
section to perform housekeeping actions such
as updating the search index, rebuilding
images, removing old files and fixing the
installation if it misbehaves.

Extending Functionality

One of the major advantages of hosting your
own photo publishing solution using Gallery is
the ability to extend the program’s default
functionality using additional modules. As
previously mentioned, Gallery comes with a
handful of default modules that you can
enable or disable at will, but the official list 
of available modules (codex.gallery2.org/

Category:Gallery_3:Modules) features dozens
of other useful extensions which can add really
nifty functionality to your Gallery installation.
For example, the Amazon S3 module uses the
Amazon Simple Storage Service (S3) as the
CDN (content distribution network) back end
for your installation, allowing you to lighten
the load on your server and significantly
improve the performance of your Gallery
system. The Amazon S3 service is not free, but
offers reasonable pricing based on the amount
of storage and data transfers you use (see
aws.amazon.com/s3/pricing/), and you have to
sign up for the service before you can
integrate it into your Gallery installation. To set
up S3, navigate to Admin > Modules, select the
Amazon S3 module, and click the Update
button. Next, switch to the Settings > Amazon
S3 section to configure it. Most of the options
contain brief explanations to help you
configure them. Remember to tick the ‘S3
Enabled’ check box before you press the ‘Save
Settings’ button.

Installing Amazon S3 or any other Gallery
module is a simple matter of fetching the
latest version, unpacking the downloaded
archive and moving the resulting folder to
Gallery’s Modules directory. 

Using the Basket Module 

This module (available at codex.gallery2.org/
Gallery3:Modules:basket) adds shopping

cart functionality to your Gallery installation.
This allows you to sell prints of your photos
and process payments via PayPal. Once
installed, the module adds a dedicated
Basket tab in the administration interface.
The module’s basic settings (currency,
PayPal e-mail address etc.) are made in the
Basket > Configure options section, and you
can also define custom postage rates using
the Basket > Postage Bands options. The
Basket > Product Lines section is used for
editing existing purchasing options and
adding new ones. And that's all there is to it
– now all visitors to your site can buy prints
directly.

Conclusions

Hosting your own photo publishing solution
takes time and requires good technical
chops, but the benefits are numerous and
often outweigh the potential drawbacks. But
remember, photo hosting is not an
‘either/or’ proposition – If you prefer to use
photo sharing services like Flickr, SmugMug
or 500px to showcase your photographic
work you are free to do so, while an
additional Gallery-based solution can serve
a variety of purposes, from a fallback option
to a private collection of your best shots that
you only share with a specific group of
people. (jr)  
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The Gallery website includes a page for submitting your own gallery design and rating those of others c
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André Kramer

HD Slideshow Software
for high-end home entertainment

Many living rooms these days play host to HD TVs of a size and resolution
that make them perfect for presenting photos, while the latest slideshow
programs offer Full HD resolution as well as a wide range of creative
effects and text options. This article takes a look at some of the programs
on today’s market and gives you the lowdown on some of the great 
(and not-so-great) features they offer. 
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Presenting photos of your vacation or your
kids’ progress on a TV screen gives

everyone the opportunity to participate in
your adventures, but dividing them up into
chapters with cool transitions and a musical
soundtrack transforms everyday snaps into 
a real story.

Many people have an LCD TV or projector
with Full HD resolution at home, and these are
much better suited to presenting slideshows
than their CRT predecessors. Expressed in
‘photo-speak’, a CRT resolves about two
megapixels, while modern and legacy digital
compacts are capable of resolving more than
five megapixels, even when a clip has been
cropped to 16:9 format. Standard DVD Video
has an equivalent resolution of about 0.4
megapixels, which represents a significant
loss of quality when compared to the original
material. If you own an output device such as
a Playstation 3, you can play back Blu-ray discs
or video encoded in AVCHD (Advanced Video
Codec High Definition) format. Both standards
can play footage recorded at Full HD
resolution, and AVCHD can even burn 
Full HD to DVD if it is encoded using H.264
compression. Alternatively, high-resolution
video files also perform the same job.

We took a look at a range of contemporary
slideshow applications and how they can be
used to apply captions, dissolve effects, audio

soundtracks and digital zooms and pans to
bring your images to life on an HD screen.

We tested Aquasoft SlideShow Blue Net 7,
Corel Digital Studio 2010, Magix PhotoStory on
DVD MX, Cyberlink MediaShow 5 and Photo
DVD Maker 8 by Anvsoft. On the Mac side, we
checked out Boinx FotoMagico 3 Pro.

Only SlideShow Blue Net and PhotoStory on
DVD can burn Blu-ray discs. Digital Studio
burns AVCHD, and all the others output
high-resolution video files. Our test
candidates also offer a range of other output
formats including Flash clips for Web
presentation, YouTube upload and
slideshows for mobile devices such as the
iPhone, iPod touch, iPad and Playstation
Portable (PSP).

Deliberate understatement is an important
part of any slideshow, and you need to make
sure that transition effects, text boxes and
pans don’t dominate the images. Although it
is an advantage to be able to create effects
manually, it is also handy if your program is
capable of producing a slideshow largely
automatically. Even if you prefer to retain
complete control of the effects you use, it is 
a boon if you can simply alter a single pan
independently of the rest of your slideshow,
rather than having to adjust the keyframing
for all 200 photos in a sequence. Most busy
families want to turn simple themes into an

appealing photo show, and are quite happy
to do without over-the-top scenes with
exploding snowmen on skis or rose petals
raining down on wedding rings.

SlideShow 7 Blue Net

Aquasoft SlideShow gives its users a lot of
creative tools to play with, but provides
wizards for simple slideshow creation too.
The comic-style clip art and animations
provided with the program are mostly too
garish for everyday use. The Slideshow
Settings dialog  (in the Slideshow menu) is
used to select the default display duration
for each image and also includes a choice 
of standard transitions. You can choose
whether to display your images at full size
with a black border, cropped to fit a selected
aspect ratio or distorted to fit your chosen
format. The various Ken Burns effect presets
included in the Movement Paths tab in the
Toolbox can be applied globally to all
images if you want. The transparency effects
are based on curves and markers just like the
ones found in pro-grade programs like
Adobe After Effects.

Typed text appears by default in white
with an optional shadow, and there are many
text effects (some animated) that you can add
to your captions and speech bubbles. The
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SlideShow 7 Blue
Net by Aquasoft,

with its multi-track
timeline and

animated
transparency effects,

offers a wide range
of creative options



preset ‘particle’ effects (such as rain or snow)
are very effective. The icons for the text and
transition effects in the Toolbox tabs are also
animated previews, which makes it much
easier to choose which one to use. All tools are
applied by dragging them to the timeline,
which is hierarchically constructed and
contains multiple tracks.

The program is well equipped in the export
department, and can even burn slideshows 
to Blu-ray disc and AVCHD for playback on 
a Playstation  3. Exported AVCHD material
showed slight jerkiness, while Blu-ray
sequences were fluid and extremely sharp.
You can burn multiple slideshows to a single
DVD and there is a range of options for adding
menus.

The program can also export high-
resolution clips in MP4, M2TS, MKV and WMV
formats, to name just a few of the options on
offer. It writes files with either 720 or 1080
lines of resolution and remained stable while
using all four cores on our test machine for
its authoring run. The program also includes
options for export to a wide range of mobile
phone, Playstation Portable and iPod
models (including older versions), but
doesn’t yet support the latest iOS and
Android releases.

The Premium version (US$40) can create
neither DVD menus nor HD files, whereas the
Ultimate version (US$70) can. Only the

top-of-the-range Blue Net version (US$90)
supports Blu-ray authoring and other
advanced output formats.

Digital Studio 2010

Corel Digital Studio is something of a
Jack-of-all-trades and is aimed at beginners
and less experienced users. It can be used to
manage and edit still images and videos and
has WinDVD 2010 built in. Once you have
imported your data , you can choose to have
calendars, prints, greeting cards etc. made, or
you can create a slideshow.

Double clicking an image opens a window
with basic editing tools, including cropping,
straightening, red-eye removal and color
correction. There are also simple additional
tools (click the ‘More Tools’ button) for
creating and editing artistic effects and
frames.

The slideshow module includes settings
for aspect ratio and high or low resolution,
and offers a selection of nine preset
templates. Five of these include animated
start and finish images, while the other four
have no real graphic elements to speak of.
Here too, the program is quite sparing with
the number of options it offers. You can add
a soundtrack or record memos, and there
are options for adding captions and
transitions.

We found ourselves wishing for less
simplicity and more choice in various places –
for example, we would like to have seen a
standard ‘Save’ dialog rather than the list of
folder names (without paths) that the
program uses, or more information about the
type of DVD you are about to burn. All of the
interesting features are hidden away in pop-
up menus at the side of the window, and
without them you are flying blind.

The program can burn high-resolution
AVCHD discs that we were able to play on our
Playstation 3, although the animated start and
finish sequences were slightly jerky. In Full HD
MPEG mode, the program produced smooth
pans and subtle fades. Our attempt to export
a sample project as a 720x576-pixel AVI or
WMV file unfortunately produced a file that
showed the original 4:3 crop distorted to fit
the 16:9 Full HD frame.

FotoMagico 3

The FotoMagico interface is as user-friendly as
most Mac users will expect. You have to
choose between monitor, television or
projector output and select your screen type
and resolution at startup. The resulting project
is then automatically given the correct aspect
ratio and resolution settings. You can load
images from iPhoto, Aperture and Lightroom
libraries or directly from user-specified folders.
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Corel’s Digital
Studio 2010 has a
simple interface
with a range of
options aimed
squarely at
slideshow
beginners and less
experienced users
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Boinx FotoMagico 3
includes intuitive tools
for selecting start and

finish points for digital
pans and zooms

Magix PhotoStory on
DVD MX can be used

to create eye-catching
movie-style ‘trailers’

to grab viewers’
attention before the

real show begins



The interface includes tracks for music, effects
and commentary, and has its own built-in
sound recorder.

The software creates subtle Ken Burns
effects automatically, but you can set the start
and finish points manually too, using the twin
preview windows together with the Zoom
and Rotation dials.

The Options panel includes settings for
display duration and image animation (if
desired). There is also a small slider panel that
allows you to set fade curves and a
teleprompter that you can display on a
second monitor during live presentations.

Finished slideshows can be exported as a
standalone player, as a screensaver for OS X,
via iDVD or Toast as a video DVD, or as a
high-resolution HD file for playback on
YouTube, an iPod or the iPhone. You can
also select custom resolution settings for
export to MOV and MP4 formats. The default
video codec is H.264 with AAC audio, and
you can change both settings if you want.
The results are great – slideshows play back
smoothly and have no unsightly black
borders. The range of available formats is up
to date, and the only real drawback is the
lack of a burn functionality. The cheaper
Home version (US$29.99) cannot export to
MOV or MP4 formats – in other words, it is
not HD-compatible.

PhotoStory on DVD MX Deluxe

This package is great for both skilled creative
artists and quick-clicking photo fans. The
Photoshow Maker wizard enables you to
create a slideshow, complete with effects,
using just a few mouse clicks. The program
automatically divides non-RAW photos more
or less logically into chapters using each file’s
Exif metadata as a guide, but you can create
chapters manually too if you want. Some of
the program’s built-in templates (‘Chill Out’ or
‘Light Box’, for example) provide subtle
background music and fades, while others
(‘70s Party’ or ‘Love Story’) are simply too
kitschy for general use. We would have
preferred to see less quantity and more
quality as far as the templates and transition
presets are concerned.

Fades, effects, text and two music tracks
can be arranged manually in the timeline,
while the wide range of text effects includes
rotation and multi-directional movement 
as well as 3D. You can also create
Hollywood-style rolling titles, subtitles and
news-style text inserts.

One of the program’s highlights is a wizard
for creating animated travel routes using
online maps. All you have to do is select 
your destinations – the program then
automatically generates a route connected by

pins on the map. If it is not clear exactly which
location you mean, the program suggests
alternatives. Routes can be saved as still
images or WMV files with animated car, boat,
airplane or bicycle icons. Unfortunately, these
tend to flicker somewhat.

A new wizard includes 15 templates for
creating Hollywood-style film trailers. The
choice of themes includes adventure, action,
blockbuster, drama, love story and thriller.
Here, the program requires you to load not
just any old image sequence, but rather one
that contains wide shots, detail shots,
close-ups, shots that include movement and
group photos. There are pictograms to help
you choose which photos are best suited to
each category. Finished trailers are
enhanced with clichéd music (although you
can also select your own) and appropriate
animations. You can add text too if you
want. These trailers make great eye-catchers
that grab a viewer’s attention before the real
show starts.

The program is one of the few we tested
that can burn slideshows to Blu-ray discs,
although it did crash once or twice while
burning full-length shows. You can also burn
about 20 minutes of Blu-ray material onto
writeable DVDs – a process that didn’t
produce any crashes during our test. Our
Playsta tion 3 couldn’t detect the menus on
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Animated travel
routes enhance
slideshows created
using PhotoStory
on DVD



our mini Blu-ray disc but did manage to play
the MPEG streams without any problems,
while a Philips Blu-ray player interpreted the
entire disc correctly. Although we made
several attempts, we were unable to
successfully burn an AVCHD disc, but the
program did produce flawless standalone HD
slideshow files for playback on a computer.
HD clips can also be exported as WMV files or
directly to your YouTube page.

Cyberlink MediaShow 5

MediaShow is divided into four modules:
Photos, Videos, Disc and Convert, with each
covering a different stage of the slideshow
production process. If you select the Photo
module, you are presented with a library that
you then fill with the images and videos you
want to present. The program interface is in
photo-friendly black and includes a face

recognition module to help you tag your
photos. Tags are added to your files once you
have uploaded them to Facebook or Flickr.

The style, transition effects and display
duration of a slideshow are selected in the
slideshow editor, and the currently selected
photo is displayed in a large preview window.
Videos are not previewed in the same
window, but clicking the ‘Play’ button
switches from the still preview to the video
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SLIDESHOW SOFTWARE
Product SlideShow 7 Blue Net Digital Studio 2010 FotoMagico 3.8 Pro PhotoStory on DVD MX MediaShow 5 Photo DVD Maker 8.0
Manufacturer Aquasoft Corel Boinx Magix Cyberlink Anvsoft

URL www.aquasoft.net www.corel.com www.boinx.com www.magix.net www.cyberlink.com www.anvsoft.com

System support Windows XP/Vista/7 Windows XP/Vista/7 Mac OS X (10.5 and up), 
QuickTime 7.1

Windows XP/Vista/7 Windows XP/Vista/7 Windows XP/Vista/7

Import
Photo BMP, JPEG, JPEG 2000, PNG,

PSD, TIF
BMP, JPEG, JPEG2000, PNG,
TIFF, various RAW

BMP, JPEG, JPEG2000, PNG,
PSD, TIFF, RAW1

BMP, JPEG, PNG, PSD, TIF,
various RAW

BMP, JPEG, PNG BMP, JPEG, PNG, TIFF

Video AVI, MPEG, MOV, MP4 (AVC),
WMV

AVI, MOV, MPEG-2, WMV MOV, MP4 (AVC) AVI, MPEG-2, WMV AVI, MOV, MPEG-2, WMV –

Audio MP3, Ogg Vorbis, WAV, WMA MP3, M4A, Ogg Vorbis, WAV,
WMA

AIFF, M4A, MP3, WMA, WAV MP3, Ogg Vorbis, WAV MP3, WMA MP3, WAV, WMA

Export 
Video DVD / mini DVD v / v v / – v (via iDVD or Toast) / – v / v v / – v / v

Blu-ray / AVCHD v / v – / v – / – (no burn tool) v (mini Blu-ray) / v2
– / – v (file only) / –

Adjustable bit rate: 
Audio / Video

v / v () – / v (3 increments) – / – (no burn tool) v / v – / v (3 increments) – / –

Project backup / 
Multi-session

v ‘Archive’ / – – / – – / – (no burn tool) v / v – / – v (and others) / –

Video file formats AVI, MPEG-2, MOV, MP4,
M2TS, MKV, WMV

AVI, MPEG-2, MP4 (AVC),
MOV

MP4 (AVC), MOV MP4 (AVC), WMV MPEG-2,MP4 (AVC), WMV AVI, FLV, MPEG-2, MP4 (AVC)

Maximum resolution 1920 x 1080 
(AVI, M2TS, MKV), 
2048 x 1536 (WMV)

1920 x 1080 (MPEG, H.264),
1440 x 1080 (WMV), 
720 x 576 (AVI)

1920 x 1080 400 x 300 to 1280 x 720
Pixel, 25/30 Frames (MP4)

1920 x 1080 
(MPEG-2, M2TS AVC), 
1280 x 720 (WMV)

1920 x 1080 (MKV, MP4 AVC),
720 x 576 (MPEG-2), 
352 x 288 (FLV)

Device profiles iPod, PSP, various mobile
phone profiles

iPhone, iPod, PSP, standard
mobile phones

iPhone, iPod, Apple TV Profiles for iPhone, iPod, PSP,
PS3, Zune and many mobile
phones available online

iPhone, iPod, PSP, Zune, PS3,
Xbox

iPhone, iPod, PSP, some
mobile phones

Menu templates: DVD / HD 66 / 66 5 / 5 – 26 / 14 11 / – 15 (82 more online) / –

Upload YouTube Facebook, Flickr, YouTube YouTube Magix Online Photo Album Facebook, YouTube – (creates YouTube,
Myspace files)

Tools
Styles / Themes 19 (4:3 and 16:9) 9 (same as in DVD menu) – (‘Instant Slideshow’) 26 14 75 (or transition subset)

Aspect ratio / Automatic
crop

4:0, 16:9 / v 4:0, 16:9 / v 4:0, 3:2 / – 4:0, 16:9 / v
(or Shift+A)

4:0, 16:9 / v 4:0, 16:9 / v

Image editing Automatic exposure, 
contrast, color and histogram
correction

Crop, straighten, red-eye,
brightness, contrast, color

– Brightness, color, sharpness Crop, red-eye, brightness,
contrast, color

Sliders for color and 
brightness, channel mixer

Timeline / Storyboard v / v – / v v / – v / v – / v – / –

Text tools / Rolling titles /
Subtitles

v / v / v v / v / v v / – / – v / v / v (3D titles, 
news-style inserts)

v / – / – v / – / v (Auto text fill 
with file, folder name etc.)

Fade effects More than 150 8 16 109 4:0, 32 (16:9) 32 More than 300

Motion effects 17 Ken Burns effect presets Automatic Ken Burns effect Manual and automatic Ken
Burns effect

Ken Burns effect, rotate,
motion, distortion

Ken Burns effect 
(‘Motion’)

Automatic or manual

Photo effects Torn, sticky tape, grid, Pola-
roid

Black and white, sepia,
antique, various frames

– Mosaic, sand, poster, emboss,
fisheye, color shift

Black and white, sepia, 
vignette, glow

–

Other modules Particle and text effects, 
animated paths for images
and text

WinDVD, Paint Shop Photo,
VideoStudio, calendar and
photo books can be ordered
online

– Animated travel routes,
photo manager

Library with face recognition,
video converter

Audio, CD ripper

Ratings
Interface / Handling ++ ± + ++ + --

Slideshow quality + + + ++ + -

Stability and speed + + ++ ± + --

Price (approx. US$) 90 40 140 (‘Home’ version 30) 70 45 50
1 Plus iPhoto, Aperture and Lightroom libraries                   2 Requires MP4 codec which costs US$10

++ˇexcellent          +ˇgood          ±ˇsatisfactory          -ˇpoor          --ˇinadequate                                     vˇincluded            –ˇnot included                 



window. Most of the transition effects are
usable but,  unfortunately, the pretty dice
effect that the program itself uses to switch
between modules is not among them.

Some of the styles are highly
contemporary and work very well: for
example, ‘Motion’ produces a subtle Ken
Burns effect without the user having to
intervene at all, while ‘Cell’ divides the frame

into nine parts and fades your photos in and
out of them following a varying rhythm. The
effect is dynamic but not kitschy. The available
styles are generally attractive and low-key.
The program doesn’t offer colored
backgrounds or clip art, but you can fine-tune
brightness, contrast, saturation, white balance
and sharpness for photos and videos. The
export dialog is the same as the one you see

if you select the Convert option at startup, and
contains resolution, format and codec options
that cover various Apple, Microsoft and Sony
devices as well as direct upload to YouTube.
You can also select your own export format –
for example H.264 in an M2TS container or a
1920x1080 MPEG file. In general, the program
works smoothly and delivers good overall
results.
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If your TV is already connected to your computer using an HDMI
cable, you don’t necessarily need to burn your slideshow to disc,
as most image viewers also have some sort of built-in slideshow
functionality. IrfanView simply displays your images in full-screen
view without any effects at all, while XnView is capable of adding
fade transitions. In both cases, each image is displayed for a preset
duration or can be toggled using the computer keyboard.
FastStone Image Viewer displays images in full-screen mode,
automatically inserts the file’s creation date and offers more than
150 transition effects of varying quality. Picasa offers slide shows
with transition and additional Ken Burns effects.

Photoshop Elements includes 23 different transition effects, text
effects and background music, and saves slideshow files to WMV
or PDF with a resolution of 1600x1200 pixels. Lightroom plays

photo collections as slideshows directly from the program
interface and can also output them as high-resolution MP4 video
files. Instead of flashy effects, Lightroom offers classy looking frame
and identity plate effects.

Apple’s iPhoto ’11 photo management package is part of the iLife
suite and provides six preset slideshow themes that range from
simple sequences to animated effects à la Ken Burns or stacks of
Polaroid-style framed photos. There are also themes with
antique and fast-moving collage effects. You can add music from
your iTunes library and export slideshows as MP4 files for
playback on the iPhone, an iPod or Apple TV. Apple’s Aperture 3
RAW converter includes a slideshow editor that enables you to
add text, music and Ken Burns effects, with output in the form of
HD MOV files.

Computer-based Photo Presentations

Cyberlink
MediaShow, with
its limited range of
user-controllable
options, can be
used to quickly
create highly
appealing
slideshows



Just before we went to press, we received
a beta of version 6, which can burn video clips
and slideshows to Blu-ray and AVCHD. In our
preview test, the motion and transition effects
we applied weren’t converted during export,
leaving us with non-moving images in our
video file and on disc.

Photo DVD Maker 8

Photo DVD Maker advertises export to
Blu-ray-compatible file formats but 
initially attracts attention with its clumsily 
translated interface. The package also
includes a CD ripper and a sound editor that
consistently crashed the program when 
we tried to use it.

Slideshows are created in a default 4:3
format which automatically includes various
effects. The default caption is the name of the
current folder and the default typeface is
Comic Sans – a font that is loved by visual arts
amateurs and hated by professionals in equal
measure. Text can be displayed in a number
of bright, almost day-glo colors. Trying to find
the right transition effect from the 300 or so
supplied with the program is tricky to say the
least – especially considering that you can
only preview five at a time. There are 75

themes to choose from, although most of
them are just frame effects that appear to
compete with each other for some kind of
ugliness prize. This ‘quantity instead of quality’
approach continues with an amazing
collection of unusably kitschy DVD menu
templates.

Once you have removed all of the default
effects (except for the Ken Burns-style pans),
you can save your project to various formats
for a range of conventional devices or upload
to YouTube. The software produces high-
resolution MP4 files and muddy-looking
MPEG-2 video clips. The range of export
formats also includes Full HD MKV but, for the
reasons outlined above, we do not
recommend the program for everyday use.

Conclusions

It is hard to escape the feeling that slideshow
software manufacturers simply don’t pay
much heed to quality programming. Photo
DVD Maker is as good as useless, and Corel’s
Digital Studio – which is not exactly cheap –
presented us with distorted aspect ratios right
off the bat. The program is really aimed at
family members who are not particularly
interested in computers but who still want to

produce quick and easy slideshows. On the
plus side, Corel gives you the option of
burning your clips to high-resolution AVCHD
disc.

FotoMagico has a refreshingly ‘different’
interface and genuinely useful features for
making live, projector-based presentations. It
also offers a good range of contemporary
export formats. Cyberlink hasn’t (yet)
announced AVCHD or Blu-ray support for
MediaShow, but still produces attractive
slideshows in a range of useful video file
formats 

Aquasoft’s SlideShow is a versatile program
aimed at those who like tinkering with their
slideshows and sharing tips, animations and
menu templates with like-minded users in the
manufacturer’s extensive forum. At US$90,
the new Blue Net version is the most expensive
of the three on offer, but shines with its
unequalled range of export formats and
AVCHD and Blu-ray burn support.

PhotoStory on DVD MX produced HD
Blu-ray discs without any problems. The
program offers a high-quality visual
experience, and the ‘film trailer’ feature
included with the latest version helps
transform everyday slideshows into a real
multimedia treat. (akr)  c
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Photo DVD Maker is not
particularly stable and
includes a lot of fairly
useless junk features
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Coming up in Issue 9 ... 

Combating Chromatic
Aberrations

Chromatic aberrations and other lens errors
were just as prevalent in analog times as they
are today, but it is the development of digital
image processing technology that has given
us the tools we need to correct them
effectively. We take a look at some of the
specialized programs and plug-ins on offer
and explain how you can use them to get rid
of those irritating RAW and JPEG color
smears.

Sorting and Managing your
Photo Archives 

An orderly folder structure alone is no longer
sufficient for keeping track of large numbers
of digital images. A well-thought-out system
of keywords and ratings helps when you
need to find the right photo. Database
software that includes face recognition and
geotagging functionality is the tool of choice
for managing digital assets. We put some
well-known and some less prominent tools
through their paces.

Street Photography

Street photography illustrates public life in all
its many facets. But don’t be fooled:
photographing strangers going about their
daily business can be tricky, and it is easy to
overstep the limits of everyday tolerance. We
give you professional tips on how to approach
people and how to go about unobtrusively
capturing great spur-of-the-moment
images.
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